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Manage and streamline the entire contract process right within Microsoft Word using X- 
Author for Contracts add-in.
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Release Notes
Review the latest X-Author for Contracts release notes that describe the system 
requirements and supported platforms, new features, enhancements, resolved issues, and 
known issues.

Summer21.11.10 Release Notes
Summer21.09.20 Release Notes
Summer21.08.04 Release Notes
Summer21.07.16 Release Notes
Summer '21 Release Notes

Summer21.11.10 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the X-Author for Contracts Summer21.11.10 Release. For 
documentation updates, see What's New in X-Author for Contracts. 

Packages
The following X-Author for Contracts package is automatically upgraded to the latest 
release without any intervention. Conga Contract Lifecycle Management (dependent 
package) is required to be upgraded to this release. Separate prerequisites for each feature 
can be found in the respective documentation. The packages marked as (New) are new in 
this release.

Product Latest Certified Version (Version Name | 
Version Number)

X-Author for Contracts  2102

This documentation may contain descriptions of software features that are 
optional and for which you may not have purchased a license. As a result, your 
specific software solution and/or implementation may differ from those described in 
this document. Please contact your CSM or AE for information on your specific 
features and licensing.



https://documentation.conga.com/x-author-for-contracts/summer-21/what-s-new-in-x-author-for-contracts-152568118.html
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Product Latest Certified Version (Version Name | 
Version Number)

Conga Contract Lifecycle Management 

(Required if you are using Conga Contract 
Lifecycle Management)

12.1.0630 | 12.630

Conga CLM (Contracts for Salesforce)

(Required if you are using Conga CLM 
(Contracts for Salesforce)) 

2.53

System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Windows operating system.

System Requirement Minimum Supported Version

Windows Operating System Windows 10

Microsoft Office Microsoft 365 version from 16.0.11629 to 
16.0.13231.20262

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Mac operating system.

System Requirement Minimum Supported Version

Mac Operating System macOS Mojave (version 10.14.5)

Microsoft Office Microsoft 365 version from 15.32 to 16.51 

The previous two (n-2) versions of Conga 
Contract Lifecycle Management are also 
supported.



Microsoft 365 is a prerequisite to install and run X-Author for Contracts on Windows 
and Mac operating systems.
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New Features
There are no new features in this release. Keep checking the Conga Documentation Portal 
for new updates.

Enhancements
There are no enhancements in this release.

Fixed Issues
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case 
Number

Conga 
Internal 
ID

Description

00774303 XAJS-5271 While trying to check out template in X-Author for Contracts using 
MAC, the following error message is displayed.

" An Unexpected error has occurred. Please try again. The 
application has encountered an error. Please contact the 
administrator ."

Known Issues
The following table provides the cumulative list of known issues up to this release.

Conga 
Internal ID

Description

XAJS-5016 A user encountered an OAuth error while logging in to the X-Author for Contracts 
on Microsoft Windows.

Workaround:

Refresh the page or re-enter the login credentials.
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Conga 
Internal ID

Description

XAJS-4982 If the template's name contains special characters, then the special characters 
are replaced with space. However, the template is saved as is in Conga CLM.

XAJS-4531 When you set a style for a segment that contains clauses or clause bundles, the 
selected style does not apply to the clauses or clause bundles in the agreement 
document. The user observes this behavior when working with X-Author for 
Contracts for Conga CLM (Contracts for Salesforce).  

XAJS-2543 On clicking the Highlight option, the smart and read-only fields are highlighted 
three times. This happens when you apply for Insert Comments and Track 
Changes protection while generating a document.

XAJS-2365 The formatting of the bulleted list is not proper when you perform the following 
actions:

Make a segment that contains a bulleted list conditional in a template.
Mark a clause to a block of text that contains a bulleted list in the 
template or agreement document. 
Insert a clause that contains a bulleted list in the template or agreement 
document. 

XAJS-3386 On performing Update from CLM and Preview Reconcile, the Contract date 
format in Croatian is converted to an invalid date.

XAJS-3301 When you generate an agreement using a non-localized template, a currency 
prefix symbol is added to the currency data type field.

Workaround: Set APTS_DoNotPrefixCurrency admin entry to true while generating 
agreement documents.

XAJS-3022 Incorrect values are displayed for smart fields after regenerating an agreement 
with a different template.

XAJS-2941 The compare pane stops responding when you change the value of a smart field 
in the document and compare it.

XAJS-2899 After creating a section and a third-level table and navigating to the Update 
From CLM screen, the values of smart fields appear as changed even if there were 
no changes made to smart fields.
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Conga 
Internal ID

Description

XAJS-2885 The reference lookup currency field does not display the record-level currency 
format.

XAJS-2975 On validating doc fields after deleting smart and merge fields, an error is 
displayed.

XAJS-2950 When you merge two versions of an agreement document generated with two 
different templates, you can view only revised version changes in the merged 
document.

XAJS-2730 The following culture-specific date formats are not supported:

Thai

ddd d MMMM yyyy (For example, ศ. 20 มกราคม 2560 is displayed for 
20/1/2560).
'วัน'dddd'ที่' d MMMM gg yyyy (For example, วันศุกร์ที่ 20 มกราคม พ.ศ. 2560 is 
displayed for 20/1/2560).
Thai dates use the Buddhist calendar, which is 543 years ahead. Hence, 
2017 is displayed as 2560.

Greek

el-gr ---- MMMM yyyy (For example, Μάιος 2017 is displayed for May 2017).

XAJS-2964 On clicking Reject changes, smart fields are appended with current values instead 
of replacing the value.

XAJS-2516 Inserting a nested clause disorganizes the clauses on the Doc Clauses tab.

XAJS-2700 A few built-in style segments do not apply in the generated document.

XAJS-2703 If an agreement document has any read-only lookup fields in the repeating table 
under the repeat section, the XAJS pane stops responding using the Update from 
CLM option.

DOC ID: XACSUM21PRN20211110
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Summer21.09.20 Release Notes
Release Notes contain the following information about X-Author for Contracts 
Summer21.09.20 Release.

Packages: Lists packages that are required to upgrade to this release of the product
System Requirements and Supported Platforms: Lists requirements and 
recommendations for installing this release
New Features: Provides high-level descriptions of new features introduced in this 
release, with links to more detailed information
Enhancements: Provides high-level descriptions of enhancements to existing features
Fixed Issues: Lists customer-reported issues that are resolved in this release or known 
issues resolved from previous releases
Known Issues: Lists known issues that are applicable in this release

Packages
The following X-Author for Contracts package is automatically upgraded to the latest 
release without any intervention. Conga Contract Lifecycle Management (dependent 
package) is required to be upgraded to this release. Separate prerequisites for each feature 
can be found in the respective guides. The packages marked as (New) are new in this 
release.

Product Latest Certified Version (Version Name | 
Version Number)

X-Author for Contracts  2102

For more information on new features, enhancements, and document improvements, 
refer to What's New in X-Author for Contracts Summer '21 User Guide.

This documentation may contain descriptions of software features that are 
optional and for which you may not have purchased a license. As a result, your 
specific software solution and/or implementation may differ from those described in 
this document. Please contact your CSM or AE for information on your specific 
features and licensing.



https://documentation.conga.com/x-author-for-contracts/latest/what-s-new-143886675.html
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Product Latest Certified Version (Version Name | 
Version Number)

Conga Contract Lifecycle Management 

(Required if you are using Conga Contract 
Lifecycle Management)

12.1.0630 | 12.630

Conga CLM (Contracts for Salesforce)

(Required if you are using Conga CLM 
(Contracts for Salesforce)) 

2.53

System Requirements and Supported Platforms

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Windows operating system.

System Requirement Minimum Supported Version

Windows Operating System Windows 10

Microsoft Office Microsoft 365 version from 16.0.11629 to 
16.0.13231.20262

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Mac operating system.

System Requirement Minimum Supported Version

Mac Operating System macOS Mojave (version 10.14.5)

The previous two (n-2) versions of Conga 
Contract Lifecycle Management are also 
supported.



Before installing or upgrading managed packages, you must review the dependency 
matrix for each managed package. You can refer to the package dependency 
matrix at Managed Packages Dependency Matrix. 



Microsoft 365 is a prerequisite to install and run X-Author for Contracts on Windows 
and Mac operating systems.



https://documentation.conga.com/display/TECHNOTES/Managed+Packages+Dependency+Matrix
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System Requirement Minimum Supported Version

Microsoft Office Microsoft 365 version from 15.32 to 16.51 

New Features
There are no new features in this release keep checking the Conga Documentation Portal 
for new updates.

Enhancements
There are no enhancements in this release.

Fixed Issues
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case 
Number

Conga 
Internal ID

Description

N/A XAJS-5198 You can now search and view the clauses in the clause library that 
contain special characters ( "&" ," _" ) in the record type name. 

Known Issues
The following table provides the cumulative list of known issues up to this release.

New features and technologies are continuously deployed in new releases by X- 
Author for Contracts and they are supported by Conga where the associated 
Microsoft Office versions are also still supported by Microsoft. As Mircosoft ends its 
own support for any Office version, subsequent new Conga release will no longer be 
developed, tested, or committed to support the application on that version.
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Conga 
Internal ID

Description

XAJS-5016 A user encountered an OAuth error while logging in to the X-Author for Contracts 
on Microsoft Windows.

Workaround:

Refresh the page or enter login credentials again.

XAJS-4982 If the template's name contains special characters, then the special characters 
are replaced with space. However, the template is saved as is in Conga CLM.

XAJS-4531 When you set a style for a segment that contains clauses or clause bundles, the 
selected style does not apply to the clauses or clause bundles in the agreement 
document. The user observes this behavior when working with X-Author for 
Contracts for Conga CLM (Contracts for Salesforce).  

XAJS-2543 On clicking the Highlight option, the smart and read-only fields are highlighted 
thrice. This happens when you apply for Insert Comments and Track Changes 
protection while generating a document.

XAJS-2365 The formatting of the bulleted list is not proper when you perform the following 
actions:

Make a segment that contains a bulleted list conditional in a template.
Mark clause to a block of text that contains a bulleted list in the template 
or agreement document. 
Insert a clause that contains a bulleted list in the template or agreement 
document. 

XAJS-3386 On performing Update from CLM and Preview Reconcile, the Contract date 
format in Croatian is converted to an invalid date.

XAJS-3301 When you generate an agreement using a non-localized template, a currency 
prefix symbol is added to the currency data type field.

Workaround: Set APTS_DoNotPrefixCurrency admin entry to true while generating 
agreement documents.

XAJS-3022 Incorrect values are displayed for smart fields after regenerating an agreement 
with a different template.

XAJS-2941 The Compare pane stops responding to changing the value of a smart field in the 
Current document and comparing it.
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Conga 
Internal ID

Description

XAJS-2899 After creating a section and a third-level table and navigating to the Update 
From CLM screen, the values of smart fields appear as changed even if there were 
no changes made to smart fields.

XAJS-2885 The currency format for the reference lookup currency field is not displaying as 
per the record-level currency.

XAJS-2975 On validating doc fields after deleting smart and merge fields, an error is 
displayed.

XAJS-2950 When you merge two versions of an agreement document generated with two 
different templates, you can view only revised version changes in the merged 
document.

XAJS-2730 The following culture-specific date formats are not supported:

Thai

ddd d MMMM yyyy (For example, ศ. 20 มกราคม 2560 is displayed for 
20/1/2560).
'วัน'dddd'ที่' d MMMM gg yyyy (For example, วันศุกร์ที่ 20 มกราคม พ.ศ. 2560 is 
displayed for 20/1/2560).
Thai dates use Buddhist year which is 543 years ahead. Hence, 2017 is 
displayed as 2560.

Greek

el-gr ---- MMMM yyyy (For example, Μάιος 2017 is displayed for May 2017).

XAJS-2964 On clicking Reject changes, smart fields are appended with current values instead 
of replacing the value.

XAJS-2516 Inserting a nested clause disorganizes the clauses on the Doc Clauses tab.

XAJS-2700 A few built-in style segments do not apply in the generated document.

XAJS-2703 If an agreement document has any read-only lookup fields in the repeating table 
under the repeat section, the XAJS pane stops responding using the Update from 
CLM option.

DOC ID: XACSUM21PRN20210920
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Summer21.08.04 Release Notes
Release Notes contain the following information about X-Author for Contracts 
Summer21.08.04 Release.

Packages: Lists packages that are required to upgrade to this release of the product
System Requirements and Supported Platforms: Lists requirements and 
recommendations for installing this release
New Features: Provides high-level descriptions of new features introduced in this 
release, with links to more detailed information
Enhancements: Provides high-level descriptions of enhancements to existing features
Resolved Issues: Lists customer-reported issues that are resolved in this release or 
known issues resolved from previous releases
Known Issues: Lists known issues that are applicable in this release

Packages
The following X-Author for Contracts package is automatically upgraded to the latest 
release without any intervention. Conga Contract Lifecycle Management (dependent 
package) is required to be upgraded to this release. Separate prerequisites for each feature 
can be found in the respective guides. The packages marked as (New) are new in this 
release.

Product Latest Certified Version (Version Name | 
Version Number)

X-Author for Contracts  2102

For more information on new features, enhancements, and document improvements, 
refer to What's New in X-Author for Contracts Summer '21 User Guide.

This documentation may contain descriptions of software features that are 
optional and for which you may not have purchased a license. As a result, your 
specific software solution and/or implementation may differ from those described in 
this document. Please contact your CSM or AE for information on your specific 
features and licensing.



https://documentation.conga.com/x-author-for-contracts/latest/what-s-new-143886675.html
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Product Latest Certified Version (Version Name | 
Version Number)

Conga Contract Lifecycle Management 

(Required if you are using Conga Contract 
Lifecycle Management)

12.1.0630 | 12.630

Conga CLM (Contracts for Salesforce)

(Required if you are using Conga CLM 
(Contracts for Salesforce)) 

2.53

System Requirements and Supported Platforms
 

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Windows operating system.

System Requirement Minimum Supported Version

Windows Operating System Windows 10

Microsoft Office Microsoft 365 version from 16.0.11629 to 
16.0.13231.20262

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Mac operating system.

The previous two (n-2) versions of Conga 
Contract Lifecycle Management are also 
supported.



Before installing or upgrading managed packages, you must review the dependency 
matrix for each managed package. You can refer to the package dependency 
matrix at Managed Packages Dependency Matrix. 



Microsoft 365 is a prerequisite to install and run X-Author for Contracts on Windows 
and Mac operating systems.



https://documentation.conga.com/display/TECHNOTES/Managed+Packages+Dependency+Matrix
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System Requirement Minimum Supported Version

Mac Operating System macOS Mojave (version 10.14.5)

Microsoft Office Microsoft 365 version from 15.32 to 16.51 

New Features
There are no new features in this release keep checking the Conga Documentation Portal 
for new updates.

Enhancements
There are no enhancements in this release.

Resolved Issues
The following table lists the issue resolved in this release.

Case 
Number

Conga 
Internal ID

Description

00117898 XAJS-5115 A user encountered an error while checking out the agreement 
document in X-Author for Contracts.

Known Issues
The following table provides the cumulative list of known issues up to this release.

New features and technologies are continuously deployed in new releases by X- 
Author for Contracts and they are supported by Conga where the associated 
Microsoft Office versions are also still supported by Microsoft. As Mircosoft ends its 
own support for any Office version, subsequent new Conga release will no longer be 
developed, tested, or committed to support the application on that version.
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Conga 
Internal 
ID

Description

XAJS-5016 A user encountered an OAuth error while logging in to the X-Author for Contracts on 
Microsoft Windows.

Resolution:

Refresh the page or enter login credentials again.

XAJS-4982 If the template's name contains special characters, then the special characters are 
replaced with space. However, the template is saved as is in Conga CLM.

XAJS-4531 When you set a style for a segment that contains clauses or clause bundles, the 
selected style does not apply to the clauses or clause bundles in the agreement 
document. The user observes this behavior when working with X-Author for 
Contracts for Conga CLM (Contracts for Salesforce).  

XAJS-2543 On clicking the Highlight option, the smart and read-only fields are highlighted 
thrice. This happens when you apply for Insert Comments and Track Changes 
protection while generating a document.

XAJS-2365 The formatting of the bulleted list is not proper when you perform the following 
actions:

Make a segment that contains a bulleted list conditional in a template.
Mark clause to a block of text that contains a bulleted list in the template or 
agreement document. 
Insert a clause that contains a bulleted list in the template or agreement 
document. 

XAJS-3386 On performing Update from CLM and Preview Reconcile, the Contract date format in 
Croatian is converted to an invalid date.

XAJS-3301 When you generate an agreement using a non-localized template, a currency prefix 
symbol is added to the currency data type field.

Workaround: Set APTS_DoNotPrefixCurrency admin entry to true while generating 
agreement documents.

XAJS-3022 Incorrect values are displayed for smart fields after regenerating an agreement 
with a different template.
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Conga 
Internal 
ID

Description

XAJS-2941 The Compare pane stops responding to changing the value of a smart field in the 
Current document and comparing it.

XAJS-2899 After creating a section and a third-level table and navigating to the Update From 
CLM screen, the values of smart fields appear as changed even if there were no 
changes made to smart fields.

XAJS-2885 The currency format for the reference lookup currency field is not displaying as per 
the record-level currency.

XAJS-2975 On validating doc fields after deleting smart and merge fields, an error is displayed.

XAJS-2950 When you merge two versions of an agreement document generated with two 
different templates, you can view only revised version changes in the merged 
document.

XAJS-2730 The following culture-specific date formats are not supported:

Thai

ddd d MMMM yyyy (For example, ศ. 20 มกราคม 2560 is displayed for 20/1/2560).
'วัน'dddd'ที่' d MMMM gg yyyy (For example, วันศุกร์ที่ 20 มกราคม พ.ศ. 2560 is 
displayed for 20/1/2560).
Thai dates use Buddhist year which is 543 years ahead. Hence, 2017 is 
displayed as 2560.

Greek

el-gr ---- MMMM yyyy (For example, Μάιος 2017 is displayed for May 2017).

XAJS-2964 On clicking Reject changes, smart fields are appended with current values instead of 
replacing the value.

XAJS-2516 Inserting a nested clause disorganizes the clauses on the Doc Clauses tab.

XAJS-2700 A few built-in style segments do not apply in the generated document.

XAJS-2703 If an agreement document has any read-only lookup fields in the repeating table 
under the repeat section, the XAJS pane stops responding using the Update from 
CLM option.
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DOC ID: XACSUM210804RN

Summer21.07.16 Release Notes
Release Notes contain the following information about X-Author for Contracts 
Summer21.07.16 Release.

Packages: Lists packages that are required to upgrade to this release of the product
System Requirements and Supported Platforms: Lists requirements and 
recommendations for installing this release
New Features: Provides high-level descriptions of new features introduced in this 
release, with links to more detailed information
Enhancements: Provides high-level descriptions of enhancements to existing features
Resolved Issues: Lists customer-reported issues that are resolved in this release or 
known issues resolved from previous releases
Known Issues: Lists known issues that are applicable in this release

Packages
The following X-Author for Contracts package is automatically upgraded to the latest 
release without any intervention. Conga Contract Lifecycle Management (dependent 
package) is required to be upgraded to this release. Separate prerequisites for each feature 
can be found in the respective guides. The packages marked as (New) are new in this 
release.

For more information on new features, enhancements, and document improvements, 
refer to What's New in X-Author for Contracts Summer '21 User Guide.

This documentation may contain descriptions of software features that are 
optional and for which you may not have purchased a license. As a result, your 
specific software solution and/or implementation may differ from those described in 
this document. Please contact your CSM or AE for information on your specific 
features and licensing.



https://documentation.conga.com/x-author-for-contracts/latest/what-s-new-143886675.html
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Product Latest Certified Version (Version Name | 
Version Number)

X-Author for Contracts  2102

Conga Contract Lifecycle Management (New)

(Required if you are using Conga Contract 
Lifecycle Management)

12.1.0630 | 12.630

Conga CLM (Contracts for Salesforce)

(Required if you are using Conga CLM 
(Contracts for Salesforce)) 

2.53

System Requirements and Supported Platforms
 

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Windows operating system.

System Requirement Minimum Supported Version

Windows Operating System Windows 10

Microsoft Office Microsoft 365 version from 16.0.11629 to 
16.0.13231.20262

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Mac operating system.

The previous two (n-2) versions of Conga 
Contract Lifecycle Management are also 
supported.



Before installing or upgrading managed packages, you must review the dependency 
matrix for each managed package. You can refer to the package dependency 
matrix at Managed Packages Dependency Matrix. 



Microsoft 365 is a prerequisite to install and run X-Author for Contracts on Windows 
and Mac operating systems.



https://documentation.conga.com/display/TECHNOTES/Managed+Packages+Dependency+Matrix
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System Requirement Minimum Supported Version

Mac Operating System macOS Mojave (version 10.14.5)

Microsoft Office Microsoft 365 version from 15.32 to 16.51 

New Features
There are no new features in this release keep checking the Conga Documentation Portal 
for new updates.

Enhancements
There are no enhancements in this release.

 

Resolved Issues
The following table lists the issues resolved in this release.

Case 
Number

Conga 
Internal ID

Description

NA XAJS-5063 When the user tried to open a template that contained more than 150 
clauses in the same instance, the opening of the template took more 
time. 

New features and technologies are continuously deployed in new releases by X- 
Author for Contracts and they are supported by Conga where the associated 
Microsoft Office versions are also still supported by Microsoft. As Mircosoft ends its 
own support for any Office version, subsequent new Conga release will no longer be 
developed, tested, or committed to support the application on that version.





X-Author for Contracts

23
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

•

Case 
Number

Conga 
Internal ID

Description

NA XAJS-5065 X-Author for Contracts did not allow marking clauses or fields on third- 
party paper. 

Resolution: Update the external metadata with marked clause ID in 
the clause tag instead of field tag.

 

Known Issues
The following table provides the cumulative list of known issues up to this release. 

Conga Internal ID Description

XAJS-5016 A user encountered an OAuth error while logging in to the X-Author 
for Contracts on Microsoft Windows.

Resolution:

Refresh the page or enter login credentials again.

XAJS-4982 If the template's name contains special characters, then the special 
characters are replaced with space. However, the template is saved 
as is in Conga CLM.

XAJS-4531 When you set a style for a segment that contains clauses or clause 
bundles, the selected style does not apply to the clauses or clause 
bundles in the agreement document. The user observes this behavior 
when working with X-Author for Contracts for Conga CLM 
(Contracts for Salesforce).  

XAJS-2543 On clicking the Highlight option, the smart and read-only fields are 
highlighted thrice. This happens when you apply for Insert 
Comments and Track Changes protection while generating a 
document.
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Conga Internal ID Description

XAJS-2365 The formatting of the bulleted list is not proper when you perform 
the following actions:

Make a segment that contains a bulleted list conditional in a 
template.
Mark clause to a block of text that contains a bulleted list in 
the template or agreement document. 
Insert a clause that contains a bulleted list in the template or 
agreement document. 

XAJS-3386 On performing Update from CLM and Preview Reconcile, the 
Contract date format in Croatian is converted to an invalid date.

XAJS-3301 When you generate an agreement using a non-localized template, 
a currency prefix symbol is added to the currency data type field.

Workaround: Set APTS_DoNotPrefixCurrency admin entry to true 
while generating agreement documents.

XAJS-3022 Incorrect values are displayed for smart fields after regenerating 
an agreement with a different template.

XAJS-2941 The Compare pane stops responding to changing the value of a 
smart field in the Current document and comparing it.

XAJS-2899 After creating a section and a third-level table and navigating to 
the Update From CLM screen, the values of smart fields appear as 
changed even if there were no changes made to smart fields.

XAJS-2885 The currency format for the reference lookup currency field is not 
displaying as per the record-level currency.

XAJS-2975 On validating doc fields after deleting smart and merge fields, an 
error is displayed.

XAJS-2950 When you merge two versions of an agreement document 
generated with two different templates, you can view only revised 
version changes in the merged document.
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Conga Internal ID Description

XAJS-2730 The following culture-specific date formats are not supported:

Thai

ddd d MMMM yyyy (For example, ศ. 20 มกราคม 2560 is 
displayed for 20/1/2560).
'วัน'dddd'ที่' d MMMM gg yyyy (For example, วันศุกร์ที่ 20 มกราคม 
พ.ศ. 2560 is displayed for 20/1/2560).
Thai dates use Buddhist year which is 543 years ahead. 
Hence, 2017 is displayed as 2560.

Greek

el-gr ---- MMMM yyyy (For example, Μάιος 2017 is displayed 
for May 2017).

XAJS-2964 On clicking Reject changes, smart fields are appended with current 
values instead of replacing the value.

XAJS-2516 Inserting a nested clause disorganizes the clauses on the Doc 
Clauses tab.

XAJS-2700 A few built-in style segments do not apply in the generated 
document.

XAJS-2703 If an agreement document has any read-only lookup fields in the 
repeating table under the repeat section, the XAJS pane stops 
responding using the Update from CLM option.

 

DOC ID: XACSUM210716RN

Summer '21 Release Notes
Release Notes contain the following information about X-Author for Contracts Summer '21 
Release.

Packages: Lists packages that are required to upgrade to this release of the product

For more information on new features, enhancements, and document improvements, 
refer to What's New in X-Author for Contracts Summer '21 User Guide.

https://documentation.conga.com/x-author-for-contracts/latest/what-s-new-143886675.html
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System Requirements and Supported Platforms: Lists requirements and 
recommendations for installing this release
New Features: Provides high-level descriptions of new features introduced in this 
release, with links to more detailed information
Enhancements: Provides high-level descriptions of enhancements to existing features
Resolved Issues: Lists customer-reported issues that are resolved in this release or 
known issues resolved from previous releases
Known Issues: Lists known issues that are applicable in this release

Packages
The following X-Author for Contracts package is automatically upgraded to the latest 
release without any intervention. Conga Contract Lifecycle Management (dependent 
package) is required to be upgraded to this release. Separate prerequisites for each feature 
can be found in the respective guides. The packages marked as (New) are new in this 
release.

Product Latest Certified Version (Version Name | 
Version Number)

X-Author for Contracts (New) 2102

Conga Contract Lifecycle Management (New)

(Required if you are using Conga Contract 
Lifecycle Management)

12.0.0630 | 12.630 

Conga CLM (Contracts for Salesforce)

(Required if you are using Conga CLM 
(Contracts for Salesforce)) (New)

2.53

This documentation may contain descriptions of software features that are 
optional and for which you may not have purchased a license. As a result, your 
specific software solution and/or implementation may differ from those described in 
this document. Please contact your CSM or AE for information on your specific 
features and licensing.



The previous two (n-2) versions of Conga 
Contract Lifecycle Management are also 
supported.
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System Requirements and Supported Platforms
 

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Windows operating system.

System Requirement Minimum Supported Version

Windows Operating System Windows 10

Microsoft Office Microsoft 365 version from 16.0.11629 to 
16.0.13231.20262

The following table lists the minimum requirements for installing and using X-Author for 
Contracts on the Mac operating system.

System Requirement Minimum Supported Version

Mac Operating System macOS Mojave (version 10.14.5)

Microsoft Office Microsoft 365 version from 15.32 to 16.51 

New Features
The following features are new to X-Author for Contracts in this release. 

Before installing or upgrading managed packages, you must review the dependency 
matrix for each managed package. You can refer to the package dependency 
matrix at Managed Packages Dependency Matrix. 



Microsoft 365 is a prerequisite to install and run X-Author for Contracts on Windows 
and Mac operating systems.



New features and technologies are continuously deployed in new releases by X- 
Author for Contracts and they are supported by Conga where the associated 
Microsoft Office versions are also still supported by Microsoft. As Mircosoft ends its 
own support for any Office version, subsequent new Conga release will no longer be 
developed, tested, or committed to support the application, on that version.



https://documentation.conga.com/display/TECHNOTES/Managed+Packages+Dependency+Matrix
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Re-marking the extracted fields
In this release, users now have the ability to re-mark the extracted fields and lookup fields 
while reviewing them in the Doc Fields tab.

Get Started

For detailed information on re-marking the extracted fields and lookup fields, refer to 
 Reviewing Doc Fields after Intelligent Discovery in the User Guide.

Deleting the extracted fields
In this release, users now have the ability to delete the extracted fields and lookup fields 
while reviewing them in the Doc Fields tab.

Enhancements
The following section describes existing features that are changed (or are no longer 
supported) in this release.

Enhancements to User Interface
The UI of the following pages is enhanced in both Conga CLM and Conga CLM (Contracts 
for Salesforce) for a better user experience. 

User Interface Enhancement

Side Navigation Menu Enhanced to better reflect and access features such 
as Contracts, Templates, Documentation, 
TechSupport, and App details

Creating a New Template The button label 'Save' has been changed to 'Create 
New'

View Versions Enhanced for a better user experience

Insert Fields The flow of inserting fields is enhanced for a better 
user experience

https://documentation.conga.com/x-author-for-contracts/summer-21/reviewing-doc-fields-after-intelligent-discovery-148121984.html
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User Interface Enhancement

Field and Clause properties on the 
landing page

Enhanced for a better user experience

Condition Icon ( ) A lighting icon is introduced in this release to indicate 
a specific segment or clause is conditional

Opening Templates in the same instance
You can open the required template in the same instance without downloading it.

Get Started

For details on opening a template in the same instance, refer to Opening Templates for 
Conga CLM and Opening a Template for Conga CLM (Contracts for Salesforce)in X-Author 
for Contracts User Guide.

Renaming the Playbook to Clause Library
In Summer '21 release, the Playbook is renamed Clause Libray. 

Get Started

For more details, refer to Using Clause Library for TemplateUsing Clause Library for 
Template in X-Author for Contracts User Guide.

Ability to view all Conditions added to Segments and 
Clauses
You can view the conditions applied to Clause under Clause name by clicking on the 
"lightning" icon.

Ability to view field type in Insert Field pop-up window
You can view the field type while inserting a field in a template in Conga CLM and Conga 
CLM (Contracts for Salesforce).

Get Started

For detailed information on inserting fields in a template, refer to Inserting Fields in a 
Template in X-Author for Contracts User Guide.

https://documentation.conga.com/x-author-for-contracts/summer-21/opening-templates-143900944.html
https://documentation.conga.com/x-author-for-contracts/summer-21/opening-a-template-143900971.html
https://documentation.conga.com/display/XAC/.Using+Clause+Library+for+Template+vSummer-21
https://documentation.conga.com/x-author-for-contracts/summer-21/using-clause-library-for-template-143902053.html
https://documentation.conga.com/x-author-for-contracts/summer-21/inserting-fields-in-a-template-143901432.html
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Resolved Issues
The following table lists the issue resolved in this release.

Case 
Number

Conga 
Internal ID

Description

00114016 XAJS- 5027 X-Author for Contracts did not allow marking clause or field on third 
party paper. A user encountered an error while publishing the 
document from OCC after accepting all the changes.

NA XAJS-2365 The following issues can be observed while working with bullets:

When a user inserts a clause containing bullets, the last bullet 
is removed.
When a conditional segment content has bullets, an extra 
bullet is added at the end of the segment.
When there are sub-bullets, an extra bullet is added at the 
end of sub-bullets.

NA XAJS-4584 When the MS Word version is 16.0.13231.20250, the home page in the 
staging environment does not load.

 

The following table lists the known issues resolved from the previous release.

Conga 
Internal 
ID

Description

XAJS-460 
1

When a user compares two agreement documents containing date fields, the read- 
only date fields are removed and smart date fields are displayed as deleted in the 
document. 

XAJS-348 
3

When you insert a clause in a template that contains a Microsoft Word table with a 
style segment, the check-in of the template takes more than 90 seconds.  

XAJS-264 
0

Using the Hide Smart Boundary option displays the smart boundary on pressing 
Command+Z.
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Conga 
Internal 
ID

Description

XAJS-442 
2

On the latest version of Microsoft Word 16.38+ on Mac, the Insert Field pop-up window 
is displaying on the top right corner. 

Known Issues
The following table provides the cumulative list of known issues up to this release. 

Conga Internal ID Description

XAJS-5016 A user encountered an OAuth error while logging in to the X-Author 
for Contracts on Microsoft Windows.

Resolution:

Refresh the page or enter login credentials again.

XAJS-4982 If the template's name contains special characters then the special 
characters are replaced with space. However, the template is saved 
as is in Conga CLM.

XAJS-4531 When you set a style for a segment that contains clauses or clause 
bundles, the selected style does not apply to the clauses or clause 
bundles in the agreement document. The user observes this behavior 
when working with X-Author for Contracts for Conga CLM 
(Contracts for Salesforce).  

XAJS-2543 On clicking the Highlight option, the smart and read-only fields are 
highlighted thrice. This happens when you apply for Insert 
Comments and Track Changes protection while generating a 
document.
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Conga Internal ID Description

XAJS-2365 The formatting of the bulleted list is not proper when you perform 
the following actions:

Make a segment that contains a bulleted list conditional in a 
template.
Mark clause to a block of text that contains a bulleted list in 
the template or agreement document. 
Insert a clause that contains a bulleted list in the template or 
agreement document. 

XAJS-3386 On performing Update from CLM and Preview Reconcile, the 
Contract date format in Croatian is converted to an invalid date.

XAJS-3301 When you generate an agreement using a non-localized template, 
a currency prefix symbol is added to the currency data type field.

Workaround: Set APTS_DoNotPrefixCurrency admin entry to true 
while generating agreement documents.

XAJS-3022 Incorrect values are displayed for smart fields after regenerating 
an agreement with a different template.

XAJS-2941 The Compare pane stops responding on changing the value of a 
smart field in the Current document and comparing it.

XAJS-2899 After creating a section and a third-level table and navigating to 
the Update From CLM screen, the values of smart fields appear as 
changed even if there were no changes made to smart fields.

XAJS-2885 The currency format for the reference lookup currency field is not 
displaying as per the record-level currency.

XAJS-2975 On validating doc fields after deleting smart and merge fields, an 
error is displayed.

XAJS-2950 When you merge two versions of an agreement document 
generated with two different templates, you can view only revised 
version changes in the merged document.



X-Author for Contracts

33
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

•

•

•

•

Conga Internal ID Description

XAJS-2730 The following culture-specific date formats are not supported:

Thai

ddd d MMMM yyyy (For example, ศ. 20 มกราคม 2560 is 
displayed for 20/1/2560).
'วัน'dddd'ที่' d MMMM gg yyyy (For example, วันศุกร์ที่ 20 มกราคม 
พ.ศ. 2560 is displayed for 20/1/2560).
Thai dates use Buddhist year which is 543 years ahead. 
Hence, 2017 is displayed as 2560.

Greek

el-gr ---- MMMM yyyy (For example, Μάιος 2017 is displayed 
for May 2017).

XAJS-2964 On clicking Reject changes, smart fields are appended with current 
values instead of replacing the value.

XAJS-2516 Inserting a nested clause disorganizes the clauses on the Doc 
Clauses tab.

XAJS-2700 A few built-in style segments do not apply in the generated 
document.

XAJS-2703 If an agreement document has any read-only lookup fields in the 
repeating table under the repeat section, the XAJS pane stops 
responding using the Update from CLM option.

 

DOC ID: XACSUM21RN20210705
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About X-Author for Contracts
X-Author for Contracts is a Microsoft Word add-in that lets you work on contracts and 
contract templates. The X-Author for Contracts add-in helps contract administrators and 
legal users to streamline the process of creating and maintaining contracts and 
associated templates and clauses. Using X-Author for Contracts, contract administrators 
can manage complex negotiation cycles with clause and contract templates easily. X- 
Author for Contracts provides support for versioning of agreements, where contract 
administrators can save redlined, clean, and final versions of an agreement in a Microsoft 
Word document opened either from Salesforce or locally. When saving final versions, you 
can also reconcile any terms that might have changed during the negotiation process. 
Finally, users can compare two versions of a contract and also merge versions into one 
agreement document.

X-Author for Contracts also provides support for creating conditional text within a contract 
or clause template. This allows contract administrators to create sophisticated 
conditional clauses that can include or exclude certain text or clauses depending on how a 
conditional expression containing valid agreement related merge fields are evaluated. 

Prior to Winter '20 release, X-Author for Contracts was supported for Conga CLM. Using X- 
Author for Contracts, Conga CLM users can manage the entire contract and template 
process. From Winter '20 release, X-Author for Contracts introduces support for Conga CLM 
(Contracts for Salesforce).  Using X-Author for Contracts, Conga CLM (Contracts for 
Salesforce) users can manage the entire contract template process.  

This guide describes the following features for Conga CLM and Conga CLM (Contracts for 
Salesforce). 

 Features for Conga CLM Features for Conga CLM 
(Contracts for Salesforce)

Templates Create a template Create a template

Search and open a template Search and open a template

Check in a template  Check in a template
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 Features for Conga CLM Features for Conga CLM 
(Contracts for Salesforce)

Clauses

Use Playbook for templates
Insert inline clauses 
Make clauses smart or read- 
only 
Make clauses conditional 
Mark clauses 
Refresh clause 

Clauses

Use Clause Library for 
templates
Insert clause and clause 
bundles 
Make clause and clause bundle 
smart 
Make clause and clause bundle 
conditional 

Fields

Insert fields
Insert fields as a table or 
section
Make fields smart or read-only
Make columns and rows 
conditional in a table

Fields

Insert fields
Insert fields as a table or 
section
Make fields smart or read-only
Make columns and rows 
conditional in a table

Set segments (conditional or style) Set segments (conditional or style)

Define template locale Define template locale

Clone a template NA

Template Versioning  NA

Contracts Search and open an agreement NA

Check-in an agreement NA

Check-out an agreement NA

Lock or unlock agreement documents  NA



X-Author for Contracts

36 Copyright ©2022 Apttus Corporation. All rights reserved.
 

•
•
•
•
•
•
•

•

•
•
•

•
•

•
•

 Features for Conga CLM Features for Conga CLM 
(Contracts for Salesforce)

Clauses

Use Playbook to insert clauses
Mark clauses
Unmark clauses
Edit or delete clauses 
Hide or show smart boundaries
Unlock read-only clauses 
Promote marked clauses to the 
playbook
Track clauses in an agreement

NA

Fields

Validate fields
Mark fields
Update smart and read-only 
field values from Salesforce
Accept or reject field changes 
Delete fields or mark fields for 
deletion

NA

Compare and merge agreements NA

Send an agreement for parallel 
review

NA

Work with offline agreements

Create offline agreements
Import offline agreements

NA

Use Intelligent Discovery  NA

Use Localization NA

Restrict agreement document check- 
in and check-out

NA
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 Features for Conga CLM Features for Conga CLM 
(Contracts for Salesforce)

Reconciliation

Preview reconcile
Reconcile smart fields and 
smart clauses

NA

Rebranding
Previously, the product was called X-Author for Contracts 2.0. With Winter '20 release, it is 
called X-Author for Contracts.

Key Terminology
It is important to understand how terms are used when working with X-Author for 
Contracts. 

Term Definition

Agreements / Contracts A contract (or an agreement) is an arrangement with specific terms, 
enacted between two or more entities, in which there is a promise to 
perform something in return for valuable consideration or benefit.

Clauses Modular blocks of text that are used repeatedly. By adding these 
blocks to a library called a playbook, they can be reused 
continuously in multiple documents.

Document Lock/ Unlock Locking a document prevents others from editing the document and 
checking in a new version at the same time you are working on it. 
Lock or Unlock (toggle) button is available on the X-Author for 
Contracts or X-Author Templates ribbon.

Documents The dynamically generated output from the merging of an 
agreement record’s data in the CRM with the static text of a 
template.
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Term Definition

Merge Fields Static fields in a template which, at the time of agreement 
generation, take their value from the corresponding field in the 
Agreement record.

Offline Agreement 
Document

A document created directly in X-Author by taking an existing Word 
document that was created outside of Conga CLM and had not 
previously been associated with an agreement.

Playbook A repository of templates, clauses, sections, or supporting 
documents, which can be inserted in the template as inline text or 
smart content-controlled text.

Reconciliation Reconciliation is a process that enables changes made to smart 
fields in an agreement document, outside of the CRM/ X-Author 
environment, to be reconciled with the data held in the Agreement 
record in the Conga CLM.

Values of smart fields and clauses can be reconciled when you 
check-in the agreement document in X-Author for Contracts.

Smart Fields Editable fields with the content control property. You can change 
the value of a smart field in a generated agreement document. 
These values can be reconciled with the corresponding fields on the 
agreement record in the CRM.

Template Blueprints to generate a variety of document types when merged 
with data from quotes or proposals.

Read-only Fields Read-only fields have content control borders (similar to smart 
fields) but are non-editable in a generated agreement document. 
You can update the value of an Update field in an agreement 
document only by using Update from Conga CLM.

Functionally, these fields lie between smart fields and merge fields. 
Read-only fields are not inline like merge fields and their values 
cannot be edited like smart fields.

X-Author for Contracts A Microsoft Word add-in that enables the legal team of an 
organization to execute an entire contract lifecycle inside Microsoft 
Word.
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What's New in X-Author for Contracts
The following table lists changes in the documentation to support each release. 

Summer '21

Docum 
ent

Publication 
Date

Topic Description

Summer 
'21 
Release 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

06 Jul 2021  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Logging into X-Author 
for Contracts

Modified topic. Updated steps.

Opening Templates Modified topic. Updated steps. Added a note 
about template versioning.

Opening a Template Modified topic. Updated steps.

Creating New 
Templates

Modified topic. Updated steps.

Creating Templates Modified topic. Updated steps.

Inserting Fields in a 
Template

Modified topic. Updated a tip.

Making Fields Read- 
Only in a Template

Modified topic. Updated steps.

Making Fields Smart in 
a Template

Modified topic. Updated steps.

Inserting Fields in a 
Template as a Table

Modified topic. Updated steps.

Inserting Fields in a 
Template as a Section

Modified topic. Updated steps.

About Clauses Menu Modified topic. Updated the title and steps.

Making Clauses Read- 
Only in a Template

Modified topic. Updated steps.

https://documentation.conga.com/x-author-for-contracts/summer-21/logging-into-x-author-for-contracts-143903226.html
https://documentation.conga.com/x-author-for-contracts/summer-21/opening-templates-143900944.html
https://documentation.conga.com/x-author-for-contracts/summer-21/opening-a-template-143900971.html
https://documentation.conga.com/x-author-for-contracts/summer-21/creating-new-templates-143901012.html
https://documentation.conga.com/x-author-for-contracts/summer-21/creating-templates-143901007.html
https://documentation.conga.com/x-author-for-contracts/summer-21/inserting-fields-in-a-template-143901432.html
https://documentation.conga.com/x-author-for-contracts/summer-21/making-fields-read-only-in-a-template-143901447.html
https://documentation.conga.com/x-author-for-contracts/summer-21/making-fields-smart-in-a-template-143901457.html
https://documentation.conga.com/x-author-for-contracts/summer-21/inserting-fields-in-a-template-as-a-table-143901470.html
https://documentation.conga.com/x-author-for-contracts/summer-21/inserting-fields-in-a-template-as-a-section-143901509.html
https://documentation.conga.com/x-author-for-contracts/summer-21/about-clauses-menu-143901560.html
https://documentation.conga.com/x-author-for-contracts/summer-21/making-clauses-read-only-in-a-template-143901526.html
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Docum 
ent

Publication 
Date

Topic Description

Making Clauses Smart 
in a Template

Modified topic. Updated steps.

Making Clauses 
Condition-based in a 
Template

Modified topic. Updated steps. Added details 
about the lighting icon.

Setting Segments in 
Templates

Modified topic. Updated steps for styles. 

Setting Segment in 
Templates

Modified topic. Updated steps for setting styles 
for a segment in a template and edit segment 
style topics. Added details about the lighting 
icon.

Inserting Fields in 
Templates

Modified topic. Updated steps.

Inserting Clauses into 
a Template

Modified topic. Updated steps.

Changing Field Level 
Locale

Modified topic. Updated steps.

Making Fields Read- 
Only in Templates

Modified topic. Added details about the lighting 
icon.

Making Clauses and 
Clause Bundles 
Conditional in a 
Template

Modified topic. Added details about the lighting 
icon.

Reviewing Doc Fields 
after Intelligent 
Discovery

Modified topic. Added new topics.

https://documentation.conga.com/x-author-for-contracts/summer-21/making-clauses-smart-in-a-template-143901537.html
https://documentation.conga.com/x-author-for-contracts/summer-21/making-clauses-condition-based-in-a-template-143901547.html
https://documentation.conga.com/x-author-for-contracts/summer-21/setting-segments-in-templates-143901650.html
https://documentation.conga.com/x-author-for-contracts/summer-21/setting-segment-in-templates-143903179.html
https://documentation.conga.com/x-author-for-contracts/summer-21/inserting-fields-in-templates-143903261.html
https://documentation.conga.com/x-author-for-contracts/summer-21/inserting-clauses-into-a-template-143903280.html
https://documentation.conga.com/x-author-for-contracts/summer-21/changing-field-level-locale-143903194.html
https://documentation.conga.com/x-author-for-contracts/summer-21/making-fields-read-only-in-templates-143903300.html
https://documentation.conga.com/x-author-for-contracts/summer-21/making-clauses-and-clause-bundles-conditional-in-a-template-143903550.html
https://documentation.conga.com/x-author-for-contracts/summer-21/reviewing-doc-fields-after-intelligent-discovery-148121984.html
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ent

Publication 
Date

Topic Description

Making Columns and 
Rows Conditional in a 
Table

Modified topic. Added details about the lighting 
icon.

Spring '21

Docu 
ment

Topic Description

Spring 
'21 Rev 
B

Installing Pre- 
Release X-Author 
for Contracts

Modified topic. Added a 
note.

Installing 
Production X- 
Author for 
Contracts

Modified topic. Added a 
note.

Spring 
'21 Rev 
A 
 

Checking In a 
Template

Modified topic. Added a 
note.

Cloning a 
Template

Modified topic. Updated 
description of alternate 
clause field.

Reviewing Doc 
Fields after 
Intelligent 
Discovery

Modified topic. Updated 
steps and limitations.

https://documentation.conga.com/x-author-for-contracts/summer-21/making-columns-and-rows-conditional-in-a-table-143901493.html
https://documentation.conga.com/display/XACSPR21/Checking+In+a+Template
https://documentation.conga.com/display/XACSPR21/Cloning+a+Template
https://documentation.conga.com/x-author-for-contracts/spring-21/reviewing-doc-fields-after-intelligent-discovery-143887734.html
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ment

Topic Description

Spring 
'21 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Creating New 
Templates

Modified topic. Added a 
new field alternate 
clause.

Checking In 
Templates

Modified topic. Added a 
new field alternate 
clause.

Inserting Clauses Modified topic. Added a 
note for an alternate 
clause.

Creating 
Templates

Modified topic. Added a 
new field alternate 
clause.

Checking In a 
Template

Modified topic. Added a 
new field alternate 
clause.

Inserting Clauses Modified topic. Updated 
description of the topic. 

Inserting Fields in 
a Template

Modified topic. Updated 
steps.

Making Fields 
Read-Only in a 
Template

Modified topic. Updated 
steps.

Making Fields 
Smart in a 
Template

Modified topic. Updated 
steps.

Inserting Fields in 
a Template as a 
Table

Modified topic. Updated 
steps.
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ment

Topic Description

Making Columns 
and Rows 
Conditional in a 
Table

Modified topic. Updated 
steps.

Inserting Fields in 
a Template as a 
Section

Modified topic. Updated 
steps.

Logging into X- 
Author for 
Contracts

Modified topic. Removed 
a note about the 
Windows system.

Defining 
Template Locale 

Modified topic. Updated 
note about deleting 
locales. 

Highlighting 
Smart and Read- 
Only Fields

New topic. 

Cloning a 
Template

Modified topic. Added a 
new field alternate 
clause.

Inserting Clauses 
into a Template

Modified topic. Updated 
steps.

Inserting Clause 
Bundles into a 
Template

Modified topic. Updated 
steps.

Doc Fields Modified topic. 

Sending an 
Agreement 
Document for 
Parallel Review

Modified topic. Updated 
steps.
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ment

Topic Description

Extracting 
Agreement Data 
Using Intelligent 
Discovery

Modified topic. Removed 
content to unmark a 
field after Intelligent 
Discovery. 

Reviewing Doc 
Fields after 
Intelligent 
Discovery

New topic.

Reviewing Doc 
Clauses after 
Intelligent 
Discovery

New topic.

Comparing and 
Merging 
Agreement 
Documents

Modified topic. Added 
behavior and limitation.

Marking Clauses Modified topic. Added 
validation for character 
limit.

Winter '20

Docum 
ent

Topic Description

Winter 
'20 Rev 
A

Intelligent Discovery   Modified topic. Renamed Intelligent Import.

Hiding and Showing Smart 
Boundaries 

Modified topic. Updated description.

https://documentation.conga.com/x-author-for-contracts/spring-21/reviewing-doc-fields-after-intelligent-discovery-143887734.html
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Docum 
ent

Topic Description

Winter 
'20

Managing Templates

Creating Templates
Opening a Template
Checking in a 
Template
Using Fields
Inserting Fields in 
Templates
Making Fields Smart 
in Templates
Making Fields Read- 
Only in Templates
Inserting Fields in 
Templates as a 
Table
Making Table 
Columns and Rows 
Conditional
Inserting Fields in 
Templates as a 
Section
Using Clauses
Using Clause Library 
for Templates 
Inserting Clauses 
into a Template
Inserting Clause 
Bundles into a 
Template
Making Clauses and 
Clause Bundles 
Smart in a Template
Making Clauses and 
Clause Bundles 
Conditional in a 
Template
Setting Segment in 
Templates
Using Template 
Locale

New topic. X-Author for Contracts introduces support 
for Conga CLM (Contracts for Salesforce). All the features 
listed in the Topic are supported for Conga CLM 
(Contracts for Salesforce).
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Topic Description

Changing Field Level 
Locale

 Installing Pre-release X- 
Author for Contracts

Modified topic. Updated steps to install pre-release X- 
Author for Contracts. 

 Upgrading X-Author for 
Contracts

Modified topic. Updated steps to upgrade.

 Changing Installation 
Approach 

New topic.

 Opening an Agreement 
Document

Modified topic. Added a limitation about date picker.

Summer '20

https://documentation.conga.com/display/XAC/.Changing+the+Installation+Approach+vSpring-21
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Summer 
'20 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Installing 
Production X- 
Author™ for 
Contracts 2.0

Modified topic. 

Added content about Centralized Deployment approach
Added content about support for Windows operating 
system
Updated installation steps 

Making Clauses 
Read-Only in a 
Template 

New topic. A new feature for this release.

Unlocking Read- 
Only Clause

Modified topic. Updated description of the topic. 

Making Clauses 
Smart in a 
Template

Modified topic. Updated the screenshot.

Creating New 
Templates

Modified topic. Added content for new fields like Name, 
Agreement Type, Category, Subcategory, Language, Keywords, 
Next Revision Date, Description, and Guidance. 

Extracting 
Agreement Data 
Using Intelligent 
Discovery

New topic. A new feature for this release.

Template 
Versioning 

New topic. A new feature for this release.

Creating New 
Template Versions

New topic. A new feature for this release.

Opening Template 
Versions

New topic. A new feature for this release.

Locking and 
Unlocking 
Templates 

New topic. A new feature for this release.
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Checking In 
Template Versions

New topic. A new feature for this release.

Cloning Template 
Versions

New topic. A new feature for this release.

Using Playbook Modified topic. Added content for working with non-versioned 
clause templates.

Promoting Clauses 
to Playbook

Modified topic. Added a note for template versioning. 

Creating Offline 
Agreements

Modified topic. Updated the screenshot.

Inserting Fields in a 
Template as a 
Table

Modified topic. Added a step about making columns and rows 
conditional in a table.

Making Columns 
and Rows 
Conditional in a 
Table

New topic. A new feature for this release.

Logging into X- 
Author™ for 
Contracts 2.0

Modified topic. Removed Prerequisite and updated steps to log 
in. 

Opening an 
Agreement 
Document

Modified topic. Added product limitations.

Refreshing Clauses 
in a Template 

Modified topic. Added behavior and limitations.

Marking Clauses  Modified topic. Added behavior and recommendation. 
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Upgrading X- 
Author™ for 
Contracts 2.0

Modified topic. Added a note about Centralized Deployment.

Spring '20

Docu 
ment

Topic Description

Spring 
'20 
Rev A

Updating 
Multiple 
Smart Fields 
in a 
Document

New topic.

Spring 
'20 

Support for 
Office 365

X-Author for Contracts provides beta support for Office 365 online and is 
open to a limited audience. If you want to know more about the feature or 
you have any queries, please contact Product Management.

Winter '19
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ment

Topic Description

 
Winter 
'19 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Creating 
Offline 
Agreements

Modified topic. Added content about the ability to perform the parallel 
review for offline agreements.

Importing 
Offline 
Agreements

Modified topic. Added content about the ability to perform the parallel 
review for imported offline agreements.

Inserting 
Clauses

Modified topic. Added content for tracking clauses inserted as plain text.

Tracking 
Clauses in 
your 
Agreement 
Document

Modified topic. Added content for tracking clauses inserted as plain text.

Checking in 
an 
Agreement 
Document

Modified topic. Added details about the ability of administrators to 
control the availability of check-in options.

Sending an 
Agreement 
Document 
for Parallel 
Review

Modified topic. Added details about the ability of administrators to 
control the availability of check-in options.

Inserting 
Fields in a 
Template

Modified topic. Added content for searching fields while inserting fields in 
a template.

Tracking 
Review 
Status

New topic. A new feature for this release.
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Docu 
ment

Topic Description

Creating 
New 
Templates

Modified topic. Added content for locale support while creating a 
template.

Cloning a 
Template

Modified topic. Added content for locale support while cloning a template.

Checking In 
Templates

Modified topic. Added content for locale support while checking-in a 
template.

Defining 
Template 
Locale

New topic. A new feature for this release.

Changing 
Field Format 
by Locale

New topic. A new feature for this release.

Upgrading 
X-Author for 
Contracts 
2.0

New topic. A new feature for this release.

Logging into 
X-Author for 
Contracts 
2.0

Modified topic. Added information about the new login UI.

Installing 
Production 
X-Author for 
Contracts 
2.0

Modified topic. Added details about the new installer.

Installing 
Pre-Release 
X-Author for 
Contracts 
2.0

New topic. A new feature for this release.
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Docu 
ment

Topic Description

Installing 
Pre-Release 
X-Author for 
Contracts 
2.0 Without 
an Installer

New topic. A new feature for this release.

Installing 
Production 
X-Author for 
Contracts 
2.0 Without 
an Installer

Modified topic. Added new manifest file details.

Summer '19

Document Topic Description

Summer '19 
 
 
 
 
 

Localization New topic. A new feature for this release.

Use Case: Managing 
Localization

New topic. A new feature for this release.

Comparing and Merging 
Agreement Documents

New topic. A new feature for this release.

Unlocking Read-Only 
Clauses

New topic. A new feature for this release.

Restricting Agreement 
Document Check-In and 
Check Out

New topic. A new feature for this release.

Sending an Agreement 
Document for Parallel 
Review

New topic. A new feature for this release.

Working with Files New topic. A new feature for this release.
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Spring '19

Document Topic Description

Spring '19 
 
 
 

Preview Reconciliation New topic. A new feature for this 
release.

Hiding or Showing Smart 
Boundaries

New topic. A new feature for this 
release.

Inserting Fields in a Template 
as a Table

New topic. A new feature for this 
release.

Inserting Fields in a Template 
as a Section

New topic. A new feature for this 
release.

Setting Segments in 
Templates

New topic. A new feature for this 
release.

Winter '18

Document Topic Description

Winter '18 
 

 

 

Making Fields Read Only in a 
Template

New topic. A new feature for this 
release.

Refreshing Clauses in a Template New topic. A new feature for this 
release.

Opening an Agreement Document Modified topic. This topic is updated 
to add information about the 
number of agreements displayed on 
logging in.

Summer '18
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Document Topic Description

Summer '18 
 
 
 
 
 
 

Template Expression Builder New topic. A new feature for this 
release.

Setting Segments in Templates New topic. A new feature for this 
release.

Deleting Smart Elements New topic. A new feature for this 
release.

Promoting Clauses New topic. A new feature for this 
release.

Inserting Inline Clauses Modified topic. This topic is updated 
to add information about the new 
inline clauses feature.

Tracking Clause Activity New topic. This topic is added for 
enhancement to Clause Tracking 
feature.

Making Clauses Condition- 
based

New topic. A new feature for this 
release, as part of the Template 
Expression Builder feature.

About Template Clauses Renamed to About Template Clauses 
Menu.
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X-Author for Contracts for Users
With the X-Author for Contracts User Guide, you can find out how X-Author for Contracts 
(previously known as X-Author for Contracts 2.0) works with Conga CLM and Conga CLM 
(Contracts for Salesforce), and how you can manage your organization's and your 
customers' contracts. 

Topic Description

What's Covered This guide walks the X-Author for Contracts user through an entire contract 
lifecycle inside Microsoft Word while complying with approval workflows and 
using the latest terms and clauses from your legal Playbook or Clause Library. 
It covers step-by-step instructions, and use cases for the features provided by 
X-Author for Contracts.

Primary 
Audience

Individuals who are working on any aspect of contracts: contract managers, 
contract creators, contract negotiators, and contract reviewers.

IT Environment Refer to the latest XAC Release Notes for information on System Requirements 
and Supported Platforms.

Updates For a comprehensive list of updates to this guide for each release, see the 
What's New in X-Author for Contracts topic.

Other Resources Refer to the Conga CLM documentation for detailed instructions for installing 
and setting-up Conga CLM in your organization.

This guide describes the following tasks: 

Working with X-Author for Contracts for Conga CLM
Creating a template
Searching and opening a template
Cloning a template
Checking in a template
Using Playbook for templates and agreements

Prior to Winter '20 release, X-Author for Contracts was supported for Conga CLM. 
Using X-Author for Contracts, the Conga CLM users can manage the entire contract 
and template process. From Winter '20 release, X-Author for Contracts introduces 
support for Conga CLM (Contracts for Salesforce).  Using X-Author for Contracts, 
the Conga CLM (Contracts for Salesforce) users can manage the entire contract 
template process. 
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Using clauses
Using fields
Using template versioning 
Creating offline agreements
Importing offline agreements
Marking clauses and fields
Using template expression builder
Updating fields from Conga CLM
Comparing and merging agreement documents
Sending an agreement document for parallel review
Using Intelligent Discovery

Working with X-Author for Contracts for Conga CLM (Contracts for Salesforce) 
Creating a template
Searching and opening a template
Checking in a template
Using Clause Library for templates
Using fields
Using clauses
Setting segments in a template 
Using Template Locale 

Before using X-Author for Contracts, you must be familiar with the following:

Basic Salesforce administration
Microsoft Word
Conga terms and definitions

 
Select one of the following topics for more information:

Getting Started
Working with Conga CLM
Working with Conga CLM (Contracts for Salesforce)
FAQs

Getting Started
X-Author for Contracts add-in works with both Conga CLM and Conga CLM (Contracts for 
Salesforce). For both products, the add-in can be installed and accessed the same way. 

This section covers:
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1.
2.

3.
4.
5.

6.
7.

1.
2.

Installing Production X-Author for Contracts
Installing Pre-Release X-Author for Contracts
Logging into X-Author for Contracts
Upgrading X-Author for Contracts

Installing Production X-Author for Contracts
You can install the X-Author for Contracts as a Microsoft Word add-in on Mac or Windows 
operating system using Microsoft AppSource.

To install X-Author for Contracts add-in 
Open Microsoft Word.
If you are installing the X-Author for Contracts add-in on Windows operating system, 
sign in to Microsoft Word.
Select the Insert tab and click My Add-ins.
Select the Store tab.
Use the search box to search for the X-Author for Contracts add-in. For example, you 
can use Conga or X-Author Contracts keywords to search for the add-in.
Click Add next to the X-Author for Contracts add-in.
Review the License terms and Privacy policy and click Continue.

On the Home tab of Microsoft Word, you can see the X-Author Contracts ribbon.

Installing Pre-Release X-Author for Contracts
To install the pre-release X-Author for Contracts, perform the following steps:

Go to https://community.apttus.com/.
Log in to the Apttus Community Portal.

To remove the X-Author for Contracts add-in, right-click on the X-Author Contracts 
ribbon and click Remove Add-in.



Ensure that you have verified the installed packages in your org. If both Conga CLM 
and Conga CLM (Contracts for Salesforce) are installed in the org, you must create 
an admin entry APTS_DEFAULT_PACKAGE in Conga CLM for the user to decide 
which CLM to connect to. For more information about this admin entry, refer to the 
Post-Installation Settings and Admin Entries topics in Conga CLM Administrator 
Guide.



https://community.apttus.com/
https://documentation.conga.com/display/CLM/Post-installation+Settings
https://documentation.conga.com/display/CLM/Admin+Entries


X-Author for Contracts

58 Copyright ©2022 Apttus Corporation. All rights reserved.
 

3.
4.
5.
6.
7.

•
•
•

Go to Resources and click Install Center-Salesforce Only.
Click Pre-release.
Click Download available for X-Author for Contracts Pre-Release. 
In the Download File window, click Confirm Download.
Use the Centralized Deployment approach to install the X-Author for Contracts add- 
in. For more information about installing X-Author for Contracts add-in using 
Centralized Deployment, see Centralized Deployment. 

Centralized Deployment Approach
You can install the pre-release X-Author for Contracts add-in using Centralized 
Deployment via the Office 365 admin center. Centralized Deployment supports both 
Windows operating system and Mac operating system and the deployment approach is the 
same for both the operating systems. 

To install the pre-release X-Author for Contracts add-in, the Office 365 administrator must 
first deploy the X-Author for Contracts add-in in Office 365. Deploying the add-in is a one- 
time activity. When the administrator installs the add-in for the first time in their 
organization, only then the administrator need to deploy the add-in. During deployment, 
the administrator can assign the add-in to a user, to multiple users via a group, or to 
everyone in their organization. The users that are assigned add-in access, must insert add- 
in in their Microsoft Word. 

If the administrator needs to assign the add-in to new users after the administrator has 
installed the add-in using Centralized Deployment:

No action is required if the add-in was assigned to Everyone. 
Add new users to the group if the add-in was assigned to Group. 
Give access to new users if the add-in was assigned to Specific users. 

When the administrator assigns add-in to new users, the users must insert add-in in their 
Microsoft Word.

The following table provides an overview of different administrator and user actions that 
need to be performed for different use cases: 

After installing the X-Author for Contracts pre-release, you must create an admin 
entry APTS_XAAddInLoadType in Conga CLM and set the value to "centralized". For 
more information about this admin entry, refer to the Post-Installation Settings 
topic in the Conga CLM Administrator Guide.
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Use case Assign Users Admin Action User Action

Assigning add-in to 
users during the first- 
time installation

Everyone/Group/ 
Specific users

Deploy X-Author for 
Contracts add-in

Insert X-Author for 
Contracts add-in

Assigning add-in to 
new users after 
installation

Everyone  No action Insert X-Author for 
Contracts add-in

Group  Add new users to the 
group

Insert X-Author for 
Contracts add-in

Specific users  Give access to new users Insert X-Author for 
Contracts add-in

Deploying X-Author for Contracts Add-in
As an Office 365 administrator, you can deploy the X-Author for Contracts add-in and 
assign the add-in directly to a user, to multiple users via a group, or to everyone in your 
organization. 

Prerequisites

You must have the administrator role to deploy the add-in.
You must have the pre-release X-Author for Contracts manifest file.  
Ensure that your organization meets all requirements for using centralized 
deployment. For information about how to determine if your organization can use 
centralized deployment, see Determine if Centralized Deployment of add-ins works 
for your Office 365 organization.

To deploy X-Author for Contracts add-in 
Sign in to Office 365 with your account.
Select the app launcher icon in the upper-left and select Admin.
In the navigation menu, click Show more, then select Settings and click Services & 
add-ins.
Select Deploy Add-In and click Next after reviewing the requirements. 
On the Centralized Deployment page, select I have the manifest file (.xml) on this 
device option.
Click Browse to locate the manifest file (.xml) that you want to use.

https://docs.microsoft.com/en-us/office365/admin/manage/centralized-deployment-of-add-ins
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On the Assign Users page, choose from Everyone, Specific Users/Groups, or Only me. 
Use the search box to find the users and groups to whom you want to deploy the add- 
in.
Click Deploy. 

The X-Author for Contracts add-in is added in Office 365. Users to whom permission is given 
can directly insert the add-in in their Microsoft Word. It can take up to 24 hours for the add- 
in to show up for all users.

Inserting X-Author for Contracts Add-in
Any user with add-in installation privileges can insert the X-Author for Contracts add-in in 
their Microsoft Word. 

To insert X-Author for Contracts add-in
Open Microsoft Word.
Sign in to Microsoft Word.
Select Insert tab and click My Add-ins.
Select Admin Managed tab.
In the Admin Managed tab, select X-Author Contracts add-in. If you are unable to see 
the add-in, click Refresh. 
Click Add.

On the Home tab of Microsoft Word, you can see the X-Author Contracts ribbon.

For more information about installing, publishing, and managing add-ins using 
centralized deployment via the Office 365 admin center, see Publish add-ins via 
Centralized Deployment and Manage deployment of add-ins. If you want to remove 
the add-in, see Delete the add-in.



If you are unable to install the X-Author for Contracts using Centralized 
Deployment, you can contact Support.



To remove the X-Author for Contracts add-in, right-click on the X-Author Contracts 
ribbon and click Remove Add-in.



https://docs.microsoft.com/en-us/office/dev/add-ins/publish/centralized-deployment
https://docs.microsoft.com/en-us/microsoft-365/admin/manage/manage-addins-in-the-admin-center?view=o365-worldwide
https://docs.microsoft.com/en-us/microsoft-365/admin/manage/manage-addins-in-the-admin-center?view=o365-worldwide#delete-an-add-in
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Logging into X-Author for Contracts
Before you can work with your agreement documents in X-Author for Contracts, you must 
log in to your Salesforce org.

Prerequisite

The X-Author for Contracts add-in must be installed and added in Microsoft Word. 
For more information about installing the add-in, see Install Production X-Author for 
Contracts.

To log in to X-Author for Contracts
Open a new document or the existing document in Microsoft Word.
Click X-Author Contracts ribbon on the Home tab. The login panel opens.
Click Login.  
or  
Click the menu icon ( ) and click Login.  
You are navigated to the Salesforce production login page.
Enter your production credentials (Username and Password) and click Login.
If it is the first time you are logging in to your Salesforce org from the add-in, you may 
be prompted to allow access to X-Author for Contracts. Click Allow to proceed.

You are logged into the X-Author for Contracts add-in.

The following options are displayed when you click on the menu icon ( ).

https://documentation.conga.com/x-author-for-contracts/summer-21/installing-production-x-author-for-contracts-148121703.html
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Option Description

User Name & User ID Displays the user name and ID

Contracts To work with Contracts

Templates To work with Templates

Documentation To navigate the X-Author for Contracts 
documentation

Technical Support To connect with the technical support team.

App Details (earlier System information) To view the system information that you are 
currently logged in

Log Out To logout from the X-Author for Contracts

To log out of X-Author for Contracts
Click the menu icon ( ).
Click Log Out "<username>" to logout.

Upgrading X-Author for Contracts

If you are an existing user and upgrading to the latest release using the Sideloading 
approach, you need to download the latest manifest file from the install center.  

Prerequisite

You must have login credentials to the Apttus Community Portal to be able to 
download the X-Author for Contracts manifest file.

On the login page, when you click Log In To Sandbox you are navigated to the 
Salesforce sandbox login page and you need to enter Sandbox credentials to log in.



If you have installed the X-Author for Contracts add-in using Microsoft AppSource, 
the X-Author for Contracts add-in is automatically upgraded to the latest release 
without any intervention (silent auto-upgrade).
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To download the latest manifest file
Go to https://community.apttus.com.
From the Resources dropdown, select Install Center - Salesforce Only.
In the Contract Management section, click    Download available for X-Author for 
Contracts.
In the Download File window, click Confirm Download. 

To upgrade using the Sideloading approach 
If you are an existing user and using the Sideloading approach, download the latest 
manifest file and perform the following actions to upgrade the X-Author for 
Contracts add-in to the latest release:

Update the manifest file in your Mac system.
Close the Microsoft Word application on your system (if open) and open it again.
In Microsoft Word, select the Insert tab and click My Add-ins.
If you are unable to see the updates, click Refresh. 

Working with Conga CLM
The following sections describe the features you can use in X-Author for Contracts when 
working with Conga CLM.

Templates
Creating New Templates
Opening Templates
Cloning a Template
Checking In Templates

If you are an existing user and upgrading to Pre-release, go to Pre-release 
Install Center and download the X-Author for Contracts Pre-release manifest 
file.



Instead of using the Sideloading approach, you are recommended to adopt the 
Microsoft AppSource approach to access the X-Author for Contracts add-in. For 
more information about changing the installation approach, see Changing 
Installation Approach.



https://community.apttus.com/
https://apttusportal.force.com/community/ApttusInstallCenterPreRelease
https://documentation.conga.com/display/XAC/.Changing+the+Installation+Approach+vSpring-21
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Clauses
Using Clause Library for Template
About Clauses Menu
Making Clauses Smart in a Template
Making Clauses Condition-based in a Template
Marking Clauses in a Template
Refreshing Clauses in a Template
Making Clauses Read-Only in a Template

Fields
Inserting Fields in a Template
Making Fields Read Only in a Template
Making Fields Smart in a Template
Inserting Fields in a Template as a Table
Making Columns and Rows Conditional in a Table
Inserting Fields in a Template as a Section

Setting Segments in Templates
Defining Template Locale

Changing Field Format by Locale
Template Versioning

Creating New Template Versions
Opening Template Versions
Locking and Unlocking Templates
Checking In Template Versions
Cloning Template Versions

Contracts
Opening an Agreement Document

Locking and Unlocking Documents
Using Playbook

Marking Clauses
Inserting Clauses
Preview Reconciliation
Hiding or Showing Smart Boundaries
Unlocking Read-Only Clauses
Marking Fields

Doc Clauses
Doc Fields
Highlighting Smart and Read-Only Fields
Checking in an Agreement Document

Reconciliation
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Updating Fields from Conga CLM
Opening Agreements in Conga CLM
Creating Offline Agreements
Importing Offline Agreements
Extracting Agreement Data Using Intelligent Discovery

Reviewing Doc Fields after Intelligent Discovery
Reviewing Doc Clauses after Intelligent Discovery

Tracking Clauses in your Agreement Document
Localization

Use Case: Managing Localization
Restricting Agreement Document Check-In and Check Out
Working with Files
Promoting Clauses to Playbook
Comparing and Merging Agreement Documents
Sending an Agreement Document for Parallel Review
Tracking Document Review Status
Deleting Smart Elements Using Delete or Backspace Key
Updating Multiple Smart Fields in a Document

Templates
A template is a common set of sections, clauses, text, and placeholders for terms and 
conditions. Templates can be merged with structured data to generate agreements or 
proposals. Templates are stored within a template repository and are used to create 
quotes and contracts. A template can be termed as a blueprint or mold for creating 
distributable documents.

In a typical scenario where an agreement/proposal document is sent to an external party 
for negotiation, the external party makes changes to the document as part of the 
negotiation. The following sections describe the features you can use in Templates when 
working with agreement templates.

Creating New Templates
Opening Templates
Cloning a Template
Checking In Templates
Clauses
Fields
Setting Segments in Templates
Defining Template Locale
Template Versioning
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Creating New Templates
To get started with creating a new Agreement or Clause template in X-Author for 
Contracts, you must first define the basic properties for your template.

To create a new Template
Open an existing document or a blank document in Microsoft Word and log in to X- 
Author for Contracts
From the Contracts pane, click the left-hand menu icon  and select Templates.
Click Create New tab in the Templates pane.
In the Create New tab enter the following details, (fields marked with an asterisk * 
are required)

Field Name Description

Name Enter the name of the template.

Type Choose the template type from the Agreement, Clause, 
Proposal, Section, and Supporting Document.

Business Object Choose the business object for your template (e.g., 
Apttus__APTS_Agreement__c for Agreement). This picklist is 
dependent on the value selected for Type.

Alternate Clause Select the checkbox to create an alternate clause. This field is 
only displayed when you select Clause as type and Agreement 
(Apttus__APTS_Agreement__c) as business object.

Agreement Types From the picklist, you can select multiple agreement types to 
associate with your template. The value of Agreement Types 
decides which templates are available at the time of 
agreement generation. If your template's agreement type 
matches with the agreement type of your agreement record, 
you will see that template in the list of available templates at 
the time of document generation.
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Field Name Description

Category Choose the category from the picklist. Template categories are 
defined by the administrator, in Conga CLM. This field is usually 
used by template administrators to categorize templates 
created by them for easy access.

Subcategory The subcategory is a dependent field. Subcategories are 
populated-based on the value chosen for Category. The 
subcategories are defined by the administrator, in Conga CLM.

Language  Choose the default template language from the picklist. The 
default language for the template is English (US).

Locale Select the locale from the picklist. Locale allows you to define 
locale settings for number and currency precision, currency 
format, and date format. Locales can be system defaults or 
user-defined locales. You can configure custom locales in 
Contract Management. For more information, see Adding 
Custom Locale topic in Conga CLM Administrator Guide.

Enable Formatting Check this box to enable locale formatting at the template 
and field level for this template. This allows you to define 
locale settings for Currency, Number, and Date formats. 
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Field Name Description

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale 
formatting.

Field Description

Date Format Select an option from the picklist to choose the default 
format for all date fields in the template.

Currency Format Select an option from the picklist to choose the format for 
all currency fields in the template. Choose "None" to only 
display currency field values in generated documents.

If "Currency Symbol" is selected, currency fields will 
be generated with no space between the symbol and field 
value. If "ISO" is selected, currency fields will be generated 
with a space between the ISO code and the field value.

Number Precision Select a number from 0-9 to define the precision for 
Number/Percent field values in the template. This allows 
you to define the number of digits to be displayed after 
the decimal (e.g., "2" if the Number/Percent field should 
display two digits following the decimal point).

Currency Precision Select a number from 0-9 to define the precision for 
currency field values in the template. This allows you to 
define the number of digits to be displayed after the 
decimal in currency value (e.g., "2" if the currency field 
should display two digits following the decimal point).

Keywords Enter comma-separated keywords to associate with the 
template. Keywords make it easier to search the templates.

Next Revision Date Select the date for the next revision of the template.

Description Enter the description for the template. Maximum of 255 
characters (an error will be thrown if this limit is exceeded). 
Using this field, you can provide a detailed description of the 
template. 
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Field Name Description

Guidance Enter guidance to help users determine the purpose of the 
template.

Click Create to confirm the template properties.

The Work Tab is enabled. You can now work with your template.

Opening Templates
You can open any type of template from the repository and make changes to static text 
and other content in the document. When you are finished, you can check in the template 
and modify properties as needed (for example, changing which agreement types it is 
associated with).

To open a template
Open Microsoft Word and launch the add-in.
Log in to X-Author for Contracts.
From the Contracts pane, click the left-hand menu icon  and select Templates.
In the Open Templates tab, use the Search Templates box to search for a template 
by keyword. Click the filter icon  to expose drop-down menus that can help you to 
refine your search according to Template Type, Category, Subcategory, Locale, and 
Language. A list of Templates is displayed with the last modified <Month Date, 
Year>. 
From the list of documents, click on the template name link. It opens the latest 
activated version of a particular template in the same instance.
To view and open an old template version, click the down arrow  to expand and 
view the guidance for the template.
Click View Versions to navigate the template details page where you can find the 
details like Type, Object, Is Active, and Active Version.
Click the template name link. click on the template name link. It opens it in Word.

If the Template name has special characters in the template name, then each 
special character is replaced with space during the check-out of the template. 
However, the special characters in the template name are saved as is in Conga 
CLM.
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Your template is opened. You can modify the template as per your requirement and check- 
in your template.

Cloning a Template
You can clone an existing template that you have opened to make a new copy of the 
template.

Prerequisite

You must have an existing template opened.

To clone a template from an existing template
From the left navigation panel, select Templates.

In the Templates pane, go to the Work tab, click the more icon ( ) and select Clone.
In the Clone Template page, change the name of the cloned template, to suit your 
requirements. By default, the cloned template name has 'Copy' added to the end of 
the original template name. For example, if you're cloning a template named Clause 
Agreement Template then the default name for the cloned template will be Clause 
Agreement Template Copy.  
You have the option to change the settings of your template when you clone it. You 
can specify the following fields:

Field Description

Name* Enter the name of the template.

Type Choose the template type from the picklist (Agreement, Proposal, Clause, etc.).

•

•

•

When the Template Versioning is Enabled, on opening a specific template, the 
name of the template is updated each time when you open a template 
version.

TemplateName <Version#> <number of times the same template version 
is opened>. For example, If you opened the second version of a template 
for 4th time, then the template name is displayed as TemplateName V2 
4.

When the Template Versioning is Disabled, on opening a specific template, the 
name of the template does not contain the version details.
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Field Description

Business 
Object

Choose the business object for your template (e.g., 
 Apttus__APTS_Agreement__c for Agreement). This picklist is dependent on the 
value selected for Type.

Alternat 
e Clause

You can mark a clause as an alternate clause while cloning a template. The 
standard clause can be marked as an alternate clause. You can not uncheck 
this checkbox while cloning an alternate clause.

Agreeme 
nt Types

From the drop-down, you can select multiple Agreement types to associate with 
your template. The value of Agreement Types decides which templates are 
available at the time of agreement generation. If your Template's Agreement 
Type matches with the Agreement Type of your agreement record, you will see 
that template in the list of available templates at the time of document 
generation.

Categor 
y

Choose the category from the drop-down. The categories are defined by the 
administrator, in Conga CLM.

Subcate 
gory

The subcategory is a dependent field. The Subcategories are populated, based 
on the value chosen for Category. The subcategories are defined by the 
administrator, in Conga CLM.

Languag 
e

Choose the default template language

Locale Choose an option from the list to change the default locale for the template. 
 You can configure custom locales in Conga CLM. For more information, 
see Adding Custom Locale topic in Conga CLMAdministrator Guide.

Enable 
Formatti 
ng

Check this box to enable locale formatting at the template and field level for 
this template. This allows you to define locale settings for Currency, Number, 
Percent and Date formats. 
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Field Description

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale 
formatting.

Field Description

Date Format Select an option from the drop-down to choose the 
default format for all date fields in the template.

Currency Format Select an option from the drop-down to choose the 
format for all Currency fields in the template. Choose 
"None" to only display Currency field values in generated 
documents.

If "Currency Symbol" is selected, Currency fields will 
be generated with no space between the symbol and 
field value. If "ISO" is selected, Currency fields will be 
generated with a space between the ISO code and the 
field value.

Number Precision Enter a number from 0-9 to define the precision for 
Number/Percent field values in the template (e.g., "2" if 
the Number field should display two digits following the 
decimal point.)

Currency Precision Enter a number from 0-9 to define the precision for 
Currency field values in the template (e.g., "2" if the 
Currency field should display two digits following the 
decimal point.)

Keyword 
s

Enter comma-separated keywords to associate with the template. Keywords 
make it easier to search the templates.

Next 
Revision 
Date

Identify a date for the next revision of the template.

Descripti 
on

Enter a new description or modify the existing description for the template. 
Maximum of 255 characters (an error will be thrown if this limit is exceeded).
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Field Description

Guidance Enter new guidance or modify existing guidance to help users determine the 
purpose of the template.

Active Select the Active switch to 'On' to activate the template. You must activate a 
template to use it for generating an agreement document.

Click Clone to save the cloned template in Conga CLM.

Checking In Templates
A template is a blueprint using which an agreement is generated and clauses or supporting 
documents are created. Template outlines the content and the format of an agreement, 
clause, and supporting document. After you create a new template or make changes to an 
existing template, you can check-in the template to update its contents in Conga CLM.

Prerequisite
You must have a template checked-out or created to check-in a template.

To check-in a template
In the Templates pane, click the Finish tab.
Under Check-in, enter the value of the following fields, (the fields marked with asterisk 
* are required)

Field Description

Name* Enter the name of the template.

Type It displays the selected template type. You can not edit the 
type while check-in.

Business Object It displays the selected business object. You can not edit the 
business object while check-in.
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Field Description

Alternate Clause Select the checkbox to create an alternate clause. This field 
is only displayed when you select Clause as type and 
Agreement (Apttus__APTS_Agreement__c) as a business 
object while creating a template. You can only update this 
checkbox while checking-in a template the first time.

Agreement Types From the drop-down, you can select multiple Agreement 
types to associate with your template. The value of 
Agreement Types decides which templates are available at 
the time of agreement generation. If your Template's 
Agreement Type matches with the Agreement Type of your 
agreement record, you will see that template in the list of 
available templates at the time of document generation.

Category Choose the category from the drop-down. The categories are 
defined by the administrator, in Conga CLM.

Subcategory The subcategory is a dependent field. The Subcategories are 
populated, based on the value chosen for Category. The 
subcategories are defined by the administrator, in Conga 
CLM.

Language Choose the default template language

Locale Select the locale from the drop-down. You can configure 
custom locales in Conga CLM. For more information, 
see Adding Custom Locale topic in Conga CLMAdministrator 
Guide.

Enable Formatting Select this checkbox to enable locale formatting at the 
template level for this template.
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Field Description

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale 
formatting.

Field Description

Date Format Select an option from the drop-down to choose the 
default format for all date fields in the template.

Currency Format Select an option from the drop-down to choose the 
format for all Currency fields in the template. Choose 
"None" to only display Currency field values in generated 
documents.

If "Currency Symbol" is selected, Currency fields will 
be generated with no space between the symbol and 
field value. If "ISO" is selected, Currency fields will be 
generated with a space between the ISO code and the 
field value.

Number Precision Enter a number from 0-9 to define the precision for 
Number/Percent field values in the template (e.g., "2" if 
the Number/Percent field should display two digits 
following the decimal point.)

Currency Precision Enter a number from 0-9 to define the precision for 
Currency field values in the template (e.g., "2" if the 
Currency field should display two digits following the 
decimal point.)

Keywords* Enter comma-separated keywords to associate with the 
template. Keywords make it easier to search the templates.

Next Revision Date Identify a date for the next revision of the template.

Description Enter a new description or modify the existing description for 
the template. Maximum of 255 characters (an error will be 
thrown if this limit is exceeded).

Guidance Enter new guidance or modify existing guidance to help users 
determine the purpose of the template.
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Field Description

Activate Select the Active switch to 'On' to activate the template. You 
must activate a template to use it for generating an 
agreement document.

Click Check In. 
A message is displayed that your template is checked in and the template is 
downloaded. You can open the template and continue working on the template. You 
can now use the Playbook to insert clauses.

Your template is checked in to Conga CLM. A new template record is created for the 
template if this is the first check-in or modified if it already exists. A DOCX copy of the 
template is added in the Notes & Attachments related list in Conga CLM.

Clauses
Clauses are modular blocks of text that are used frequently across multiple templates. You 
create clauses as described in Creating New Templates. After a clause is created, you can 
use Clause Library to insert clauses into a template.

The following sections explain how you can use clauses in your agreement template:

Using Clause Library for Template
About Clauses Menu
Making Clauses Smart in a Template
Making Clauses Condition-based in a Template
Marking Clauses in a Template
Refreshing Clauses in a Template
Making Clauses Read-Only in a Template

Using Clause Library for Template
Clause Library is a library of clauses, or clause templates, that each contains modular 
blocks of contractual language that can be reused across multiple agreement templates. 

If you are using X-Author for Contracts add-in in the Windows version of Microsoft 
Word, the screen resolution must be up to 125% to select a date from the date 
picker. It doesn't work with a screen resolution of 150%. 
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Clause Library helps you to search for clauses or supporting documents that can be 
inserted into the template as inline text.

To insert a clause from Clause Library into a template
In the Templates pane, go to Work > Clause Library.
Use the Search by Clause Name box to search a clause by keyword. 
Click the filter icon  to expose drop-down menus that can help you to refine your 
search according to Type, Category, Subcategory, Locale, and Language.

Place the cursor in the section of the template where you want to insert a clause.
Click a clause from the list to view the clause text and active version. Select the 

clause from the Clause Library pane, click icon  next to the clause name and click 
Insert this Clause to insert the clause into your template as inline text.

You see a success message on successfully inserting a clause. The clause content is marked 
by a content control boundary in your template.

To delete a clause
Select the clause text in the template and press Delete on your keyboard. The selected 
clause text is deleted from the template.

About Clauses Menu
The Clauses menu lists all the clauses (inserted and marked) and fields present in the 
currently opened template. The fields contained within a clause are shown hierarchically. 
From this menu you can take the following actions on a clause or a field:

Navigate to a clause in the template
Mark a clause as smart

You cannot use the Clause Library to insert clauses unless the template you are 
working with has already been checked in at least once. If you are in the process of 
creating a new template, check-in the template and open it again to start using 
Clause Library.



Note

You can configure custom locales in Conga CLM. For more information, 
see Adding Custom Locale topic in Conga CLM Administrator Guide.



You cannot search and insert an alternate clause from the Clause Library.
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Mark a clause as read-only
Make a clause condition-based in the template

To view a clause
Go to Work > Clauses tab.
Click on a clause name in the list. The document scrolls to highlight the selected 
clause in the template.

A newly marked clause is also displayed in the Clauses list.

Making Clauses Smart in a Template
You can make a clause in your template as smart. A standard contracting process begins 
with a generated document and ends with a final agreement. In between the initial 
document and the final signed agreement, the document gets redlined and negotiated. 
Smart clauses help track the differences between different versions of the agreement 
document.

Smart clauses, like smart fields, are parts of a contract that can be reconciled between 
versions of an agreement and noted in the agreement record. This can be used during 
negotiations when clauses are redlined. Clauses that have been changed will be reconciled 
when you choose the reconciliation option at Check-In. Clauses can only be smart in the 
context of a generated contract document.

In the process of negotiations, a contract may get redlined multiple times. During 
these redlines, a user may choose to accept the changes made to the contract. Smart 
Clauses provide visibility into the changes made in the contract document by allowing the 
user to view the changed clauses in at Check-in and when the clause change has been 
checked in, on the Agreement Clauses related list. 

When you use a template that has the smartness attribute enabled for its clauses, the 
generated agreement document will have smart clauses that can be tracked.

A Note on Agreement Documents and Templates

All generated agreement documents (as opposed to imported offline agreements) 
use document templates saved in Conga CLM. These templates contain merge 
fields which, upon generation, pull field values from the agreement to create 
distributable documents.
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To make a clause smart in a template
Open the template in X-Author for Contracts.
Log in to X-Author for Contracts and from the left-hand navigation select Templates.
In the Templates pane, go to Work > Clauses.
The Clauses pane lists all the clauses present in your template. Select a clause from 

the list and click the gear icon next to the clause name .
In the Properties pane, click the toggle for the Smart Clause attribute to enable it 
and click Save.

Your template clause will now have smartness property. To remove the smartness property 
of a clause, you can slide the Smart Clause attribute toggle to off position (greyed out).

Making Clauses Condition-based in a Template
You can use condition-based clauses in your template to make more customized and 
flexible agreement templates. The condition for the condition-based clauses can be simple 
or complex expressions that you can make using the expression builder. The clause 
conditions are evaluated at the time of agreement generation and the clause text is 
included in the generated document only if the associated condition resolves to True.

To add a condition to a clause
Open the template in X-Author for Contracts.
Log in to X-Author for Contracts  and from the left-hand navigation select Templates.
In the Templates pane, go to Work > Clauses.
The Clauses pane lists all the clauses present in your template. Select a clause from 

the list and click the gear icon  next to the clause name.
In the Properties pane, click Add Condition to open the template expression builder.
Create your condition expression on the Condition page. To create a conditional 
expression, enter values for the following fields:

Field - Select the field which you want to set as the criteria for the condition. 
You must select a field name. The fields are listed and grouped according to 
their hierarchy.
Operator - You must select the logical operator from the picklist. This forms the 
relationship between the Field and its Value.
Value - Enter the value of the field name selected in the Field.

When you enable the Read-Only Clause attribute, the value of the Smart 
Clause attribute is disabled. 
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Click Add row to create additional expressions for the same column. You can create 
up to a maximum of 9 filters for a single column.
Enter Custom Logic to add a logical relation between multiple rows. The supported 
filter logic operators are AND and OR. You can use parentheses for setting the 
precedence. For example, if you have five rows you can create a filter logic like, (((1 
AND 3) OR (2 AND 4)) AND 5).  In the absence of custom logic, the default relationship 
between the rows is the boolean operator AND.
Click Test to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Click Save to save the condition. The properties page now shows the condition that 
you created.

Your clause is made conditional and you will see a success message. A lightning icon ( ) is 
displayed next to the particular clause. Click the lightning icon ( ) to view the conditions 
added to the particular Clause.

Marking Clauses in a Template
You can use the mark Clause menu to apply clause boundary and smartness property to a 
block of text. On generating a document, only the clauses marked as smart have the 
clause boundaries.

While constructing a template, you may have a block of text that you may not want in the 
playbook, but in the context of an agreement template (and later a contract), you would 
like to add the smartness property. Using Mark Clauses feature, you can add smartness 
property to an inline text in the agreement template. Any clause formed from the Mark 
Clauses feature will, by default, have Smart Clause property turned on.

While marking a clause, you have to keep in mind the following points:

You are recommended to only mark clauses that are not inserted from the Playbook. 
In other words, you cannot mark a clause as smart inside an existing clause record.
After you mark a block of text as a clause, you cannot mark any other clause within 
the boundary of the marked clause.

To mark a clause in a template
Log in to X-Author for Contracts and select Templates from the left-hand navigation.
Go to Start tab in the Templates pane and search and open a template.
Highlight the content (inline text) of the template that you want to mark as a clause.
After highlighting the content, go to Work Tab> Mark Clauses. If you cannot see the 
Mark Clauses option in the Work tab, click the more option and select Mark Clauses.
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In the Mark Clause form, specify the following details for marking a clause,

Field Description

Clause Name Enter a new name of the clause.

Category Select a category for your clause. The values of the 
categories are defined by your admin and help in 
filtering the clauses.

Subcategory Select a subcategory for your clause. Options in the list 
will change based on the category you selected.

Exception Select a term exception record from the drop-down list 
to associate with your clause.

Risk Rating Select an appropriate risk rating for your clause. Valid 
values are:

Green
Red
Yellow

Materially Significant Select this check box if you want to make your clause 
materially significant.

Click Save.

Your clause is successfully marked and acquires content control border. After marking the 
clause you can go to Work > Clauses, to confirm that the marked clause is recognized in 
the document.

Refreshing Clauses in a Template
Refresh Clauses functionality allows you to keep your agreement template up to date. If 
the agreement template contains clauses, and one clause has been changed but not 
published, this functionality can update the clause in the agreement template in context. 
The clauses having any of the following changes will appear in the Refresh Clauses list:

Change in clause attribute
Addition, deletion, or modification in clause content
Change in the smart, read-only or merge fields
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Prerequisite
Ensure that you have checked in the clause after editing it.

Restrictions
Clauses with repeat tables or repeat sections cannot be refreshed.

To refresh clauses in a template
In the Templates pane, go to Work tab, click the dropdown icon  and select Refresh 
Clauses. 
If the Template contains clauses with no changes, you will see a message stating, No 
clauses are found for refresh. 
If the Template contains clauses with changes, you will receive a message showing 
which clauses need to be refreshed.
Click Refresh to update all of the clauses that are within your main Template. This 
displays the confirmation message.

Behavior and Limitations

When you perform Refresh Clauses the default space inside a clause between two 
lines is removed. If you need additional space between the two lines, it is 
recommended that you manually give space.
When you perform Refresh Clauses, one line of space is added after the clause. 

Making Clauses Read-Only in a Template
You can make clauses in your X-Author templates, read-only. When you enable the read- 
only attribute for a clause in a template, that clause becomes uneditable in the generated 
document. You can mark a clause as read-only to restrict a user from editing the clause 
after a document is generated. You cannot edit or delete a read-only clause in a generated 
document unless you have enabled 'XA_UnlockReadOnlyClause' custom permission in 
Conga CLM. For more information on how to unlock a read-only clause, see Unlocking 
Read-Only Clauses. 

Read-Only clauses have the following characteristics:

Any clause can be made read-only.
A read-only clause cannot be made smart.
A read-only clause can only be defined in a template.
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A read-only clause shows a content control boundary in the generated agreement 
document. 
A read-only clause cannot be deleted in the generated agreement document. 
The value of the read-only clause cannot be edited in the generated agreement 
document.
When you make a clause read-only, the smart fields or read-only fields inside that 
clause lose their smartness or read-only property and become plain-text fields.

To make a clause read-only in a template
Open the template in X-Author for Contracts and log in to X-Author for Contracts.
From Contracts pane, click the left-hand menu icon   and select Templates.
In the Templates pane, go to Work >Clauses.
The Clauses pane lists all the clauses present in your template. Select a clause from 

the list and click the gear icon next to the clause name .
In the Properties pane, click the toggle for Read-Only Clause attribute to enable it 
and click Save.

Your template clause will now have read-only properties. To remove the read-only 
properties of a clause, you can slide the Read-Only Clause attribute toggle to off position 
(greyed out).

Fields
Fields that you insert in your template, or "merge fields" as they are sometimes called, 
represent the contractual terms and metadata from your Agreement record in Conga CLM. 
When you generate a contract document, the values of the fields are retrieved from the 
agreement record and populated in the document. As a template administrator, you are 
responsible for building your template to include fields, as static text, as read-only fields or 
as smart fields that can be changed and reconciled to the Agreement record during the 
negotiation process.

Following sections explain how you can use fields in your agreement template:

Read-only clause characteristics apply to clauses that are marked read-only in a 
template and do not apply to those clauses that are inserted from the Playbook 
after generating the agreement.



When you enable the Smart Clause attribute, the value of Read-Only Clause 
attribute is disabled. 
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Inserting Fields in a Template
Making Fields Read Only in a Template
Making Fields Smart in a Template
Inserting Fields in a Template as a Table
Making Columns and Rows Conditional in a Table
Inserting Fields in a Template as a Section

Inserting Fields in a Template
You can navigate to the Work tab to insert fields in a template.

To insert fields in a template
Open a template in X-Author for Contracts.
Click Fields in the Work tab.
Place the cursor in the section of the template text where you want to insert a field 
and click Insert Field.
On the Insert Field popup, select an Object (i.e., "Agreement") from the left column. 
To search a field related to the selected object in the right column, enter a keyword 

and click the search icon ( ) or press enter. 
Select the required fields and click Insert.

The fields are inserted in the template. The Fields page shows the list of all the fields 
present in your current template. Select a field from the list to highlight it in the template 
document.

Making Fields Read Only in a Template
The Read Only fields are the fields with content control border and their values can be 
updated after document generation only using Update from Conga CLM. These fields are 
different from smart fields and merge fields in that they are not inline like merge fields and 
their values cannot be edited like smart fields.

If you have generated an agreement document using a template containing the read-only 
fields and later want to update the values of the field without generating or regenerating 

•
•

Tip

To select multiple fields,
On Windows, hold Ctrl (keyboard key) and select the fields.
On Mac, hold the command (keyboard key) and select the fields.
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another document, you can click Update from CLM and the values of the read-only fields 
will be updated from the Conga CLM agreement record. This is useful when you need to use 
the same agreement as a baseline document for creating another agreement with the 
same content but for a different agreement record. All the fields which are not marked as 
smart but need to be updated with the values from the new agreement record can be made 
read-only fields.

Read Only fields have the following characteristics:

Any field can be made a read-only field or smart field but not both.
Read-only fields can only be defined in a template.
The value of the read-only fields cannot be edited in the generated agreement 
document and can only be updated.
Read Only fields show a content control boundary in the generated agreement 
documents.
Fields in clauses, repeat table, and repeat section can also be marked as Readonly.

To mark a field read-only
Insert the field into your template by following the steps in Inserting Fields into a 
Template.
From the Templates pane, go to Work tab > Fields. If you cannot see the Fields tab, 
click the dropdown icon ( and select Fields.
The Fields page shows the list of all the fields present in your template. Search for 
and click the field name in the list to highlight it in the document.

Click the Settings icon  adjacent to the field name. It opens the field settings pane 
where you can also find the field type (datatype) of a particular field.
Click the toggle for the Read-Only Field option to enable it.
Click Save.

Your field is marked as read-only.

Making Fields Smart in a Template
Smart fields are specialized fields that can retain the field definition even after the Merge 
Service generates the Agreement document. This feature helps for reconciling the document 
which is explained in detail in the Reconciliation section. Smart fields are intended for parts 
of an agreement that would normally be negotiated. Smart fields are usually represented 
by small chunks of text, such as dates, categories, and numeric values. Smart fields are not 
intended to hold large amounts of text–if necessary, use smart clauses instead.

) 

Smart fields have the following limitations:
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To mark a field as Smart
Insert the field into your template by following the steps in Inserting Fields in a 
Template.
From the Templates pane, go to Work tab > Fields. If you cannot see the Fields tab, 
click more  icon and select Fields.
The Fields page shows the list of all the fields present in your template. Search for 
and click the field name in the list to highlight it in the document.

Click the gear icon  adjacent to the selected field name to open the Properties 
page.
In the attributes list turn on the Smart Field switch and click Save.

Inserting Fields in a Template as a Table
You can insert fields as a table in your template and the inserted table is added as a 
repeat table. When the template with a repeat table is used to generate an agreement, 
the repeat table of a header row with inserted fields and their values in the preceding 
rows. 

Open a template in X-Author for Contracts.
Click Fields in the Work tab.
Place the cursor in the section of the template text, where you want to insert a field 
and click Insert Field. 
This displays the Insert Fields popup.
On the Insert Field popup, select an Object (i.e., "Agreement") from the left column. 
To search a field related to the selected object in the right column, enter a keyword 
and click the search icon  or press enter.
On Mac: hold command and select one or more fields from the list. On Windows: hold 
Ctrl (keyboard key) and select the fields.

•
•
•

Text Area data type fields and formula field for LongDate are not supported.
You cannot mark Lookup fields as smart.
Smart fields cannot be used in the headers or footers of agreement 
documents.

If you want to turn off the smartness property of a field, turn off the Smart Field 
switch, under Properties.
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Select the checkbox Insert as a table.
Click Insert. A Repeat table is inserted into your template with each field displayed 
as a separate column.
To search inserted fields:

The Fields tab displays the Repeat Table (object name) and the fields in the 
repeat table.
Enter the field name in the search field and click the search icon .

To make an inserted field smart field or readonly:

Click the Settings icon  adjacent to the selected field name to open 
the Properties page.
In the attributes list, click the Smart Field or Read-Only Field option based on 
your requirement and click Save. 

To show or hide captions for a generated table:

Click the Settings icon  adjacent to the Repeat Table.
In the Table Attributes section, turn on the Show Caption switch and click Save.

To select table formatting when no data is present:
Under the Table Attributes, click Format. This displays a drop-down menu. 
Select one of the following options based on your requirement.

To show table captions and one empty row, select Show captions and 
one empty row.
To show captions only and no rows, select Show captions only.
To remove the entire table from the generated document, select 
 Remove whole table.

Click Save.
To make columns and rows conditional, see Making Columns and Rows Conditional in 
a Table.

Making Columns and Rows Conditional in a Table
You can mark any or all of the rows and columns in a table as conditional. In practice, 
these conditions operate as filters, allowing rows and columns in the table to be 
conditionally shown (and populated) or hidden. When you are constructing your 
template, you define various condition expressions on rows and columns of a table. These 
conditions are then evaluated at runtime when an agreement document is generated using 
the template.

Fields are inserted as columns in the table based on the order you select. Do 
not move your cursor when the fields are being inserted.
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For example, your table consists of 4 columns: Product, Quantity, List Price, and Net Price. 
You can define a condition to show the Net Price column only when the Account Name is 
ABC Company.

To make columns conditional in a table
In the Templates pane, go to the Work tab, click the more options icon ( ) and select 
Fields. The Fields pane displays the Repeat Table.

Click the Settings icon  next to the Repeat Table name.
In the Repeat Table Settings pane, click Add Condition to open the template 
expression builder. 
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Select a column from the picklist at the top of the expression builder that you want to 
make conditional.
To create a conditional expression, enter values for the following fields:

Field - Select the field that you want to set as the criteria for the condition. You 
can select any field from the object (whose fields are displayed in the table) or 
the parent object (parent of the object whose fields are displayed in the table) 
or lookup objects. For example, if the table displays the fields from Service Plan 
Device object, Field lists all the available fields of Service Plan Device, 
Agreement Service Plan (parent object) and lookup objects for Service Plan 
Device and Agreement Service Plan.
Operator - You must select the logical operator from the picklist. This forms the 
relationship between the Field and its Value.
Value - Enter the value of the field name selected in the Field.

Click Add row to create additional expressions for the same column. You can create 
up to a maximum of 9 filters for a single column.
Enter Custom Logic to add a logical relation between multiple rows. The supported 
filter logic operators are AND and OR. You can use parentheses for setting the 
precedence. For example, if you have five rows you can create a filter logic like, (((1 
AND 3) OR (2 AND 4)) AND 5).  In the absence of custom logic, the default relationship 
between the rows is the boolean operator AND.
Click Test to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Repeat steps 4 - 8 for each column you want to filter.
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Click Next when you are finished to continue to the next screen in the Expression 
Builder to define any conditional rows in your table (see the next section for complete 
instructions).
Click Save to save your table filters and return to your document.

Once the condition is successfully saved, a lightning icon ( ) is displayed next to the 
particular repeat table. Click the lightning icon ( ) to expand and view the conditions 
added to the particular repeat table. Click the lightning icon ( ) again to collapse.

The column condition is created for the table. You can modify or delete the condition. 

To make rows conditional in a table
In the Templates pane, go to the Work tab, click the more options icon ( ) and select 
Fields. The Fields pane displays the Repeat Table and the fields.

Click the Settings icon  next to the Repeat Table name.
In the Repeat Table Settings pane, click Add Condition to open the template 
expression builder.
Follow instructions from the previous section to create conditional columns in the 
table.
Click Next.
To create a conditional expression, enter values for the following fields:

Field - Select the field that you want to set as the criteria for the condition. You 
can select any field from the parent object (parent of the object whose fields 
are displayed in the table), grandparent object (parent’s parent), or lookup 
objects. For example, if the table displays the fields from Service Plan Device 
object, Field lists all the available fields of Agreement Service Plan (parent 
object), Agreement (grandparent object) and lookup objects for Agreement and 
Agreement Service Plan.
Operator - You must select the logical operator from the picklist. This forms the 
relationship between the Field and its Value.
Value - Enter the value of the field name selected in the Field.

Click Add row to create more conditional expressions. You can create up to a 
maximum of 9 rows of expression conditions to be used in a single expression.
Enter Custom Logic to add a logical relation between multiple rows. The supported 
filter logic operators are AND and OR. You can use parentheses for setting the 
precedence. For example, if you have five rows you can create a filter logic like, (((1 

If you are defining column filters for a table inside a section that contains third- 
level fields, you cannot apply column filters on objects that are not included in the 
table. 
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AND 3) OR (2 AND 4)) AND 5).  In the absence of a filter logic, the default relationship 
between the rows is the boolean operator AND.
Click Test to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Click Save to save your table filters and return to your document.

Once the condition is successfully saved, a lightning icon ( ) is displayed next to the 
particular repeat table. Click the lightning icon ( ) to view the conditions added to the 
particular repeat table. Click the lightning icon ( ) again to collapse.

The row condition is created for the table. You can modify or delete the condition. 

To remove column and row conditions
In the Templates pane, go to Work tab, click the more options icon ( ) and select 
Fields. The Fields pane displays the Repeat Table and the fields.

Click the Settings icon  next to the Repeat Table name.
In the Repeat Table Settings pane, click the delete icon  .
Click Remove.

The column and row conditions are deleted for the table. 

To edit column and row conditions
In the Templates pane, go to Work tab, click the more options icon ( ) and select 
Fields. The Fields pane displays the Repeat Table and the fields.

Click the Settings icon  next to the Repeat Table name.
In the Repeat Table Settings pane, click edit icon  .
Update conditions and click Save.

Inserting Fields in a Template as a Section
You can insert fields as a section in your template and the inserted section will be added as 
a repeat section. This inserts each specified field on a new line when you select multiple 
fields (in the selected order). There is not a content-control boundary around a repeat 
section in the agreement document.

To insert fields in a template as a section
Open a template in X-Author for Contracts.
Click Fields in the Work tab.
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Place the cursor in the section of the template text, where you want to insert a field 
and click Insert Field. 
This displays the Insert Fields popup.
On the Insert Field popup, select an Object (i.e., "Agreement") from the left column. 
To search a field related to the selected object in the right column, enter a keyword 
and click the search icon  or press enter.
On Mac: in the window to the right, hold command and select one or more fields from 
the list. On Windows: hold Ctrl (keyboard key) and select the fields.

Select the radio button Insert as a Section.
Click Insert. A repeat section is inserted into your template with each field displayed 
one below the other.
To search inserted fields:

Navigate to the Fields tab. This displays the Repeat Section (object name) and 
the fields in the repeat section.
Enter the field name in the search field and click the search icon .

To make an inserted field smart field or readonly:

Click the Settings icon  adjacent to the selected field name to open the 
Settings page.
Turn on the Smart Field or Read-Only Field switch based on your requirement 
and click Save.

To make a repeat section conditional in a template
The Fields tab displays the Repeat Section (object name) and the fields in the repeat 
section.

Click the Settings icon  next to the selected repeat section to open the Repeat 
Section Settings page.
Click Add Condition. This opens the Make Conditional popup which has the 
expression builder.
In the Make Conditional popup, you can create a conditional expression and also 
create a complex expression using logical operators between multiple rows of 
conditions. To create an expression you must enter values for the following three 
fields: 

Fields are inserted one below the other based on the order you select. Do not 
move your cursor when the fields are being inserted.
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Field Description

Field Select the field which you want to set as the criteria for the 
condition. You must select a field name. The fields are listed and 
grouped according to their hierarchy.

Operator Select the logical operator from the drop-down. This forms the 
relationship between the Field and its Value.

Value Enter the value of the field name selected in the Field.

Click Add row to create more conditions. You can add up to 9 rows of condition 
expressions.
Enter Custom Logic to add a logical relation between multiple rows of condition 
expressions. The supported filter logic operators are AND and OR. You can use 
parentheses for setting the precedence. For example, if you have 5 rows you can 
create a filter logic like, (((1 AND 3) OR (2 AND 4)) AND 5).  In the absence of a filter 
logic, the default relationship between the rows is the boolean operator AND.
Click Test to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Click Save to save your table filters and return to your document. Once the condition 
is successfully saved, a lightning icon ( ) is displayed next to the particular repeat 
section. Click the lightning icon ( ) to expand and view the conditions added to the 
particular repeat section. Click the lightning icon ( ) again to collapse.

Setting Segments in Templates
Set Segment feature allows you to set conditions and style for the highlighted text in your 
agreement template. The condition for the segment's visibility can be set from the 
expression builder. The segment can consist of the highlighted text, a clause, a group of text 
across clauses, or text with fields. You can leverage this feature to create a template that 
can show or hide different segments of text in the generated agreement based on the 
conditions set by you. The expression builder is fully integrated with the objects and fields in 
your Salesforce Org.

To make a Segment Conditional in a template
In the Templates pane, go to Work tab, click the more options icon and select 
Segments.
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Highlight a block of text in your template and click New Segment. This opens the 
Segment Condition window which has the expression builder.
In the Segment Condition window, you can create a conditional expression and also 
create a complex expression using logical operators between multiple rows of 
conditions. To create an expression you must enter the values of the following three 
fields:

Field 
Nam 
e

Description

Field Select the field which you want to set as the criteria for the condition. The Field 
drop-down shows the Agreement object and its fields from your Salesforce org. You 
must select a field name. The fields are listed and grouped according to their 
hierarchy.

Oper 
ator

You must select the logical operator from the drop-down. This forms the 
relationship between the Field and its Value.

Value Enter the value of the field name selected in the Field.

Click Add row to create additional expressions for the same column. You can create 
up to a maximum of 9 filters for a single column.
Enter Custom Logic to add a logical relation between multiple rows. The supported 
filter logic operators are AND and OR. You can use parentheses for setting the 
precedence. For example, if you have five rows you can create a filter logic like, (((1 
AND 3) OR (2 AND 4)) AND 5).  In the absence of custom logic, the default relationship 
between the rows is the boolean operator AND.
Click Test to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Click Save to save your table filters and return to your document.

You see a success message and your segments are added as Segment Conditional to the 
segments list in the Segment pane. A lighting icon ( ) is displayed next to the newly 
added segment. Click the lighting icon ( ) to view the conditions added to the particular 
segment.

Selecting the segment name from the list highlights that segment in the template 
document. 
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To view or edit a segment condition
select the Segment Conditional from the segments list in the Segments pane and click 

the Settings icon  next to the segment name. This opens the Segment Settings 
page. where the Segment Type is set to Conditional for that segment. To edit the 
conditional, click the pencil icon  next to Condition. 
At the time of agreement generation, if your conditional's value evaluates to true, the 
associated segment is shown in the agreement document.

To delete a conditional segment in a template
Go to the Work tab > Segment in Templates.
Select the segment from the segment list. The selected segment is highlighted in the 
template.

Click the Settings icon    next to the segment name to open the Segment Settings 
page.
Click Delete Segment. You will see a confirmation message. Click Delete again.

Your segment is successfully deleted and the content control boundary of your segment is 
removed.

To set a style for a segment in a template
In the Templates pane, go to the Work tab, click the more options icon 
 and select Segment.
Highlight a block of text in your template and click Set Style. This opens the Select 
Styles window that lists custom styles.
Select a custom style or select the Show template styles checkbox and select a style.
Click Save.  
The segment is added as Segment Regular to the segments list in the 
Segment pane. Selecting the segment name from the list highlights that segment in 
the template document. 

To view or edit a segment style
Select Segment Regular from the segments list in the Segments pane and click the 

Settings icon  next to the segment name. 
 

This opens the Segment Settings page where the Segment Type is set to Regular for 
that segment. 
To edit the style, click the pencil icon  next to Style. 



X-Author for Contracts

96 Copyright ©2022 Apttus Corporation. All rights reserved.
 

3.

1.
2.

3.

4.

•
•

•
•

•

•

To add a segment condition, click Add Condition. This opens the Segment 
Condition window which has the expression builder. For more information, see To 
make a Segment Conditional in a template. After adding a condition to the segment, 
a lighting icon ( ) is added.  
Segment Regular style segment changes to Segment Conditional after you add a 
condition.  
When you generate a document using a template with style segments, you can view 
different styles applied in the generated document.

To delete a style for a segment in a template
Go to the Work > Segment tab in Templates.
Select the segment from the segment list. The selected segment is highlighted in the 
template.

Click the Settings icon  next to Segment Regular to open the Segment Settings 
page.
Click Delete Segment. You will see a confirmation message. Click Delete again.

Your segment is successfully deleted and the content control boundary of your segment is 
removed.

Defining Template Locale
You can define locale settings at the agreement template or clause level and field level. 

At the template or clause level:
You can specify the Locale and choose the Currency Format, Date Format, and 
configure Number and Currency Precision for the whole template when you 
create or clone a template or clause. 

You can also change the locale of a template or clause at check-in. 
At the template or clause field level:

You can use the Template Fields tab to define locale for 
 Number, Currency, Date, and Precision fields. 
You can also use the Template Fields tab to define Currency Format, Date 
Format, Currency Precision, and Number Precision for fields.

Note

For date fields, the date formats are displayed based on the selected 
Locale.
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The template or clause field level locale settings take precedence over template or 
clause level locale settings in the generated document.

To learn how to change field format by locale, refer to Changing Field Format by Locale.

Prerequisites
Enable Formatting must be checked when creating, checking in or cloning a template 
to enable field-level locale configuration.

Supported Locale
English (US), English (UK), English (Canada), English (Ireland), Italian, German, Chinese, 
Japanese, Korean, Thai, Norwegian, Swedish, Russian, Portuguese, Polish, Greek (Greece), 
and Spanish are the standard locales that are available in Conga CLM. You can configure 
custom locales in Conga CLM. For more information, see Adding Custom Locale 
topic in Conga CLMon Salesforce Administrator Guide.

Unsupported Locale
Alsatian (Switzerland), Romansh (Switzerland), French (Switzerland), Walser (Switzerland), 
English (Republic of the Philippines), Filipino (Philippines) locales are not supported. German 
Mark and Swiss Franc currencies are not supported.

Locale Settings for Templates
You can define locale settings while:

Creating a new template
Checking in a template
Cloning a template

Note

If a locale is deleted in Conga CLM that is being used in a template at the template 
level and you check out and check in the template, the deleted locale is replaced 
with the first value of the Locale dropdown. If a locale is deleted in Conga CLM that 
is being used in a template at the field level and you navigate to the Template 
Fields and view the field details, the Locale field is set to blank. If all the locales are 
deleted in Conga CLM, the Locale field is set to English (US). 
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Changing Field Format by Locale
When you create a new template or clone an existing one, you are required to specify 
a Locale for your template. 

Because there may be some cases that require you to override formats at the field level, X- 
Author Templates provides template administrators with the ability to define Number and 
Currency Precision, Currency Format, and Date Format. This allows you to preserve locale 
for fields in inserted clauses at the template level while making specific changes to other 
field formats as needed. Generated documents conform to template locale except when 
specified at the field level.

Prerequisite
Enable Formatting must be selected when the template is created, cloned or checked in.

To change the field-level locale, precision, and format for date and 
currency fields

From the left navigation panel, select Templates.
In the X-Author Templates pane, go to the Work tab > Fields.

Click the Settings icon  beside the field name.
In the Field Settings page, based on the template field selected, you can view and 
change the following field properties: 

For date fields, you can change Locale and Date Format from their respective 
dropdown. 
The Date Formats displayed are based on the Locale selected. 
For the currency fields, you can change the Currency Format, Currency Precision, 
and Locale from their respective dropdown. 
Based on the locale selected, the default currency precision value provided 
in Conga CLM is displayed. You can change the Currency Precision value as per 
your requirement.
For the number fields, you can change the Locale and Number Precision from 
their respective dropdown. 
Based on the locale selected, the default number precision value provided 
in Conga CLM is displayed. You can change the Number Precision value as per 
your requirement.

Click Save.
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Template Versioning
Template Versioning provides a solution framework of document versioning at the template 
level to track template versions against generated documents. Your organization's policies, 
requirements, legal and business practices may change over time, requiring templates to 
be updated. Rather than manually keeping track of template iterations, you can use 
template versioning to track and manage every version of your template throughout its 
lifecycle. Template versioning maintains those different versions as the template changes, 
giving template admins the ability to activate specific template versions based on their 
needs and to observe how the template looked at every stage in the authoring process. 
Template versioning applies to all types of templates in your library.

To summarize, template versioning allows template admins to:

Survey older contracts by viewing their associate template version to understand 
what was in the template at generation.
Revert to previous template versions.
Clone template versions to begin a new template lifecycle.
Understand the growth and evolution of a given template.

The following sections in this guide provide step-by-step instructions for managing 
templates in X-Author for Contracts for orgs with Template Versioning enabled:

Creating New Template Versions
Opening Template Versions
Locking and Unlocking Templates
Checking In Template Versions
Cloning Template Versions

The behavior for versioned templates is different where described. All other X-Author for 
Contracts functionality remains unchanged. 

To use Template Versioning it must be enabled for your org. For more information, see 
Configuring Template Versioning topic in the Conga CLM on Salesforce Administrator 
Guide.

How Template Versioning Works
Each agreement or clause template in your org (with or without template versioning 
enabled) always consists of one template and multiple child references to clauses and 
sections contained in that template. For every instance of that template, there is always 
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only one template that can be considered active (the version selected by the user to 
generate the contract or the version of the clause inserted into an agreement template).

More specifically, whenever a new template is created by any means, one instance of the 
template is created, stored in the Template object in Salesforce, and any clauses in the 
template are stored in the Template Clause Reference. The Template object has a master- 
detail relationship with the child object, as shown in the following figure.

Template Versioning preserves the same template, called the Header Template, which has 
a one-to-one relationship with the active version of the template and its child objects, and 
a one-to-many relationship with other versions of the template, which also have versioned 
clause and section references, but are considered inactive.
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Template Versioning introduces two new objects:

Template Version – a detail object of the master Template object
Template Clause Reference Version – a child object of Template Version that stores 
nested clause references

When a user creates a new version of a template, the version information is incremented 
(e.g. from "1.00" to 2.00") and stored in the Template Version object and its child object. 
When a template version becomes the active version, data from the Template 
Version object is copied to the Header Template object and that template version becomes 
the newly active version of the Header Template.

Creating New Template Versions
The process for creating a template is the same regardless of whether template versioning 
is enabled or disabled. For instructions on creating templates, see Creating New Templates 
in this guide. 

Opening Template Versions

Using X-Author Templates, you can open any template version from the repository and 
make changes to static text and other content in the document. When the document is 
finalized, you can check in the template and modify properties as needed (for example, you 
can change which agreement types it is associated with). As with contracts, when you 
check out a template a lock is put on the document, preventing other users from editing it 
while you are working on it. After you release the lock or check in the template, the lock is 
released. Note that the lock only prevents other users from checking out the version you are 
working on, not every version of the template. For more information about locking and 
unlocking templates, see Locking and Unlocking Templates. 

To open a template version
Open Microsoft Word and launch the X-Author for Contracts add-in.
Log in to X-Author for Contracts.
From the Contracts pane, click the left-hand menu icon   and select Templates.
In the Templates pane, go to Start tab > Search > Search Templates.

This page contains instructions for opening templates when Template Versioning is 
enabled. For instructions on opening templates without versioning, see Opening 
Templates in this guide.
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Use the Search box to search for a template by keyword. Click the filter icon   to 
expose drop-down menus that can help you to refine your search according to 
Template Type, Category, Subcategory, Locale, and Language.

Click the Search icon   to display a list of templates that match your criteria. 
From the list of templates, click the down arrow   for a template to expand and 
view Type, Business Object, Is Active flag, and Active Version of the template. Active 
Version is not displayed if the template is not active.
In the expanded description, click Versions to view a list of all versions of the 
template.
Select a template version to view the comments saved for that template version. 

To open a template version, click the icon  and click Open. Your document is 
downloaded. 
Check your Downloads folder for the file and open it in Microsoft Word.

Your template is opened. You can modify the template as per your requirement and check 
in your template.

Opening Templates with No Versions
You will likely have many templates in your org that were created before enabling 
Template Versioning. In this case, these templates will not have a template version. After 
Template Versioning is enabled, the first time you expand or select a non-versioned existing 
template, the system automatically creates an initial template version (1.00). You can open 
the newly created template version. 

Locking and Unlocking Templates
When you open a template in X-Author Templates, the template is locked to prevent others 
from editing the document and checking in a new version while you are working on it. When 
you open a template it is automatically locked, which is indicated by the lock icon being 

closed  . You can always check the lock status of a template by clicking the Lock Status  
icon. This opens the Lock Status page with the following information:

Template Name 
Template Version
Template locked by
Locked Date
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To release a template lock

From the Templates pane, click the Lock Status  icon.
Click Release Lock. 

After you release the lock, the icon changes to open  . The template page refreshes and 
shows the Start tab of X-Author Templates. You cannot access the Work and Finish tabs of 
X-Author Templates after releasing the lock. When you click the Lock Status icon, 
the Acquire Lock button replaces the Release Lock button on the Lock Status page. 

Checking In Template Versions

After you create a new template or make changes to an existing template, you can check 
in the template to update its contents in Salesforce and create a new version. 

To check in a template version
In the Templates pane, click the Finish tab.
Under Check-In, the following fields are displayed:  

Field Name Description

Name Enter a new name for the template.

Current Version It indicates the version you are currently working on. The current 
version is not displayed if the template is being checked in for 
the first time.

Type It shows the type of template.

Business Object It shows the business object of the template.

If you released a template lock by mistake and want to continue working with the 
template, go to the Lock Status page and click Acquire Lock.



This page contains instructions for checking in templates when Template Versioning 
is enabled. For instructions on checking in templates without versioning, see 
Checking In Templates in this guide. 
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Field Name Description

Agreement Types From the picklist, you can select multiple agreement types to 
associate with your template. The value of Agreement Types 
decides which templates are available at the time of 
agreement generation. If your template's agreement type 
matches with the agreement type of your agreement record, 
you will see that template in the list of available templates at 
the time of document generation.

Category Choose the category from the picklist. Template categories are 
defined in Conga CLMby the administrator.

Subcategory A dependent field that is populated based on the value chosen 
for Category. Subcategory values are defined in Conga CLM by 
the administrator.

Language  Select the default template language from the picklist.

Locale Select the locale from the picklist. You can configure custom 
locales in Conga CLM. For more information, see Adding 
Custom Locale topic in Conga CLM Administrator Guide.

Enable Formatting Check this box to enable locale formatting at the template 
and field level for this template. This allows you to define 
locale settings for Currency, Number, and Date formats. 
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Field Name Description

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale 
formatting.

Field Description

Date Format Select an option from the picklist to choose the default 
format for all date fields in the template.

Currency Format Select an option from the picklist to choose the format 
for all currency fields in the template. Choose "None" to 
only display currency field values in generated 
documents.

If "Currency Symbol" is selected, currency fields will 
be generated with no space between the symbol and 
field value. If "ISO" is selected, currency fields will be 
generated with a space between the ISO code and the 
field value.

Number Precision Select a number from 0-9 to define the precision for 
Number/Percent field values in the template (e.g., "2" if 
the Number/Percent field should display two digits 
following the decimal point.)

Currency Precision Select a number from 0-9 to define the precision for 
currency field values in the template (e.g., "2" if the 
currency field should display two digits following the 
decimal point.)

Keywords Enter comma-separated keywords to associate with the 
template. Keywords make it easier to search the templates.

Next Revision Date Select the date for the next revision of the template.

Description Enter the description for the template. Maximum of 255 
characters (an error will be thrown if this limit is exceeded).

Guidance Enter guidance to help users determine the purpose of the 
template.
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Field Name Description

Comments Enter comments that apply to this version of the template.

Update Current Version Check this box to update the current version you have checked 
out. This template will replace the current version and will not 
create a new version of the template. Update Current Version 
will not be displayed if the template is being checked in for the 
first time.

Active Check this box to activate the new version of this template 
when check-in is completed. If disabled, the new version will still 
be checked in but the currently active version will remain the 
same. You must activate a template version to use it for 
generating an agreement document.

Click Check In.

A message is displayed that your template is checked in and the template is downloaded. 
You can open the template and continue working on the template. 

The template version is checked in and the version number is incremented by 1 (unless 
Update Current Version is checked). For example, if you have checked out Template v2.00, 
when you check in the new version, it will be checked in as Template v3.00. Template 
version information is updated in Salesforce. When a template is checked-in for the first 
time, the version number is v1.00.

Cloning Template Versions

You can clone a template when the need arises to have a template with similar language 
or elements. When you clone a template version, a new template record is created as 
version 1.00. 

To clone a template version
Open Microsoft Word and launch the X-Author for Contracts add-in.
Open the template version you want to clone.

This page contains instructions for cloning templates when Template Versioning is 
enabled. For instructions on cloning templates without versioning, see Cloning a 
Template in this guide. 
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In the Templates pane, go to the Work tab. Click the more options   icon and select 
Clone. 
In the Clone Template page, change the name of the cloned template, to suit your 
requirements. By default, the cloned template name has 'Copy' added to the end of 
the original template name. For example, if you're cloning a template named Clause 
Agreement Template then the default name for the cloned template will be Clause 
Agreement Template Copy.  
You have the option to change settings of your template when you clone it. You can 
specify the following fields: 

Field Name Description

Name Enter the name of the template.

Current Version It indicates which version of the template you are cloning. 

Type It shows the type of template.

Business Object It shows the business object of the template.

Agreement Types From the picklist, you can select multiple agreement types to 
associate with your template. The value of Agreement Types 
decides which templates are available at the time of 
agreement generation. If your template's agreement type 
matches with the agreement type of your agreement record, 
you will see that template in the list of available templates at 
the time of document generation.

Category Select a category from the picklist. Template categories are 
defined in Conga CLM by the administrator.

Subcategory A dependent field that is populated based on the value chosen 
for Category. Subcategory values are defined in Conga CLM by 
the administrator.

Language  Select the default template language from the picklist.

Locale Select the locale from the picklist. You can configure custom 
locales in Conga CLM. For more information, see Adding 
Custom Locale topic in Conga CLM Administrator Guide.
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Field Name Description

Enable Formatting Check this box to enable locale formatting at the template 
and field level for this template. This allows you to define 
locale settings for Currency, Number, and Date formats. 

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale 
formatting.

Field Description

Date Format Select an option from the picklist to choose the default 
format for all date fields in the template.

Currency Format Select an option from the picklist to choose the format 
for all currency fields in the template. Choose "None" to 
only display currency field values in generated 
documents.

If "Currency Symbol" is selected, currency fields will 
be generated with no space between the symbol and 
field value. If "ISO" is selected, currency fields will be 
generated with a space between the ISO code and the 
field value.

Number Precision Select a number from 0-9 to define the precision for 
Number/Percent field values in the template (e.g., "2" if 
the Number/Percent field should display two digits 
following the decimal point.)

Currency Precision Select a number from 0-9 to define the precision for 
currency field values in the template (e.g., "2" if the 
currency field should display two digits following the 
decimal point.)

Keywords Enter comma-separated keywords to associate with the 
template. Keywords make it easier to search the templates.

Next Revision Date Select the date for the next revision of the template.
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Field Name Description

Description Enter the description for the template. Maximum of 255 
characters (an error will be thrown if this limit is exceeded).

Guidance Enter guidance to help users determine the purpose of the 
template.

Comments Enter comments that apply to this version of the template.

Active Check this box to activate the template. You must activate a 
template to use it for generating an agreement document. 

Click Save. 

After the cloning is successful, a copy of the template with the new name and header 
information is created as a new template record. The template version information is saved 
to the record as version 1.00.

Contracts
After you have checked out your document, you are ready to begin the negotiation and 
redlining process. 

The following sections describe the features you can use in X-Author for Contracts when 
working with contract or agreement documents.

Opening an Agreement Document
Using Playbook
Doc Clauses
Doc Fields
Highlighting Smart and Read-Only Fields
Checking in an Agreement Document
Updating Fields from Conga CLM
Opening Agreements in Conga CLM
Creating Offline Agreements
Importing Offline Agreements
Extracting Agreement Data Using Intelligent Discovery
Tracking Clauses in your Agreement Document
Localization
Restricting Agreement Document Check-In and Check Out
Working with Files
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Promoting Clauses to Playbook
Comparing and Merging Agreement Documents
Sending an Agreement Document for Parallel Review
Tracking Document Review Status
Deleting Smart Elements Using Delete or Backspace Key
Updating Multiple Smart Fields in a Document

Opening an Agreement Document
To work with any version of an agreement document associated with an agreement record 
in Conga CLM, you must open it directly in X-Author for Contracts. There are three common 
ways for you to open a document, depending on how you are accessing the document itself. 
You can open your DOC or DOCX agreement document using one of the following methods:

Search and open the document in X-Author for Contracts
Download the document from Conga CLM and open it using X-Author for Contracts.

After opening a document, only one user can work on the document at a time.

To open or open and update an agreement document 
In the Contracts pane, go to Start tab > Search > Search Agreements. It displays all 
the agreement ordered by modified date. 

If you are using X-Author for Contracts on MacBook Air, you might see an error 
message related to “Add-in memory usage” when you work with a document of size 
2 MB or more. This is due to a limitation of Microsoft Word. You can continue working 
after closing this warning message. However, to avoid high memory usage related 
issues, you are recommended to close any unused applications on your system while 
working with X-Author for Contracts.



If you have already downloaded the document from another location, open 
the document in Word. The document is automatically locked by you (You'll 
see a message saying 'Document is locked by you'). If the document is already 
opened by another user, you will not be able to work with it until it is checked 
in.  
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Enter the agreement name or number as the search keyword and click the Search icon 
( ).
From the search results, click the Expand icon ( ) of the agreement you want to 
download. In the expanded description, click Documents. This opens the Agreement 
Details page that lists all the versions of the document.  

To open an agreement document version, click the more icon ( ) next to the version 
and click Open. Your document is downloaded. 
Open the downloaded document in Microsoft Word. The document is automatically 
opened and locked by you (You'll see a message saying 'Document is locked by you'). 
This means that your agreement is opened.

To open and update an agreement document version, click more icon ( ) next to the 
version and click Open And Update. The selected document is downloaded. 
Open the downloaded document. You'll get a message saying 'Document is locked by 
you' and the X-Author Contracts pane directly opens the Update from CLM page. This 
page lists all Smart and ReadOnly fields with current values in Conga CLM. For more 
information, see Updating Fields from Conga CLM.

Behavior and Limitations

When you insert Microsoft Word's 3D shapes into your agreement document, the 
agreement document cannot be opened in X-Author for Contracts.
When you download and open an agreement document from Conga CLM and convert 
it to X-Author for Contracts compatible, the converted document name and the 
original document name are not identical. 
When you create an agreement template in X-Author for Contracts 1.0 that includes 
date fields, generate an agreement document using that template and open the 
document in X-Author for Contracts, you will see a warning message. Click Ok to 
continue. The date picker is not available for date fields in the agreement document. 
However, you can edit date fields and the property of date fields is also retained. 

 

Locking and Unlocking Documents
When you open a document in X-Author Contracts, the document is locked for editing and 
cannot be checked out by anyone else. Anyone with proper permissions for the document's 
agreement record can still view and/or download the document, but they cannot make 

Maximum of 50 agreements are displayed in one instance in the Contracts 
pane. When you search agreements using filters, 20 agreements are displayed 
in one instance based on the search results and if you scroll further, 20 more 
agreements are displayed. 
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edits and check the document back in while you have it locked (the Work and Finish tabs 

are disabled). You can always check the lock status of a document by clicking the   Lock 
Status button. This opens the Lock Status page with the following information:

Agreement Name: Shows the name of the agreement.
Document protection mode: Shows the protection level of the agreement document. 
The values could be Full Access, Insert Comment and Track Changes Only, Track 
Changes Only, Fill in form fields only and Read Only. 
Document locked by: Shows the name of the user who has locked the document. If the 
document is locked by another user, this field will show the name of the user who has 
locked the document. 
Locked date: Shows the date and time of locking. 
Release Lock or Acquire Lock: This is a  toggle button. If a document is already locked 
you can unlock it using the Release Lock. If you have accidentally unlocked a 
document, you can lock it again by clicking Acquire Lock.
Refresh Lock: This button checks the current lock status of your document.  
Cancel: Takes you back to the previous screen that you were working on.

To release a document lock
Before you can release a lock on a document, it must be opened in X-Author for Contracts.

From the Contracts pane, click the Lock Status button. The Lock Status page shows 
agreement details and information on the current document lock.
Click Release Lock on the Lock Status page.

The document page refreshes and shows the Start tab of X-Author Contracts. You cannot 
access the Work and Finish tabs of X-Author Contracts after releasing the lock. When you 
click the Lock Status icon, the Acquire Lock button replaces the Release Lock button in the 
Lock Status page.

Using Playbook
The Playbook allows you to access a library of previously defined clause templates 
in Conga CLM for use with your document agreement type during negotiations. Instead of 
editing clauses already in the document or inserting static text, you can insert clauses from 

If you released a document lock by mistake and want to continue working with the 
document, go to the Lock Status page and click Acquire Lock.
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Playbook directly into the agreement document and track and manage changes to clause 
content as negotiations proceed. 

To use Playbook, go to Work tab in X-Author Contracts pane and select Playbook tab. You 
can use the Playbook in the agreement document to:

Mark New Clause
Mark
Insert
Insert Smart

To search clauses in the Playbook
In the Contracts pane, go to Work > Playbook. 
Enter a search term in the Search Clauses text box and click the search icon to list all 
the available clauses.
If you need to add filter criteria for the clauses, in Search Clauses, click the clause 
filter icon (  to get filtering options. You can filter your clause search based on 
clause Category, Subcategory, Locale, Language, and Type.

To use non-versioned clause templates
You will likely have many clause templates in your org that were created before enabling 
Template Versioning. In this case, these clause templates will not have a template version. 
You can access the non-versioned clause templates from Playbook after Template 
Versioning is enabled. The system assigns the existing non-versioned clause templates 
automatically as version 1.00 when you perform the following actions:

Select the clause template
Mark
Insert
Insert Smart

The version number is added to the Template record as Template Version. You can see the 
active version along with the text and guidance when selecting the clause. You can insert 
an active version of a clause from Playbook into the agreement document. 

Unless explicitly stated, any mention in this guide of fields or clauses should be 
considered a reference to smart fields and clauses.



)

For more information about Template Versioning, see Template Versioning topic.
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Marking Clauses
During the process of negotiation, you may find a section of text that you would like to 
mark as smart. Mark document content as a clause when:

You are with a third party offline agreement created or imported into the agreement 
record that contains language which should be tagged as clauses.
An external party adds language to the agreement document that constitutes a 
clause.

To mark a clause
In the Contracts pane, go to Work > Playbook.
Highlight the content of the contract to be marked as a clause.
Search the clause you want to add or select the clause from the available clauses 
list and click the more icon   next to the clause name.
Click Mark. 
By marking the text as a clause in your agreement document, the text adopts the 
properties of the marked clause. You can even choose to replace text in the 
agreement with text from a pre-existing clause in your Playbook. When the 
agreement document is checked in and reconciled to the agreement record, 
information on marked clauses is added to the Agreement Clauses related list.

To mark a new clause
In the Contracts pane, go to Work > Playbook.
Highlight the content of the contract to be marked as a clause and click Mark New 
Clause in the Playbook tab.
In the Mark Clause form, specify the following fields for marking the clause. The 
clause will be automatically marked as a 1-off instance of the clause for this 
agreement.

Field Description

Clause Name Enter a new name for the clause.

Clauses can only be smart in the context of single generated or offline agreement 
document. You cannot select more than 32000 characters for marking a clause.
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Field Description

Action By default, Inserted is chosen and is Read-Only.

Category Select a category for your clause.

Sub Category Select a subcategory for your clause. Options in the list will change 
based on the category you selected.

Exception Select a term exception record from the drop-down list to associate 
with your clause.

Risk Rating Select an appropriate risk rating for your clause. Valid values are:

Green
Red
Yellow

Materially 
Significant

Select this check box if you want to make your clause materially 
significant.

Clause Text 
(Selected)

This text area shows the selected text which you want to mark as a 
clause.

Click Save to apply clause properties to the highlighted content and mark the 
content as a smart clause. When you check in and reconcile your agreement 
document, the clause will be displayed as inserted in the Agreement Clauses related 
list and is listed in the Document panel under Clauses.

Your clause is successfully marked and acquires content control border like the other smart 
clauses.

After inserting the clause, you can go to Work tab > Doc Clauses to confirm that the clause 
is now recognized in the document. When you check in the document, any smart clauses can 
be reconciled to the agreement and information of the inserted clause is added to the 
Agreement Clause related list on the agreement record.

Scroll past the Clause Text to view additional fields and buttons required to 
mark the clause.



If you decide you want to unmark a clause during the same session in which you 
marked it, you must use the Doc Clauses tab to remove clause properties.
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Behavior and Recommendations

If you mark a table as a clause by selecting the table only, you will see an error message. 
You are recommended to select some space before and after the table.

Inserting Clauses
Clause content typically includes text, smart fields, read-only fields, merge fields, MS-Word 
tables, and style segments. You can insert a clause from the Playbook into a document in 
two different ways, as described below.

Inserting Clauses as Text: There is not a content-control boundary around a clause 
that is inserted as text from Playbook. The clause contains static text and the 
content of the clause cannot be edited in an agreement document. Moreover, when 
you insert a clause as a text it is not recorded in the Doc Clauses list and the clause 
reconciliation page. If you insert a clause as text and that contains smart fields, the 
values in the smart fields are converted to plain text and do not have a content- 
control border.
Inserting Clauses as Smart: A smart clause is a clause with a content-control border. 
A smart clause contains text that can be edited in an agreement document. When 
you insert a clause as smart, you can see it in the clause list of the Doc Clauses tab 
of Contracts. Additionally, when you make changes to the content of a smart clause, 
those changes are tracked through redlines and you can see the changes recorded on 
the clause reconciliation page.

To view the content of a clause listed in the Playbook panel, click the Clause Name. A 
section displays the text of the clause, active version (If versioning is enabled in your 
Salesforce org), and guidance below the clause list. Click the clause text to scroll.

To insert a clause
In the Contracts pane, go to Work > Playbook > Search Clauses.
In Search Clauses, click the search icon to list all the available clauses or enter a 
search string to search a specific clause. You can also click the clause filter icon 
to get filtering options. You can also filter your clause search based on clause 
Category, Subcategory, Locale, Language, and Type.
In the agreement document, place your cursor at the point of insertion.

When you insert an agreement clause into a document, it is only valid for that 
specific agreement document.
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Select the clause from the Playbook pane, click more icon  next to the clause name 
and click Insert to insert the clause as a text (or non-smart clause) in your document. 
OR 
Select the clause from the Playbook pane, click the more icon  next to the clause 
name and click Insert Smart to insert the clause as a smart clause in your document.

You get a success message and if you have selected Insert Smart, the inserted clause is 
marked as a smart clause (shown with a grey border). The text of the inserted clause 
appears redlined in the agreement document if the agreement's protection level is set to 
Insert Comments and Track Changes.

If you have inserted the clause as smart, you can go to Work tab > Doc Clauses to confirm 
that the clause is now recognized in the document. When you check in the document, any 
smart clauses can be reconciled to the agreement and information of the inserted clause is 
added to the Agreement Clause related list on the agreement record.

If you insert a clause as text and check in with any save option, you can view the clause 
entry in the Conga CLM Agreement Clause related list with action as InsertedAsText.

If you insert a clause as text inside a smart clause and check in with any save option, you 
can view the clause entry in the Conga CLM Agreement Clause related list with action as 
Modified.

To learn how the Agreement Clause related list is populated with each insert, modify, and 
delete action, refer to Tracking Agreement Clause Activity in the Conga CLM Administrator 
Guide.

Behavior and Recommendations

Inserting a smart clause into a cell of a Microsoft Word table produces an error. To prevent 
this error, you must insert a space in the cell of the table before and after a clause.

Preview Reconciliation
The preview reconciliation feature allows you to preview the difference between the current 
or modified value in the document and the Conga CLM values. The following tasks are 
available for reconciliation:

Modify a smart field
Mark a field
Modify a marked field
Modify a smart clause
Insert as a smart clause

You cannot search and insert an alternate clause from the Playbook.

https://documentation.conga.com/display/CLM/Tracking+Agreement+Clause+Activity
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Modify a marked clause
Mark a clause for deletion

To preview reconciliation
Go to Work tab > Preview Reconcile. If you do not see Preview Reconcile under 
the Work tab, click the more icon (    and from the menu, select Preview Reconcile. 

The Preview Reconcile tab displays all the modified smart fields, modified mark fields, 
and new marked fields. Review the CLM Value and Current Value of the changed 
smart fields in your document.
Click Next.

The Preview Reconcile tab displays the modified smart clauses, marked clauses, 
inserted clauses, and clauses marked for deletion. Expand a clause from the list to 
review the Original and Edited content of the clause.
Click Back to navigate to the previous screen.

Hiding or Showing Smart Boundaries
Smart fields, smart clauses, read-only fields, and read-only clauses in an agreement 
document are represented in Microsoft Word as a content control, with a bounding box. You 
can control the visibility of bounding boxes using the Hide Smart Boundary and Show Smart 
Boundary options. The Hide Smart Boundary and Show Smart Boundary options are visible 
based on the Hide Content Control Border custom setting in the Conga CLM. Your 
administrator can configure the custom setting. For more information on configuring custom 
settings, refer to the Comply System Properties topic in the Conga CLM Administrator 
Guide. The following table provides the details about which option is displayed based on 
the Hide Content Control Border custom setting:

Hide Content Control Border 
 custom setting when 
generating or checking-in the 
document

Result Menu in Work tab

True All smart boundaries are hidden 
while checking-out the document.

Show Smart Boundary

)

If you have only one change in the agreement document, the Cancel button is 
displayed instead of the Next button.
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Hide Content Control Border 
 custom setting when 
generating or checking-in the 
document

Result Menu in Work tab

False All smart boundaries are shown 
while checking-out the document.

Hide Smart Boundary

Prerequisite
Ensure that the checked-out document contains read-only fields, read-only clauses, smart 
fields, or smart clauses.

To hide smart boundaries in an agreement document

In the Contracts pane, go to Work tab and click the more icon ( ).
Click Hide Smart Boundary. 
This hides all the smart boundaries.

To see smart boundaries in an agreement document

In the Contracts pane, go to Work tab and click the more icon ( ).
Click Show Smart Boundary. 
This shows all the smart boundaries.

Unlocking Read-Only Clauses
Read-only clauses are clauses with content control boundaries whose text cannot be 
edited in a generated agreement. However, as a Contract Administrator, you can grant 
certain users the permission to unlock the read-only clauses in the agreement document. 
This feature gives you more control on clause access and you can speed up the review or 
negotiation process by allowing certain users to edit the read-only clause. You can use the 
custom permission XA_UnlockReadOnlyClause to give edit access to read-only 
clauses. This permission must be associated with the user's profile to provide the user the 
access to the read-only clauses. When you enable XA_UnlockReadOnlyClause custom 
permission for a profile, the users of that profile get access to the Unlock Clauses option in 
the Work tab. Clicking Unlock Clauses scans the entire document and unlocks the read- 

Regardless of the Hide/Show Boundary option selected before checking in, the 
boundaries are displayed after checking out the document.
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only clauses present in the document. Update from Salesforce does not impact read-only 
clauses.

You can delete a read-only clause when:

You have edit access to the read-only clause, which means, 
 XA_UnlockReadOnlyClause custom permission is enabled. 
UnlockSmartElement custom setting is enabled, which means, the smartness 
property of the clause is unlocked.

Prerequisite
You must have XA_UnlockReadOnlyClause permission to view the Unlock Clauses option in 
the Work tab. For information on XA_UnlockReadOnlyClause custom permission, 
see Conga CLM Administrator Guide.

To unlock or lock Read-Only clauses
Open a generated agreement document containing read-only clauses.
Go to Work tab > Unlock Clauses. If there are no read-only clauses in the agreement 
document and you select Unlock Clauses, an error message is displayed. 
All the read-only clauses in the agreement document become editable. 
Make the required changes to the read-only clauses or delete read-only clauses.  
To delete a read-only clause, see To mark a clause for deletion.
Go to Work tab > Lock Clauses. 
The read-only clauses become uneditable. You cannot undo changes after the read- 
only clauses are locked.
Check in the agreement document. 
If you do not lock read-only clauses and check in the agreement document, the read- 
only clauses get locked.

Marking Fields
Using Doc Fields, you can mark small chunks of agreement document content as fields. 
When you mark content in an agreement document as a field, it becomes a smart field. 
Smart field values can be reconciled with data in the agreement record when the document 

Note

You can view modified unlocked read-only clauses on the Reconciliation page or 
Agreement Clauses tab.
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is checked in, allowing changes made during negotiation to be accurately reflected and 
managed as data in the Conga CLM. Content marked as a field must map to the data 
type of existing fields in your agreement record.

Marking a field in a single agreement does not mark the field across all other documents 
for the same agreement record.

To mark a field in an agreement
Highlight the content of the contract to be marked as a field.
In the Work pane, click the more icon and select Mark Fields to open the Mark Fields 
form.
The Mark Fields form lists all the available CLM fields with their name and type that 
could be made smart. These fields are grouped into different categories according to 
the field type, like Information, Key Dates, Miscellaneous, etc.
Use Search Fields to enter the field name and search or scroll through the list of fields 
to select the field to be applied to the selected text.
Click the more icon next to the field name and click Mark Field. You will get a 
confirmation message.
Select Mark in the confirmation message to mark the selected text as a smart field.

You will get a success message and the selected text in the contract will acquire content 
control boundary. The content adopts the properties of the same field on the agreement 
record.

Doc Clauses
The Doc Clauses tab lists all smart clauses in the agreement document. You can take the 
following actions on clauses from the Doc Clauses tab:

Navigate to a clause in the document
Mark a clause for deletion
Unmark a clause

Note

Make sure the format of the text you are marking matches the data type you are 
mapping to. You will receive an error if the text is not valid for the field type you 
choose.
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To view a clause
Go to Work > Doc Clauses tab.
Click on a clause name in the list. The document scrolls to highlight the selected 
clause in the agreement document.

To mark a clause for deletion
Go to Doc Clauses > Available Clauses list.
Search the clause you want to delete or select the clause from the available clauses 
list and click the more icon   next to the clause name.
Click Delete.
You will get a confirmation message, select Delete again.

You'll get a message, "Your clause will be deleted on reconciliation" and the clause text in 
the document is marked with a strikethrough. You can click Undo Delete from the more 
options next to the clause name, to remove the mark at any time in the same session.

Check-in the document and choose Reconcile. The content of the deleted clause is removed 
from the document and a "Deleted" entry is recorded in the Agreement Clause related list 
on the agreement record in Salesforce.

Unmarking a Clause
Unmarking a clause removes clause properties and returns the text to a static state. If you 
decide you want to unmark a clause during the same session in which you marked it, you 
can use the Doc Clauses pane to remove clause properties. Note that, if you chose to 
replace the text with a clause from the library, you cannot choose to unmark the clause, it 
can only be deleted.

Pre-requisites

You must have marked static text in the agreement document as a clause in the 
same session using Playbook.

Sections and supporting documents do not display in the list of clauses if they 
contain a smart field.



For more information on tracking clauses and clause activity in your agreements, 
refer to the Conga CLMAdministrator Guide for the Salesforce platform.
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To unmark a clause
Go to Work > Doc Clauses.
Search the clause using Search Clauses or select the clause from the Available 
Clauses list.
Select the marked clause and click the more icon.
Click Unmark.

You will see a confirmation message and the clause will be removed from the available 
clauses list too. The clause will also lose the content control border after your Unmark it.

Doc Fields
The Doc Fields section of the Document Panel lists all smart fields in the agreement 
document. Use the Document Panel to take the following actions on fields in the document:

View and change field values in the document
Mark Fields
Reject changed field values
Validate field value format
Mark fields for deletion

To view and change fields
In the Work tab and click Doc Fields. All fields are displayed in a list in the order they 
appear in the document. Previous (as of last check-in), CLM, and Current (document), 
values are displayed.
Click a field in the list to highlight the field in the document.
To change the current value of a field, place your cursor in the field's content control 
in the document, and make changes. To view the updated field value in the Doc Fields 
list, click some other tab and then click back the Doc Fields tab.
Click Validate to confirm that the new field value is valid for its corresponding data 
type.

The changed field values are updated in the agreement document upon check-in. If 
you choose to reconcile fields during check-in, they will also be changed on the 
agreement record.
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Marking Fields
Using Mark Fields, you can mark small chunks of agreement document content as fields. 
When you mark content in an agreement document as a field, it becomes a smart field. 
Smart field values can be reconciled with data in the agreement record when the document 
is checked in, allowing changes made during negotiation to be accurately reflected and 
managed as data in the Conga CLM. Content marked as a field must map to the data 
type of existing fields in your agreement record.

To mark a field in an agreement
Select the content in the document to be marked as a field.

In the Work tab, click the more options icon ( ) and select Mark Fields to open the 
Mark Fields form.
The Mark Fields form lists all the available CLM fields with their name and type that 
could be made smart. These fields are grouped into different categories according to 
the field type, like Information, Key Dates, Miscellaneous, etc.
Use Search Fields to enter the field name and search or scroll through the list of fields 
to select the field to be applied to the selected text.

Click the more options icon ( ) next to the field name and click Mark Field. You will 
get a confirmation message.
Select Mark in the confirmation message to mark the selected text as a smart field.

You will get a success message and the selected text in the contract will acquire content 
control boundary. The content adopts the properties of the same field on the agreement 
record.

Marking a field in a single agreement does not mark the field across all other 
documents for the same agreement record.



Make sure the format of the text you are marking matches the data type you are 
mapping to. You will receive an error if the text is not valid for the field type you 
choose.
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Rejecting changes to a field
If changes have been made to smart fields in the document, you can choose to reject these 
changes in the same session prior to check-in. You can not reject changes for fields that are 
marked using the Mark Field option.

To reject changes
In the Work tab, click Doc Fields.

Click the more options icon ( ) next to the changed fields in the Doc Fields pane and 
select Reject changes.

The field value is reverted to its previous value prior to the change. The Doc Fields pane 
reloads to show the change.

Validating Fields
Use the Validate action to ensure that all smart fields in your document are in the proper 
format for their assigned data type (e.g., Date, Number, DateTime, selected values from 
picklists, etc.).  For example, if the date format is not proper in the document, you get an 
error message when validating fields. The agreement document cannot be reconciled at 
check-in unless all fields in your document are valid.

To validate fields
In the Work tab, click Doc Fields.
Click the Validate button.
If any fields are invalid, an error message is displayed for the first invalid field. The 
first invalid field is also highlighted in the document.
Make corrections to the invalid field as needed and click Validate again to confirm 
there are no invalid fields.

If all the fields are valid, you'll see a success message displayed at the top of the pane. You 
can now check-in your document.

Marking Fields for Removal
There will be times in the negotiation when a negotiating party wants to remove language 
from an agreement that contains a smart field. According to document protection settings, 
users outside your org can remove content from the agreement, but any smart field content 
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removed will not remove the field itself. Follow the instructions on this page to mark fields 
for removal. You usually want to mark fields for removal when:

A user marked static text as a field.
A Template Admin marked the field as smart.
You need to delete a smart field from an agreement document.

To mark fields for deletion
In the Work tab, click Doc Fields.

Click the more options icon ( ) icon and select Mark for Removal. 
Click Delete on the confirmation dialog that appears. The field is marked with a 
strikethrough in the document and the Document pane to denote that it has been 
marked for deletion. 
Check-in the document and choose Reconcile. The field is removed from the document.

To unmark fields for deletion
If you decide in the same session that you want to keep a field in the document that you 
have already marked for deletion, follow these steps.

In the Work tab, click Doc Fields.

Click the more options icon ( ) icon and select Undo Delete.
Click Undo on the confirmation dialog that appears.

Highlighting Smart and Read-Only Fields
The highlight fields feature in the Work menu allows you to highlight smart and read-only 
fields in your agreement document. 

To highlight smart and read-only fields
Open an agreement document in X-Author for Contracts.
In the Work tab, click the more icon ( ).
Click Highlight Fields.

All smart fields are highlighted in lime color and read-only fields are highlighted in yellow 
color. The highlight for fields is not retained when you check-in the document, send the 
document for review, or close Microsoft Word.
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To remove highlight for smart and read-only fields
In the Work tab, click the more icon ( ).
Click Unhighlight Fields.

This removes the highlights from the fields in the agreement document.

Checking in an Agreement Document
Whether you are saving a redlined version, clean version, or final version, the process for 
each is similar and each makes use of X-Author's Check-In feature. Only Microsoft Word 
documents in DOC and DOCX format are supported for maintaining versions, opening and 
checking in agreement documents. When you check-in from X-Author, the document you are 
working on is converted back to the same document format as when it was first checked 
out.

Prerequisite
You can view With Redlines, Without Redlines, and Final - to be signed options according to 
the custom permissions available for your profile. 

Custom permission in Conga CLM Save option available in X-Author for 
Contracts

XA_CheckinAsFinal Final - to be signed, Without Redlines, and With 
Redlines

XA_CheckInWithoutRedlines Without Redlines and With Redlines

XA_CheckInWithRedlines With Redlines

If all the custom permissions are disabled, you can view all the Save Options. For more 
information on how to configure custom permissions, see Conga CLM Administrator Guide.

Mark Field and Highlighting

If Highlight Fields is already selected in the Work menu and you mark a text in the 
agreement document as a smart field (using the "Mark Field" option), the marked 
field is not automatically highlighted. Click Unhighlight Fields and Highlight Fields 
in the Work menu to highlight the new field. 
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To check in an agreement document
From the Contracts pane, click Finish tab. The Check-in page is displayed.
From Save Options, choose one of three options for saving the document:

Option 
at 
Check-in

Description

With 
Redlines

This saves a draft version of the agreement document with all markups and 
Redlines is used as the action in your org's configured default document 
naming convention. A DOCX version of the document is saved in Notes & 
Attachments. If Contract Document versioning is enabled, selecting this option 
creates a new version under the Document Versions related list in your 
Agreement record.

Without 
Redlines

This saves a draft version of the document without markups and is typically 
done before sending an agreement to a third party for review. Track changes/ 
redlines are automatically removed from the Word file and _Clean is used as 
the action in the configured default document naming convention. A DOCX 
version of the document is saved in Notes & Attachments. If Contract 
Document Versioning is enabled, selecting this option creates a new version 
under the Document Versions related list in your Agreement record.

Final - to 
be signed

This saves a version of the document without markups and also enables a PDF 
version of the document to be created. If this option is selected, a PDF file will 
be saved to the agreement's Notes & Attachments related list. By default, 
_Final is used as the action in the configured default document naming 
convention. If Contract Document Versioning is enabled, selecting this option 
creates a new version (DOCX) under the Document Versions related list in your 
Agreement record.

In the Agreement Name field, enter the required name for the document or leave it as 
the name suggested by X-Author. The default name includes the agreement name, 
revision number, and version type. X-Author automatically saves the agreement in 
DOCX format.

When you select "Final - to be signed" as the check-in option, Create PDF 
attachment is automatically checked if you have the Comply System Property 
Auto Enable PDF for Final Docs enabled. For more information on Comply 
System Properties, refer to Conga CLM Administrator Guide.
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Select the required watermark option.
Select Include Watermark, to add one to a non-final version. This option is 
available with the With Redlines and Without Redlines options.
Include Watermark is automatically deselected (greyed out) if you are saving 
the document as Final - to be signed.

Select Reconcile Document to synchronize the Salesforce Agreement object fields with 
those that were updated in the document. See Reconciliation for more details.
Select Mark as private to enable the Private indicator for this agreement (only for use 
in custom implementations– see the Conga CLM Administrator Guide for more 
information).
Click Finish to confirm check-in of the document. If you have selected the Reconcile 
option, you will see Save and Next button which takes you to the reconciliation page.

The document is checked in to Salesforce and the new document version is downloaded 
from the agreement record. Close the document you just checked in (no need to save) and 
load the newly downloaded document to continue working with the agreement, if 
necessary.

For information on enabling Contract Document Versioning and how it works, refer to 
the Conga CLM Administrator Guide for the Salesforce platform.

Reconciliation
X-Author for Contracts provides a reconciliation feature which enables changes made to 
smart fields in an agreement document, outside of the Salesforce/X-Author environment, to 
be reconciled with the data held in the Agreement record in Salesforce.

In a typical scenario where an agreement document is sent to an external party for 
negotiation, the external party will make changes to the document as part of the 
negotiation. If the changes to the document involve data belonging to the Agreement 
record, reconciliation provides the mechanism to ensure the values in the document and the 
Agreement record are reconciled.

If the document already contains a watermark, the watermark will be 
removed instead when this option is chosen.



If there are any invalid fields in your agreement, a message is displayed and the 
check-in is not completed. Return to Doc Fields to validate fields and make 
corrected as needed.
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To check in and reconcile smart fields and clauses
From the Contracts pane, click Finish to open the Check-In page.
Choose the Save Options for saving your document:

To check in the document with redlines, choose With Redlines.
To check in the document without redlines (clean), choose Without Redlines.
To check in the document as final, choose Final - to be signed.

Select the Reconcile checkbox and click Save & Next.
This page shows all the smart field with changed values that are available for 
reconciliation. Review the CLM Value and Current Value of the changed smart fields 
in your document and click Save & Next.
This page shows the changed smart clauses that are available for reconciliation. 
Expand a clause from the list to review the Original and Edited content of the clause.

Click Finish to check in the document with reconciliation.

Updating Fields from Conga CLM
Update from CLM is an option available in the Work tab that allows you to update smart 
fields and Readonly fields in your agreement document with the current values in Conga 
CLM. Update from CLM updates all header, 2nd, and 3rd level smart fields located in your 
document, including:

Smart and read-only fields in the body of the agreement document.
Smart and read-only fields in sections.
Smart and read-only fields in tables or repeating datasets. 
Smart and read-only fields in generated clauses.

If you choose to check in the document without reconciling, changed smart 
field values will not be updated in the agreement record and changes to 
clauses will not be reflected in the Clauses related list in Conga CLM. If you 
choose to check in the document with redlines, redlines and comments will be 
retained



Agreement documents cannot be reconciled with the agreement record as long as 
invalid values exist in the document for smart fields. Go to Doc Fields pane to 
perform a validation and correct any invalid field values.
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To Update from Conga CLM
Check out your agreement document and go to Contracts > Work tab and click the 
more icon ( ).
In the menu, click Update from CLM to display a dialog showing all header-level 
fields in the document. Field values that have been changed on the Conga CLM 
record are highlighted in red.
Review the changed values and click Update to update the field values.  
You'll see a success message when the fields are updated in the agreement.

Opening Agreements in Conga CLM
You can easily view the Agreement record associated with your document by choosing 
Open in CLM from X-Author.

To open an agreement in Conga CLM
Connect to X-Author for Contracts.
Open the agreement document for the agreement you want to view.
Under the Contracts pane, click the Work tab.
In the Work tab, click more icon ( ) and select Open in CLM.

A separate browser window is opened and the agreement is loaded in Conga CLM(You may 
be prompted to log in again to your Conga CLM account in the browser).

Creating Offline Agreements
Offline Agreements can be created directly in X-Author Contracts, by taking a pre-existing 
Microsoft Word document that was created outside of CRM and has not previously been 
associated with an Agreement and checking it in. When you have a document open in 
Microsoft Word and you can create a new agreement record by checking it in as an offline 
agreement.

•

•

If you choose to update fields from Conga CLM, all changed smart field values 
and Readonly field values will be updated. You cannot select only specific 
fields.
Fields cannot be updated to an empty (null) value.
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To create an offline agreement
Open the document in Microsoft Word and connect to X-Author for Contracts.
Select the Contracts option from the left-hand menu and go to Start > Create. The 
Create New Offline Agreement page is displayed.
In the Create New Offline Agreement window, enter the following details (fields 
marked with an asterisk are required):

Fields Description

Record Type* Select the Record Type from the picklist.

Name* Enter the agreement name.

Account* Enter the Account name.

Contact* Enter the Contact details.

Start Date Select the start date of the agreement from the date 
picker.

End Date Select the end date of the agreement from the date 
picker.

Click Save. You will see a confirmation message.

A new agreement record is created in Conga CLM. If the Enable Document Versioning 
comply system property is enabled in Conga CLM, the new agreement is available in 
Document Versions. If the Enable Document Versioning comply system property is not 
enabled and the Enable File comply system property is enabled, the new agreement is 
available as a type-file in the Notes & Attachments. You can also send the offline 
agreement for review when the Parallel review comply system property is enabled. For 
more information, see Sending an Agreement Document for Parallel Review.

Importing Offline Agreements
Using X-Author Contracts you can import a document which has not previously been saved 
in CLM and attaches it to a pre-existing agreement record. Like creating a new agreement, 
when you choose to associate the document with a pre-existing agreement record, it is 
added to the Documents related list for that agreement. Unlike creating new offline 
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agreement, importing an agreement offline does not create a new agreement record, but 
rather attaches your offline document to a pre-existing agreement record.

To import an offline agreement
With the document open in Microsoft Word, connect to X-Author for Contracts.
Go to the Contracts pane >  Start > Search Agreements.
In the Search Agreements field enter the full or partial agreement name and click the 
search icon to locate your agreement.
From the search result select the agreement name and click Check In Offline.

Your document is checked in offline and you can download the checked-in version of the 
agreement document. You can view the checked in agreement from Documents related list 
of your agreement record in Conga CLM. The imported agreement does not have a 
template associated with it. You can also send the offline agreement for review when the 
Parallel review comply system property is enabled. For more information, see Sending an 
Agreement Document for Parallel Review.

Extracting Agreement Data Using Intelligent Discovery
You can use the Intelligent Discovery feature to automatically extract key data from third- 
party contract documents. Intelligent Discovery scans the third-party document, 
recognizes, and maps important metadata and clauses to the Conga CLM. You can control 
the visibility of the Intelligent Discovery feature in X-Author for Contracts. For more details, 
see Configuring Intelligent Discovery Settings topic in the Conga CLM Administrator Guide.

Previously, on importing an offline agreement, you had to manually find clauses and fields 
and mark them. Intelligent Discovery uses the pre-trained Artificial Intelligence-based 
clauses and fields AI Models to recognize the words that denote the clauses or fields in the 
third party document.

Pre-requisites:

You must configure the Intelligent Discovery Settings in Conga CLM to view the 
Intelligent Discovery option in the Work tab. For more details, see Configuring 
Intelligent Discovery Settings topic in the Conga CLM Administrator Guide.
You must create a mapping of record types and provisions. For more details, see 
Mapping Record Types to Projects topic in the Conga CLM Administrator Guide.

To perform the Intelligent Discovery
Check-in the third-party document as an offline agreement in X-Author Contracts.
Check-out the offline agreement document.
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From the Contracts pane, go to Work tab and click Intelligent Discovery. 
Click Yes.

Your document is sent for the Intelligent Discovery and you see a confirmation message. 
Click Review Import Result to check the status of Intelligent Discovery. You get a message 
and an email on Intelligent Discovery status after clicking the Review Import Result. 

After clicking the Review Import Results, the status of the agreement changes in Conga 
CLM. For more information on change of statuses in Conga CLM, see Status Changes in 
Offline Agreements.

After the Intelligent Discovery has performed the data extraction successfully, you will 
receive an email. You can see the fields and clauses recognized from the document in X- 
Author Contracts. The Doc Fields and Doc Clauses in Work tab shows the list of fields and 
clauses identified in the document. You can perform the following tasks on the extracted 
fields and clauses:

Reviewing Doc Fields after Intelligent Discovery
Reviewing Doc Clauses after Intelligent Discovery

Reviewing Doc Fields after Intelligent Discovery
In the Doc Fields tab, you can review the actual and normalized values for each extracted 
field. For example: for Term, the actual extracted value is “The Agreement term is 3 years” 
and the normalized value is "36".  The Doc Fields tab displays the normalized value for the 
first extracted value at the top and all the actual extracted values below it. To highlight 
the corresponding text in the document, click on the actual extracted value. You can edit 
the normalized value or set a custom value for a field. 

If you find that some extracted fields are incorrectly marked, you can remove the identified 
fields from the document. You can also re-mark the specific field in the document. For 
Example, the actual extracted value is Agreement Start Date is "01/01/2019" but only 
01/2019 is incorrectly marked as a field in the date. Using this Re-mark field feature, you can 
select the full date and re-mark the field. This removes the incorrect doc field and creates a 
new doc field as per your marking. 

To Re-mark the extracted field
Go to the Work tab and click Doc Fields.

Select the incorrectly tagged Doc Field and click the more options icon ( ). Following 
menu options are displayed.

Re-mark Field: To remark the selected field in the document.

https://documentation.conga.com/clm/spring-21/status-changes-in-offline-agreements-143904861.html
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Delete Field: To delete the field. 

Click Re-mark Field. 
Click Re-mark on the confirmation dialog that appears. This removes the incorrect 
doc field and creates a new doc field as per the new marking.

To Re-mark the Lookup field
Go to the Work tab and click Doc Fields.

Select the lookup field and click the more options icon ( ). Following menu options are 
displayed.

Re-mark Field: To remark the selected field in the document.
Delete Field: To delete the field.

Click Re-mark Field. 
Click Re-mark on the confirmation dialog that appears. This removes the incorrect 
doc field and creates a new doc field as per the new marking.

To Edit the Extracted Field Value

Go to the Work tab and click Doc Fields. It displays all the extracted values for each 
field present in the document.
At the top, it displays the normalized value for the first extracted value. Click on the 
normalized value to view all the values for a field.
Click edit icon  to update the value.
Select a normalized value from the dropdown list.
Click Custom Input in the dropdown list to set a custom value for the field. 

When you click on the Delete Field option, the content control of the selected field is 
removed and content remains the same in the agreement document or template.
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Enter a value in the textbox or use the Search box to search for a value. For the date 
field, the textbox shows a calendar. You can select a date from the calendar or enter 
a date in the textbox. 

Click the Save icon  to save the value. 
Click the Reset icon  to reset the previous value.
Click Validate to validate the format of normalized value.

Once you select a normalized value for all the fields and check-in the document, all 
occurrences of the field in the document are updated to the selected value.

Behavior and Limitation

If an actual value is not converted into a normalized value, the normalized value is 
shown as N/A.
For fields with multiple extractions, if you do not explicitly select one of the 
normalized values from the list

at the time of check-in first normalized value is displayed for the same 
extracted fields. 
each occurrence of the field is updated with the first normalized value in the 
document. The first normalized value is updated in the agreement in Conga 
CLM.

If you set a custom input for a normalized value and reload the X-Author for 
Contracts add-in, the custom input for the normalized value is not retained.
If there is a line break for extracted text, the partial text is marked as a field or 
clause.
If you re-mark any field 

Reviewing Doc Clauses after Intelligent Discovery
If you find that some clauses are incorrectly marked, you can remove the identified clauses 
from the document. You can also mark other content as a field in the document.

To remove a marked clause after Intelligent Discovery
Go to the Work tab and click Doc Clauses.

Select the incorrectly tagged clause and click the more options icon ( ).
Click Unmark. 
Click Unmark on the confirmation dialog that appears.

Additionally, clauses and fields extracted by Intelligent Discovery are converted into smart 
clauses and fields. Upon check-in with reconcile, it will promote all marked clauses.
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Tracking Clauses in your Agreement Document
The Clauses related list on the Agreement record captures the clause activity for 
associated agreement documents during contract negotiation. You can open an agreement 
document in X-Author and make changes to it by inserting, modifying or deleting clauses. 
When you check-in that agreement document, new records are created in the Agreement 
Clauses Related List that reflects these changes. With each change made to the clauses, 
either from Playbook or to the new clause marked in an agreement document, you can see 
corresponding entries in the Agreement Clauses Related List of your agreement record in 
the Conga CLM.

Agreement Clause activity is recorded in the related list during a negotiation when you 
insert, modify or delete a clause in the initial session or a subsequent session. A session can 
be defined as the time between opening a document in X-Author for Contracts and 
checking it in. You can insert, modify or delete the content of a clause in an agreement 
document by doing any of the following:

User action in X-Author for 
Contracts

Trigger point in X-Author 
for Contracts

Agreement Clauses - Action 
entry in Conga CLM

NA NA Original (after a document is 
generated)

Check-out a document NA NA

Modify a smart clause Reconciliation Modified

Delete a smart clause Reconciliation Deleted

Insert clause as smart in an 
agreement

Check-in with any save option Inserted

Insert clause as text in an 
agreement

Check-in with any save option InsertedAsText

Modify smart fields in a smart 
clause

Reconciliation FieldChangedOnly

Check-in a document as Final NA NA 



X-Author for Contracts

138 Copyright ©2022 Apttus Corporation. All rights reserved.
 

•

•

•

•

•

•

•

•

Localization
You can define the locale of your templates in X-Author Contracts (Windows). The 
localization feature allows you to define locale settings for Number, Currency, Precision, 
and Date fields. You can generate a document in Conga CLM using the template that you 
have created in X-Author Contracts (Windows) and check out or open the generated 
document in X-Author for Contracts (MAC). X-Author for Contractssupports multiple 
locales. 

 
When you open a generated document in X-Author for Contracts the following conditions 
are applicable for a localized agreement:

If you import an offline agreement document, the default English (United States) 
locale settings are applied to the document.
If you use the "Update From CLM" option, the values are updated from Conga CLM in 
the document according to the locale settings of the template/fields.
If you have Doc Fields in the document and validate them, the Doc Fields 
are validated based on the locale settings of the template or fields.
If you update smart fields with locale settings, you can view the updates when you 
use Preview Reconciliation and Reconciliation options.
If you have Mark Fields in the document, you need to enter the values in the default 
English (United States) format and the value is converted according to the template/ 
fields locale.
If you insert a clause either by using the Insert or Insert Smart option, the document 
inherits the locale settings of the agreement template if the clause does not have any 
locale settings. 
If you insert a clause either by using the Insert or Insert Smart option, the document 
inherits the locale settings of the clause if the clause has locale settings. 
If you are connected to a multicurrency org, the currency is displayed based on the 
record level currency. 

Note

You must create the template in X-Author for Contracts (Windows) using the latest 
X-Author for Contracts Salesforce Template.
Enable Formatting must be selected when the template is created, cloned, or 
checked in. For more information on localization and list of supported locale, see X- 
Author for Contracts User Guide.
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Use Case: Managing Localization
This topic describes how a template administrator can create a template using X-Author 
for Contracts (Windows) with Japanese locale, generate a document using the template, 
and review it in X-Author for Contracts (MAC).

Prerequisite

You must create the template in X-Author for Contracts using the latest X-Author for 
Contracts Salesforce Template.
You must disable the Enable Template Versioning property in the Conga CLM Comply 
System Properties.

To define locale settings for a new template in X-Author for Contracts

Open Microsoft Word and click Connect on the Templates or Contracts and 
select Manage Connections.
In the Create a new connection section, enter a name for the connection and enter the 
host URL of your CRM in the Login URL field. The login URL is the URL of the CRM with 
which you want to connect.
Click the Templates tab.
Click New. The Specify Template Attributes dialog opens. 
Enter the following values in the fields and then click OK.  

Type: Select Agreement
Business Object: Select Apttus__APTS_Agreement__c
Locale: Select Japanese
Enable Formatting: Select the checkbox
Date Format: Select yyyy'年'M月'd'日'
Currency Format: Select Currency Symbol
Number Precision: Enter 2
Currency Precision: Enter 2

Navigate to Templates tab.
Paste the following content in the document:

This Master Service Agreement "Agreement"  with XYZ corporation and 
has a start date of "Agreement Start Date" .

Select Agreement in the content and click Insert Fields.
Select Agreement Name and click Finish.
Select Agreement Start Date in the content and click Insert Fields.
Select Agreement Start Date and click Finish. Mark the Agreement Start Date field as 
smart.
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Click Check-In. 

Enter the following values in the fields:
Name: Enter JLocale
Agreement Types: Select Corporate
Category: Select Category
Subcategory: Select Subcategory
Language: Select Japanese

Click Check-In.
Log into the Conga CLM application. 
Navigate to the Agreements tab, and click New.
Select Corporate from the Record Type of new record and click Continue.
Enter the following values in the fields:

Agreement Name: Enter JAgreement
Agreement Start Date: Select 5/20/2019
Account: Acc

Click Continue and click Save.
Select JLocale as the template and click Generate.
Open the generated document in X-Author for Contracts. The locale settings in the 
document are inherited from the template.
Change the agreement start date to 2020年8月21日.
Insert a clause with smart fields. All the fields are updated based on the template 
locale
Navigate to Doc Fields and click Validate. All the fields are validated based on the 
template locale and template date format.
Change smart field values in the Conga CLM application and click Update from CLM. 
The field values are updated in X-Author for Contracts as per the template locale.
Change the agreement start date to 2020年8月22日.
Click Preview Reconcile or Reconcile to view the locale based changes in the 
agreement document.

Tip

The Control Panel shows all the field present in the template and when you 
select a field the Properties pane is displayed under the Navigation pane of 
the Control Panel. From the Properties pane, under Display Attributes, you can 
change or define the format for Number, Currency, and Date fields.



Tip

You can change the locale of a template in the check-in window.
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28. Click Check-In.

Restricting Agreement Document Check-In and Check 
Out
You can restrict agreement document check-in and check out based on the Status 
Category and Status of the agreement. You can use the "Restrict Checkin of Documents" 
comply system property to restrict users from checking in and checking out agreement 
documents. By default, no value is available for the property, hence, no check-in restrictions 
will be applied.  For information on the Restrict Checkin of Documents comply system 
property, see Conga CLM  Administrator Guide.

If you provide a Status Category as the property value, the check-in and check-out 
restrictions are applied to all the statuses belonging to that status category. If you provide 
a Status as the property value, the check-in and check-out restrictions are applied only to 
that status.

If an agreement Status Category or Status matches the property value and you check-out 
the document, all the options are disabled and you cannot check in the document. If an 
agreement Status Category or Status changes with the workflow and does not match the 
property value, the restrictions are removed and you can modify the agreement. 

Use Case
Consider the Restrict Checkin of Documents has In Authoring (Status Category) as the 
property value. When you open a document with the Internal Review status, the restriction 
will be applied and you cannot modify the document. This is because the restriction was 
applied at the Status Category level and all the statuses of that Status Category are 
considered for restriction.

Working with Files
When you enable the "Enable File" comply system property in Conga CLM, you can check in, 
check out, and work on the agreement documents of type - Files. For more information on 
the comply system properties, see Conga CLM Administrator Guide.

Note

You can also use the above steps to create a clause template and generate the 
clause document.
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Promoting Clauses to Playbook
You can promote a marked clause from an agreement to the playbook to make that clause 
a part of the Playbook's clause repository. When you mark a text as a clause in an 
agreement, the highlighted text acquires smartness and becomes a clause. However, a 
marked clause is only considered a clause for that agreement instance and when you 
regenerate the agreement, the marked clause is lost. If you want to reuse the same marked 
clause for that agreement record even after regenerating the document or want to make 
the marked clause available for other agreements and users, you can use Promote Clause 
to make it a part of the Playbook.

Prerequisite
You must have a marked clause either in the template or in an agreement document.

To promote a clause to the Playbook
Go to Work tab > Promote Clauses. If you cannot see Promote Clauses under the 
Work tab, click the more icon ( ) and from the menu, select Promote Clauses.
From the list of marked clauses, select the clause you want to promote to the clause 
library and click Promote Clause. 
The Promote Clause form inherits field values from the marked clause. 
You can change the following field values based on your requirement.

Field Description

Clause Name Enter a new name of the clause.

Category Select a category for your clause. The values of the 
categories are defined by your admin and help in filtering the 
clauses.

Subcategory Select a subcategory for your clause. Options in the list will 
change based on the category you selected.

Language Choose the default clause language.
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Field Description

Description Enter a new description or modify the existing description for 
the clause. Maximum of 255 characters (an error will be 
thrown if this limit is exceeded).

Guidance Enter new guidance or modify existing guidance to help users 
determine the purpose of the clause.

Keywords Enter comma-separated keywords to associate with the 
template. Keywords make it easier to search the templates.

Click Save.

You have promoted the clause to the Playbook. You can open the Playbook and search the 
promoted clause to use it in any other document or template.

Comparing and Merging Agreement Documents
This feature allows to compare or merge any two versions of an agreement document. You 
can compare or merge different versions of an agreement document within the same 
agreement record. You can also compare or merge different versions of an agreement 
document within the same agreement record. 

Compare: The comparison is done on the basis of Word's Legal Black lines compare 
functionality. Compare Legal Black Lines compares the documents and displays only what 
changed between the two documents. The documents being compared are not changed. 
This type of comparison is always displayed in a new third document, typically named 
Compare Result. Microsoft Word displays a new, third document in which tracked changes 
in the baseline document are accepted and changes in the selected document are shown 
as tracked changes. The documents being compared are not changed. You can compare 
the different versions of an agreement document within the same agreement record. You 
can also compare different versions of an agreement document within the same agreement 
record generated using different templates. 

Merge: Merging documents uses Word's Combine feature to merge selected documents. 
Merging documents can be advantageous if you have one version of the document that has 

When Template Versioning is enabled and you promote a clause to Playbook, the 
system automatically creates an active version (v1.00) of the clause template.  For 
more information about Template Versioning, see Template Versioning topic in this 
guide.
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been redlined, and a regenerated version in the latest format (dynamically inserted fields, 
new clauses, etc.). Original (pre-merged) documents do not get changed. Merging the 
documents displays a new third document, named Merge Result. At this point, you can 
accept and reject any of the redlined elements in the combined document and check-in the 
document as a new version.

Compare Vs Merge
When you compare two document versions, the revised document version is considered as a 
baseline for tracking changes. When you merge two document versions with changes to the 
same content, the edits of both the original and revised content is displayed.

To compare different versions of an agreement document
Open an agreement document.
Go to the Work tab and select Compare. If you cannot see Compare under 
the Work tab, click the more icon ( ) and from the menu, select Compare.
To compare agreement versions from the same agreement record, select a version in 
'Select a version to compare or merge from' and then a different version from 'Select 
a version to compare or merge with' and click Compare.  
A new document is downloaded in the Insert Comments and Track Changes mode. It 
contains the differences between the two versions, in which tracked changes in the 
baseline document are accepted and changes in the selected document are shown as 
tracked changes. 
Open the document in X-Author for Contracts. 
The document is locked and you will be able to Preview Reconcile, Mark Clause, Mark 
Field, Update from CLM, Validate Fields, Update Fields, Update Clauses and Promote 
Clause.
Unprotect the document.
Right-click a comment and select Accept Change or Reject Change based on your 
requirement. 
You can make the required changes and check in the document to create a new 
version of the agreement document.

To merge different versions of an agreement document
Open an agreement document.
Go to the Work tab and select Compare. If you cannot see Compare under 
the Work tab, click the more icon ( ) and from the menu, select Compare.
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To compare agreement versions from the same agreement record, select a version in 
'Select a version to compare or merge from' and then a different version from 'Select 
a version to compare or merge with' and click Merge.  
A new document is downloaded in the Insert Comments and Track Changes mode. It 
contains the changes of the two versions, in which changes in both the documents are 
shown as tracked changes. If both versions have changes in the same smart field, the 
changes in the revised version are retained.
Open the document in X-Author for Contracts. 
The document is locked and you will be able to Preview Reconcile, Mark Clause, Mark 
Field, Update from CLM, Validate Fields, Update Fields, Update Clauses and Promote 
Clause.
Unprotect the document.
Right-click comment and select Accept Change or Reject Change based on your 
requirement. 
You can make the required changes and check in the document to create a new 
version of the agreement document.

Behavior and Limitation
When you compare and merge documents, the original document takes precedence 
as it contains comments. The comments are retained in the merged document. This is 
Microsoft Word's behavior. As a workaround, you can remove comments from the final 
version of the document.
If the document contains date type content control, the merge document may lose 
content control boundary for certain smart fields. This is Microsoft Word's behavior.
When working with Microsoft Word version 2007, the revised document takes 
precedence over the original document.
When working with Microsoft Word version 2019, the combined document contains 
changes from both documents. If both documents contain changes in the same place, 
then the behavior is unpredictable.

Sending an Agreement Document for Parallel Review
At any point in the negotiation process, prior to finalizing the document, you can send the 
document for review to your customers or other parties involved in the negotiation. After an 
agreement document is generated, you can send it for internal or external review to one or 
more reviewers. 

The parallel review is an unordered workflow that allows you to send a document for 
review to multiple reviewers without having to wait for each reviewer to approve it. When a 
Contract Administrator initiates a parallel review, a review cycle is created in Conga CLM. 
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After completing the review, each reviewer can check in the reviewed document. The 
feedback from each reviewer is merged with the latest version of the document. The 
Contract Administrator can review the changes of all the reviewers and check in the final 
document. Conga CLM allows you to track the review activity in the Document Version 
section in the Agreement Related list on the agreement. 

Prerequisites
You must enable the Parallel Review comply system property in Conga CLM to view 
the Send for Review and Check-in button on the latest version of the agreement 
document.
You must check out the latest version of the agreement document per template to 
send for review.
When you click Send for Review and Check-in, you can view With Redlines, Without 
Redlines, and Final - to be signed Save Options according to the custom permissions 
available for your profile. 

Custom Permission in Contract 
Management

Save option available in X-Author for 
Contracts

XA_CheckinAsFinal Final - to be signed, Without Redlines, and With 
Redlines

XA_CheckInWithoutRedlines Without Redlines and With Redlines

XA_CheckInWithRedlines With Redlines

If all the custom permissions are disabled, you will see all the Save Options. For more 
information on how to configure custom permissions, see Conga CLM Administrator 
Guide.

Restriction
You cannot send supporting and non-version aware documents for review. 

To send an agreement document for review
Click Finish to open the Select Check In/Parallel Review page.
Click Send for Review and Check-in to view the Assign Reviewers page.
In the Search and add reviewers section, click User to view a dropdown menu.
Select User, Contact, or Email according to your requirement.
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Enter the following reviewer details:

If you select User, enter the name of a user in your Org. Click Add.
If you select Contact, enter the name of a contact in your Org. Click Add.
If you select the Email address, enter the name and email address of the 
recipient. Click Add.

Click   to remove any reviewer.
Click Next.
In the Notify via Email > Compose Message section, you can view or edit the Subject 
and Message of the review email. Press the Enter key on your keyboard to add a new 
line to the message.  
By default subject line contains the Agreement Document Name and the message 
body contains Sender's Name and Agreement Number.
Click Next. 

In the Reviewer Access Selection (Fields) section, you can view the list of smart fields 
within the agreement document.
Click the smart field name to view the field in the agreement document. 
Select or unselect the first checkbox to allow or prevent a reviewer from editing all 
the smart fields. You can also select or unselect specific smart fields to allow or 
prevent the editing of those smart fields.
Click Next.
In the Reviewer Access Selection (Clauses) section, you can view the list of smart 
clauses within the agreement document.
Click the smart clause name to view the clause in the agreement document. 

Tip

Type the first two letters of user name or contact in the text fields to view 
suggestions. If the desired contact name is not displayed in the first 20 search 
results then enter more characters of the Contact or enter the full name of the 
Contact name.



Note

You cannot add the same reviewer in the User, Contact, or Email 
sections.



Note

The Reviewer Access Selection page does not appear if there are no smart 
fields or clauses within the document or if the document has Insert Comments 
or Read-only protection mode.
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Select or unselect the first checkbox to allow or prevent a reviewer from editing all 
the smart clauses. You can also select or unselect specific smart clauses to allow or 
prevent the editing of those smart clauses.
Click Next.
Select the required Save Options.  
The Reconcile checkbox is selected by default. 
Click Complete. If there are changes to smart fields or clauses in the document:

All the updated smart fields that are available for reconciliation are displayed. 
Review the CLM Value and Current Value of the updated smart fields in your 
document and click Save & Next.
All the updated smart clauses that are available for reconciliation are 
displayed. Expand a clause from the list to review the 
 Original and Edited content of the clause.

Click Complete. 
An email notification with an attached review document is sent to all the reviewers.  
The review cycle is initiated and the document is locked. You cannot use the same 
agreement document which is generated with the same template and cannot send 
the same document for review. You can initiate a new review cycle after the current 
review cycle is completed, ended, or canceled.

As a reviewer you can or cannot perform the following tasks:

You cannot access the Work tab as it is disabled.
You can edit smart clauses and smart fields in the document that are permitted by 
the contract administrator. 
You can check out and check in the review document.

Checking In a Reviewed Document
A reviewer can check out, make necessary changes, and check in the reviewed document. 
When you check-out the review document, X-Author for Contracts identifies the document 
as a part of the review process and allows checking in that document as a revised version. 
A reviewer can check in the reviewed document multiple times before the review cycle is 
completed. A reviewer cannot check in the reviewed document after the review cycle is 
completed. Each reviewer's document is checked in as a new review version. A minor version 

Note

The parallel review is not applicable for Offline Agreements when they are created 
or checked-in for the first time. Once the offline agreement is checked-in, you can 
send for parallel review on the subsequent check-outs. 
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is created after regenerating the document by merging the reviewer changes with the 
previous version of the document. The Contract Administrator can check in a reviewed 
document on behalf of another review. The review cycle is completed when all the reviewers 
check-in their reviewed documents. After all the reviewers have completed the review, the 
Contract Administrator can review the document by accepting and rejecting changes and 
check-in the final document.

Tracking Document Review Status
You can track the status of the documents in the review that require your attention and 
response. When the parallel review is enabled for your org, you can view the reviewer 
details and the current review status of an agreement document.

Prerequisites
You must enable the Parallel Review comply system property to view the Track 
Review Status button.
The Track Review Status button is enabled when you have a document in review.

Restriction
You cannot track review status for non-version aware documents. 

To track review status
In the Contracts pane, go to Start tab > Search > Search Agreements.
Enter the agreement name or number as the search term and click the Search icon (
).
From the search results, click the Expand icon ( ) of the agreement you want to 
download. In the expanded description, click Track Review Status. This opens the 
Review Status page that lists all the review cycles and the review details. 
Click the template name to view a template list that has at least one review cycle. 
The latest template is selected by default.

Click the review cycle name to view different review cycles for a particular template. 
The latest review cycle is selected by default.

Note

For offline agreements, an agreement document name is displayed instead of 
the template name.
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You can view the review cycle details—Started By, Created On, Current Status, Document 
Details, Version, Reviewer Name, Reviewer Email, and Status.

Deleting Smart Elements Using Delete or Backspace 
Key
You can now use the Backspace or Delete key from your keyboard to delete clauses, fields, 
smart clauses, smart fields and read-only fields from an agreement document. Clauses or 
fields deleted from the document are recorded in the reconciliation screen as deleted. This 
feature improves the usability experience of X-Author Contracts.

Earlier smart elements like smart fields or smart clauses could be deleted only by marking 
them for deletion from the control panel and then reconciling them. This feature removes 
that limitation. Also, if you do not have X-Author installed, you would still be able to delete 
smart elements from the agreement document. Additionally, earlier it was difficult to 
remove static text if it was in between two smart elements. That problem is solved with this 
feature.

Prerequisites

To delete a smart element you must ensure that the value of the Comply System 
Property, UnlockSmartElements is set to True in Conga CLM. Only then the smart 
elements become available for deletion. 
For more information on how to configure the comply system property, refer to Conga 
CLM Administrator Guide.

To delete a smart field, smart clause or repeat section
Select the smart element in the document. Highlight the text value of the field, clause, 
section or table with your mouse.
Press Delete or Backspace. This only deletes the field value but the content border 
remains.
Press Delete or Backspace again to completely delete the smart element. Now, the 
content border is also deleted.

OR

Identify the smart element in the document.

Click the vertical ellipsis icon   on the content control border of the element.
Press Delete or Backspace.
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The content control border of the fields, as well as the field value, will be deleted.

To delete a repeat-table
Identify the smart table in the document.

Click the vertical ellipsis icon   on the content control border of the table.
Press Delete or Backspace.

The cell values are deleted but the table remains with blank cells. When you delete a cell 
value within a table, the changes are shown as strikethrough in the reconcile smart fields in 
table screen. The new value column remains blank and the previous value is shown as 
strikethrough. However, this practice is not recommended because if you delete a cell in a 
repeat a table, you may see some issues during reconciliation.

To delete a read-only field
Select the read-only field in the document (Protection Mode= Full Access).
Press Delete or Backspace.

OR

Select the read-only field in the document (Protection Mode= Insert Comments and 
Track Changes).
Press Delete or Backspace.
You will see a Microsoft Word's warning message, click Yes to continue with the delete 
operation.
Go to Microsoft Word ribbon and click Review tab.
Click Accept, to accept the delete changes. The content control of the read only field 
is deleted but the text value remains.
Select the text value and again press Delete or Backspace.
Repeat steps 3 and 4. You have to Accept the delete changes twice.

Now the complete read only field is deleted.

Best Practices and X-Author Contracts Behavior When 
Deleting Smart Elements or Read Only Fields
Smart elements can be deleted using the Del or Backspace key but, while doing it you must 
adhere to the following recommended best practices to avoid errors.

Existing documents would not support delete using Delete or Backspace key unless 
they are regenerated from Conga CLM or checked out in X-Author Contracts.



X-Author for Contracts

152 Copyright ©2022 Apttus Corporation. All rights reserved.
 

•

•
•

•

•

•

•

•

•

You are recommended not to delete fields or smart elements in the following 
scenarios:

If the fields are part of sections, X-Author Tables, Headers, or Footers.
If the smart elements are part of a section with a third level X-Author table.

When Document Protection is set to Full Access

If you delete a field by selecting the field value text and pressing Delete or 
Backspace, hit Backspace or delete twice to remove the text and the content control 
border of the field. If you fail to do so, you'll see a validation error on reconciliation or 
while validating the fields using Validate Fields.

When Document Protection is set to Insert Comments and Track Changes

In Insert Comments and Track Changes protection mode, it is mandatory for you to 
first Accept or Reject the changes in the document from the Review tab of Microsoft 
Word before you perform any action from X-Author Contracts. Failing to do so will 
give you validation errors or unexpected behavior in X-Author Contracts. X-Author 
Contracts actions include performing Update from Salesforce, Checking in the 
document, reconciling the document, Preview Reconcile, and Validate Fields.
You must remove the document protection by manually entering the password before 
you can delete smart elements as well as read-only fields from your document.
If you select a content control and partially delete the text, the partial text would 
remain as static text.
When you delete a smart field in the document and then open the control field, the 
Current Value column of the Control Panel will show blank values for the deleted 
fields.
When you delete a smart field that has multiple occurrences in the document, the 
smart field's occurrence index is not updated in the Control Panel unless you check-in 
the document. The index number helps identify which occurrence of the field you have 
deleted.

Updating Multiple Smart Fields in a Document
The updateSmartFieldsOnAgreementDocument API allows you to update multiple smart 
fields in a document with the latest values and creates a new check-in with the redlined 
version without manual intervention. For more information, see Updating Smart Fields topic 
in Conga CLM SOAP API Guide.
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Working with Conga CLM (Contracts for 
Salesforce)
The following sections describe the features you can use in X-Author for Contracts when 
working with Conga CLM (Contracts for Salesforce).

Managing Templates
Conga CLM (Contracts for Salesforce) User Interface
Creating Templates
Opening a Template
Checking In a Template
Using Fields

Inserting Fields in Templates
Making Fields Smart in Templates
Making Fields Read-Only in Templates
Inserting Fields in Templates as a Table
Making Table Columns and Rows Conditional
Inserting Fields in Templates as a Section

Using Clauses
Using Clause Library for Templates

Inserting Clauses into a Template
Inserting Clause Bundles into a Template

Making Clauses and Clause Bundles Smart in a Template
Making Clauses and Clause Bundles Conditional in a Template

Setting Segment in Templates
Using Template Locale

Changing Field Level Locale

Managing Templates
This section walks the Conga CLM (Contracts for Salesforce) users through the setup of the 
entire contract template lifecycle within the scope of X-Author for Contracts. It covers 
information, step-by-step instructions, and use cases for the features provided by X-Author 
for Contracts. 

You can use X-Author for Contracts to create or maintain contract templates and manage 
them within the Conga CLM (Contracts for Salesforce) system through the Templates. A 
contract template is a common set of sections, clauses, text, and placeholders for terms 
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and conditions. Contract templates are stored within the Template object and are used to 
create contracts.   

The following sections describe the features you can use in X-Author for Contracts when 
working with contract templates.

Conga CLM (Contracts for Salesforce) User Interface
Creating Templates
Opening a Template
Checking In a Template
Using Fields
Using Clauses
Setting Segment in Templates
Using Template Locale

Conga CLM (Contracts for Salesforce) User Interface
This section walks the Conga CLM (Contracts for Salesforce) user through its interface. It 
covers the features displayed on the interface after logging into the Conga CLM (Contracts 
for Salesforce).

Creating Templates

To get started with creating a new agreement template in X-Author for Contracts, you 
must first define the basic properties for your template.

For more information about Conga CLM (Contracts for Salesforce), see Conga CLM 
(Contracts for Salesforce) User Guide. 



If you are a Conga CLM user and you are looking for information regarding 
template creation, see Templates.



This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding template 
creation, see Creating New Templates.
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To create a new Template
Open an existing document or a blank document in Microsoft Word and log in to 
Conga CLM (Contracts for Salesforce).
Click Create New tab in the Templates pane.
In the Create New screen, enter the following details, (fields marked with an asterisk * 
are required)

Field Name Description

Name Enter the name of the template.

Business Object  Business object defines the set of fields available for a 
template. Business objects can be standard objects or custom 
objects. You can configure custom business objects in Conga 
CLM (Contracts for Salesforce). This field is only displayed 
when multiple business objects are configured in the Conga 
CLM (Contracts for Salesforce). If one business object is 
configured, the created templated is assigned to the Contract 
Template business object. For more information about creating 
custom business objects, refer to Configuring Business Objects 
for Use with X-Author for Contracts topic in Conga CLM 
(Contracts for Salesforce) User Guide.

Alternate Clause Select the checkbox to create an alternate clause. This field is 
only displayed when you select Contract 
Template (Apttus__APTS_Agreement__c) as a business object.

Agreement Types From the picklist, you can select multiple agreement types to 
associate with your template. The value of Agreement Types 
decides which templates are available during agreement 
generation in Conga CLM (Contracts for Salesforce). 

Category Choose the category from the picklist. Template categories are 
defined in Conga CLM (Contracts for Salesforce) by the 
administrator. This field is usually used by template 
administrators to categorize templates created by them for 
easy access.
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Field Name Description

Subcategory The subcategory is a dependent field. Subcategories are 
populated based on the value chosen for Category. 
Subcategories are defined in Conga CLM (Contracts for 
Salesforce) by the administrator.

Language Choose any language from the picklist. The default language 
for the template is English (US).

Locale Choose the locale from the picklist. Locale allows you to define 
locale settings for number and currency precision, currency 
format, and date format. Locales can be system defaults or 
user-defined locales. You can configure custom locales in 
Conga CLM (Contracts for Salesforce). For more information 
about configuring locale, refer to Managing X-Author for 
Contracts Templates topic in Conga CLM (Contracts for 
Salesforce) User Guide. 

Enable Formatting Check this box to enable locale formatting at the template 
and field level for this template. This allows you to define 
locale settings for Date Format, Currency Format, Number 
Precision, and Currency Precision.
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Field Name Description

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale 
formatting.

Field Description

Date Format Select an option from the picklist to choose the default 
format for all date fields in the template. Date format is 
a dynamic field to the locale selected.

Currency Format Select an option from the picklist to choose the format for 
all currency fields in the template. Choose "None" to only 
display currency field values in generated documents.

If "Currency Symbol" is selected, currency fields will 
be generated with no space between the symbol and field 
value. If "ISO" is selected, currency fields will be generated 
with a space between the ISO code and the field value.

Number Precision Select a number from 0-9 to define the precision for 
Number/Percent field values in the template. This allows 
you to define the number of digits to be displayed after 
the decimal (e.g., "2" if the Number/Percent field should 
display two digits following the decimal point).

Currency Precision Select a number from 0-9 to define the precision for 
currency field values in the template. This allows you to 
define the number of digits to be displayed after the 
decimal in currency value (e.g., "2" if the currency field 
should display two digits following the decimal point).

Keywords Enter comma-separated keywords to associate with the 
template. Keywords make it easier to search the templates.

Next Revision Date Select the date for the next revision of the template.

Description Enter the description for the template. Maximum of 255 
characters (an error will be thrown if this limit is exceeded). 
Using this field, you can provide a detailed description of the 
template. 
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Field Name Description

Guidance Enter guidance to help users determine the purpose of the 
template.

Click Create.

The Work Tab is enabled. You can now work with your template.

Opening a Template

You can open any agreement template from the repository and make changes to static 
text and other content in the document. When the document is finalized, you can check in 
the template and modify properties as needed.

To open a template
Open an existing document or a blank document in Microsoft Word and log in to X- 
Author for Contracts. 
In the Open Templates tab, use the Search Templates box to search for a template 
by keyword. Click the filter icon  to expose drop-down menus that can help you to 
refine your search according to Category, Subcategory, Locale, and Language. 
Click the Search icon  to display a list of templates that match your criteria.  
To clear the filter criteria and view the entire list of templates:

Click filter icon  to open the menus.
Click Clear Filters.
Click Apply Filters. A list of Templates is displayed with last modified <Month 
Date, Year>. 

From the list of documents, click on the template name link. It downloads and opens 
the latest activated version of the particular template.
Your template is opened. You can modify the template as per your requirement and 
check-in your template.
From the list of templates, click the down arrow  to expand and view the Guidance 
for the template.

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding opening a 
template, see Opening Templates.
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Checking In a Template

After you create a new template or make changes to an existing template, you can check 
in the template to update its content in Salesforce.

Prerequisite
You must have a template checked-out or created to check-in a template.

To check-in a template
In the Templates pane, click the Finish tab.
Under Check In, enter values for the following fields: 

Field Description

Name Enter a new name for the template.

Business Object Business object defines the set of fields available for a 
template. Business objects can be standard objects or 
custom objects. You can configure custom business objects 
in Conga CLM (Contracts for Salesforce). This field is only 
displayed when multiple business objects are configured in 
the Conga CLM (Contracts for Salesforce). If one business 
object is configured, the checked-in templated is assigned 
to the Contract Template business object. For more 
information about creating custom business objects, refer 
to Configuring Business Objects for Use with X-Author for 
Contracts topic in Conga CLM (Contracts for Salesforce) 
User Guide.

Alternate Clause Select the checkbox to create an alternate clause. This field 
is only displayed when you select the Contract 
Template (Apttus__APTS_Agreement__c) as a business 
object while creating a template. You can only update this 
checkbox while checking in a template the first time.

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding checking in 
a template, see Checking In Templates.
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Field Description

Agreement Types From the picklist, you can select multiple agreement types 
to associate with your template. The value of Agreement 
Types decides which templates are available during 
agreement generation in Conga CLM (Contracts for 
Salesforce). 

Category Choose the category from the picklist. Template categories 
are defined in Conga CLM (Contracts for Salesforce) by the 
administrator. This field is usually used by template 
administrators to categorize templates created by them for 
easy access.

Subcategory  The subcategory is a dependent field. Subcategories are 
populated based on the value chosen for Category. 
Subcategories are defined in Conga CLM (Contracts for 
Salesforce) by the administrator.

Language Choose any language from the picklist. The default 
language for the template is English (US).

Locale Choose the locale from the picklist. Locale allows you to 
define locale settings for number and currency precision, 
currency format, and date format. Locales can be system 
defaults or user-defined locales. You can configure custom 
locales in Conga CLM (Contracts for Salesforce). For more 
information about configuring locale, refer to Managing X- 
Author for Contracts Templates topic in Conga CLM 
(Contracts for Salesforce) User Guide.

Enable Formatting Check this box to enable locale formatting at the template 
and field level for this template. This allows you to define 
locale settings for Date Format, Currency Format, Number 
Precision, and Currency Precision.
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Field Description

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale 
formatting.

Field Description

Date Format Select an option from the picklist to choose the default 
format for all date fields in the template. Date format is 
a dynamic field to the locale selected.

Currency Format Select an option from the picklist to choose the format for 
all currency fields in the template. Choose "None" to only 
display currency field values in generated documents.

If "Currency Symbol" is selected, currency fields will 
be generated with no space between the symbol and field 
value. If "ISO" is selected, currency fields will be generated 
with a space between the ISO code and the field value.

Number Precision Select a number from 0-9 to define the precision for 
Number/Percent field values in the template. This allows 
you to define the number of digits to be displayed after 
the decimal (e.g., "2" if the Number/Percent field should 
display two digits following the decimal point).

Currency Precision Select a number from 0-9 to define the precision for 
currency field values in the template. This allows you to 
define the number of digits to be displayed after the 
decimal in currency value (e.g., "2" if the currency field 
should display two digits following the decimal point).

Keyword Enter comma-separated keywords to associate with the 
template. Keywords make it easier to search for templates.

Next Revision Date Select the date for the next revision of the template.

Description Enter the description for the template. Maximum of 255 
characters (an error will be thrown if this limit is exceeded). 
Using this field, you can provide a detailed description of 
the template.
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Field Description

Guidance Enter new guidance or modify existing guidance to help 
users determine the purpose of the template.

Active By default, the template is active. To deactivate the 
template, slide the Active toggle to the off position. The 
template must be active to use it for generating an 
agreement document.

Click Check In.

A message is displayed that your template is checked-in. You can continue working on the 
template. You can now use the Clause Library to insert clauses and clause bundles.

Using Fields

Fields that you insert in your template, or "merge fields" as they are sometimes called, 
represent the contractual terms and metadata from your Contract Agreement record in 
Conga CLM (Contracts for Salesforce). When you generate a contract document, the values 
of the fields are retrieved from the agreement record and populated in the document. As a 
template administrator, you are responsible for building your template to include fields, as 
static text, as read-only fields or as smart fields.

The following sections explain how you can use fields in your agreement template:

Inserting Fields in Templates
Making Fields Smart in Templates
Making Fields Read-Only in Templates
Inserting Fields in Templates as a Table
Making Table Columns and Rows Conditional
Inserting Fields in Templates as a Section

After creating a template and checking it out at least once, you should not reload 
the X-Author for Contracts add-in. If you reload the add-in, you cannot access the 
Clause Library.



This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding Fields, see 
Fields.
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Inserting Fields in Templates

You can navigate to the Work tab to insert fields in a template.

To insert fields in a template
Open a template in Conga CLM (Contracts for Salesforce). 
In the Templates pane, go to Work and click Fields.
Place the cursor in the section of the template text where you want to insert a field 
and click Insert Field.
On the Insert Field popup, select an Object (i.e., "Agreement") from the left column.
To search a field related to the selected object in the right column, enter a keyword 

and click the search icon ( ) or press enter.
Select the required field and click Insert. 

The fields are inserted in the template. The Fields tab shows the list of all the fields 
present in your current template. Select a field from the list to highlight it in the 
template document.

Making Fields Smart in Templates

Smart fields are specialized fields that can retain the field definition even after the Merge 
Service generates the Agreement document. Smart fields are intended for parts of an 
agreement that would normally be negotiated. Smart fields are usually represented by 

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding inserting 
fields in a template, see Inserting Fields in a Template.



•
•

Tip

To select multiple fields,
On Windows, hold Ctrl (keyboard key) and select the fields.
On Mac, hold the command (keyboard key) and select the fields.



Rich Text fields are not supported. 

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding making 
fields smart in a template, see Making Fields Smart in a Template.
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small chunks of text, such as dates, categories, and numeric values. Smart fields are not 
intended to hold large amounts of text - if necessary, use smart clauses instead.

To mark a field as Smart
Open the template and log in to X-Author for Contracts. 
In the Templates pane, go to Work and click Fields.
The Fields page shows the list of all the fields present in your template. Use 
the Search Field box to search for a field by keyword.

Select a field from the list and click the gear icon ( ) next to the field name.
In the Properties pane, click the toggle for the Smart Field attribute to enable it.
Click Save.

Making Fields Read-Only in Templates

You can make fields in your templates, read-only. When you enable the read-only attribute 
for a field in a template, that field becomes uneditable in the generated document. You can 
mark a field as read-only to restrict a user from editing the field after a document is 
generated.

To mark a field read-only
Open the template and log in to Conga CLM (Contracts for Salesforce). 
In the Templates pane, go to Work and click Fields. If you cannot see the Fields tab, 
click the dropdown icon ( and select Fields.

•
•
•

Smart fields have the following limitations:
Text Area data type fields and formula field for LongDate are not supported.
You cannot mark Lookup fields as smart.
Smart fields cannot be used in the headers or footers of agreement 
documents.



To remove the smartness property of a field, you can slide the Smart Field attribute 
toggle to off position (greyed out).



This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding making 
fields read-only in a template, see Making Fields Read-Only in a Template.



) 
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The Fields page shows the list of all the fields present in your template. Use 
the Search Field box to search for a field by keyword.

Click the Settings icon ( ) next to the field name. It opens the field settings pane 
where you can also find the field type (datatype) of a particular field. 
Click the toggle for the Read-Only Field option to enable it.
Click Save.

Inserting Fields in Templates as a Table

You can insert fields as a table in your template. The table is inserted into your template 
as a Repeat Table, meaning each separate line item record is populated as a row in the 
table, with field data populated in individual cells by column.

To insert fields in a template as a table
Open the template in Conga CLM (Contracts for Salesforce). 
Click Fields in the Work tab.
Place the cursor in the section of the template text where you want to insert a table 
and click Insert New Fields.
On the Insert Field popup, select an Object (i.e., "Agreement") from the left column.
To search a field related to the selected object in the right column, enter a keyword 
and click the search icon ( ) or press enter.
Select the required fields. On Mac: hold command and select one or more fields from 
the list. On Windows: hold Ctrl (keyboard key) and select the fields.

Select the checkbox Insert as a table.
Click Insert.

A Repeat Table is inserted into your template with each field displayed as a separate 
column.

To remove the read-only property of a field, you can slide the Read-Only Field 
option toggle to the off position (greyed out).



This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding inserting 
fields in a template as a table, see Inserting Fields in a Template as a table.



Fields are inserted as columns in the table based on the order you select. Do 
not move your cursor when the fields are being inserted.
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To show or hide caption for a repeat table
Navigate to the Fields tab. This displays the Repeat Table (object name) and the 
fields in the repeat table.

Select the Repeat Table and click the gear icon (  next to Repeat Table.
In the Table Attributes section, turn on or off the Show Caption switch. By default, it is 
on.

To select table formatting when no data is present
Navigate to the Fields tab. This displays the Repeat Table (object name) and the 
fields in the repeat table.

Select the Repeat Table and click the gear icon (  next to Repeat Table.
In the Table Attributes section, click Format. This displays a drop-down menu. Select 
one of the following options based on your requirement.

To show table captions and one empty row, select Show captions and one 
empty row.
To show captions only and no rows, select Show captions only.
To remove the entire table from the generated document, select 
 Remove whole table.

Click Save.

To make an inserted field smart or read-only
Navigate to the Fields tab. This displays the Repeat Table (object name) and the 
fields in the repeat table.
Enter the field name in the Search Field and click the search icon ( ).

Click the gear icon (  next to the selected field name to open the Properties page.
In the attributes list, turn on the Smart Field or Read-Only Field toggle based on your 
requirement and click Save.

Making Table Columns and Rows Conditional

)

)

)

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding making 
columns and rows conditional in a table, see Making Columns and Rows 
Conditional in a Table.
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You can mark any or all of the rows and columns in a table as conditional. In practice, 
these conditions operate as filters, allowing rows and columns in the table to be 
conditionally shown (and populated) or hidden. When you are constructing your 
template, you define various condition expressions on rows and columns of a table. These 
conditions are then evaluated at runtime when an agreement document is generated using 
the template.

For example, your table consists of 4 columns: Product Type, Quantity, List Price, and Net 
Price. You can define a condition to show the Net Price column only when the Account 
Name is ABC Company.

To make columns conditional in a table
Open the template and log in to Conga CLM (Contracts for Salesforce). 
In the Templates pane, go to Work and click Fields. 
The Fields page shows the list of all the fields, repeat tables, and repeat 
sections present in your template. Use the Search Field box to search by keyword.

Click the Settings icon ( ) next to the Repeat Table name.
In the Repeat Table Settings pane, click Add Condition to open the template 
expression builder.
Select a column from the picklist at the top of the expression builder that you want to 
make conditional.
To create a conditional expression, enter values for the following fields: 
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Field Description

Field Select the field which you want to set as the criteria for the 
condition. You can select any field from the parent object (parent 
of the object whose fields are displayed in the table) or lookup 
objects. You must select a field name. The fields are listed and 
grouped according to their hierarchy.

Operator Select the logical operator from the drop-down. This forms the 
relationship between the Field and its Value.

Value Enter the value of the field name selected in the Field.

Click Add row to create additional expressions for the same column. You can create 
up to a maximum of 9 filters for a single column.
Enter Custom Logic to add a logical relation between multiple rows. The supported 
filter logic operators are AND and OR. You can use parentheses for setting the 
precedence. For example, if you have five rows you can create a filter logic like, (((1 
AND 3) OR (2 AND 4)) AND 5).  In the absence of a filter logic, the default relationship 
between the rows is the boolean operator AND.
Click Test to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Repeat steps 4 - 10 for each column you want to filter.
Click Next when you are finished to continue to the next screen in the expression 
builder to define any conditional rows in your table (see the next section for complete 
instructions).
Click Save to save your table filters and return to your document.

Once the condition is successfully saved, a lightning icon ( ) is displayed next to the 
particular repeat table. Click the lightning icon ( ) to view the conditions added to the 
particular repeat table. Click the lightning icon ( ) again to collapse.

The column condition is created for the table. You can modify or delete the condition. 

To make rows conditional in a table
Open the template and log in to Conga CLM (Contracts for Salesforce). 
In the Templates pane, go to Work and click Fields. 

If you are defining column filters for a table inside a section that contains third-level 
fields, you cannot apply column filters on objects that are not included in the table. 
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The Fields page displays the repeat tables and fields present in your template. Use 
the Search Field box to search by keyword.

Click the Settings icon ( ) next to the Repeat Table name.
In the Repeat Table Settings pane, click Add Condition to open the template 
expression builder.
Follow instructions from the previous section to create conditional columns in the 
table.
Click Next.
To create a conditional expression, enter values for the following fields: 

Field Description

Field Select the field which you want to set as the criteria for the 
condition. You can select any field from the object, parent object 
(parent of the object whose fields are displayed in the table), 
grandparent object (parent’s parent), or lookup objects. You must 
select a field name. The fields are listed and grouped according to 
their hierarchy.

Operator Select the logical operator from the drop-down. This forms the 
relationship between the Field and its Value.

Value Enter the value of the field name selected in the Field.

 Click Add row to create more conditional expressions. You can create up to a 
maximum of 9 rows of expression conditions to be used in a single expression.
Click Add filter logic to add a logical relation between multiple rows. The supported 
filter logic operators are AND and OR. You can use parentheses for setting the 
precedence. For example, if you have five rows you can create a filter logic like, (((1 
AND 3) OR (2 AND 4)) AND 5).  In the absence of a filter logic, the default relationship 
between the rows is the boolean operator AND.
Click Test to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Click Save to save your table filters and return to your document.

Once the condition is successfully saved, a condition icon ( ) is displayed next to the 
particular repeat table. Click the condition icon ( ) to view the conditions added to the 
particular repeat table. Click the lightning icon ( ) again to collapse.

The row condition is created for the table. You can modify or delete the condition. 
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To edit or remove column and row conditions
In the Templates pane, go to Work and click Fields. 

Click the Settings icon ( ) next to the Repeat Table name.
Click delete icon ( ) to remove the condition and click Remove.
Click the edit icon ( ) and update the conditions.
Click Save.

Inserting Fields in Templates as a Section

You can insert fields as a section in your template and the inserted section will be added as 
a repeat section. This inserts each specified field on a new line when you select multiple 
fields (in the selected order). 

To insert fields in a template as a section
Open the template and log in to X-Author for Contracts. 
In the Templates pane, go to Work and click Fields. 
Place the cursor in the section of the template text where you want to insert a section 
and click Insert Field.
On the Insert Field popup, select an Object (i.e., "Agreement") from the left column.
To search a field related to the selected object in the right column, enter a keyword 
and click the search icon ( ) or press enter.
Select the required fields. To select multiple fields, hold Ctrl (keyboard key) and select 
the fields. 

Select the radio button Insert as a Section.
Click Insert. A repeat section is inserted into your template with each field displayed 
one below the other.
To search inserted fields:

Navigate to the Fields tab. This displays the Repeat Section (object name) and 
the fields in the repeat section.

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding inserting 
fields in a template as a section, see Inserting Fields in a Template as a Section.



Fields are inserted one below the other based on the order you select. Do not 
move your cursor when the fields are being inserted.
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Enter the field name in the search field and click the search icon .
To make an inserted field smart field or readonly:

Click the Settings icon  adjacent to the selected field name to open the 
Settings page.
In the Filed Settings page, turn on the Smart Field or Read-Only Field switch 
based on your requirement and click Save.

A repeat section is inserted into your template with each field displayed one below the 
other.

To make an inserted field read-only
Navigate to the Fields tab. This displays the Repeat Section (object name) and the 
fields in the repeat section.
Enter the field name in the Search Field and click the search icon ( ).
Click the Settings icon (  next to the selected field name to open the Field 
Settings page.
Turn on the Readonly toggle.
Click Save.

To make a repeat section conditional in a template
Navigate to the Fields tab. This displays the Repeat Section (object name) and the 
fields in the repeat section.
Click the Settings icon (  next to the selected repeat section to open 
the Properties page.
Click Add Condition. This opens the Make Conditional popup which has the 
expression builder.
In the Make Conditional popup, you can create a conditional expression and also 
create a complex expression using logical operators between multiple rows of 
conditions. To create an expression you must enter values for the following three 
fields: 

Field Description

Field Select the field which you want to set as the criteria for the 
condition. You must select a field name. The fields are listed and 
grouped according to their hierarchy.

Operator Select the logical operator from the drop-down. This forms the 
relationship between the Field and its Value.

)

)
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Field Description

Value Enter the value of the field name selected in the Field.

Click Add row to create more conditions. You can add up to 9 rows of condition 
expressions.
Click Add filter logic to add a logical relation between multiple rows of condition 
expressions. The supported filter logic operators are AND and OR. You can use 
parentheses for setting the precedence. For example, if you have 5 rows you can 
create a filter logic like, (((1 AND 3) OR (2 AND 4)) AND 5).  In the absence of a filter 
logic, the default relationship between the rows is the boolean operator AND.
Click Apply Logic to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Click Add to save your table filters and click Ok to return to your document. Once the 
condition is successfully saved, a lightning icon ( ) is displayed next to the 
particular repeat section. Click the lightning icon ( ) to expand and view the 
conditions added to the particular repeat section. Click the lightning icon ( ) again 
to collapse.

To edit or remove conditions from repeat section
In the Templates pane, go to Work and click Fields. 
Click the Settings icon ( ) next to the repeat section name.
Click delete icon ( ) to remove the condition and click Remove.
Click edit icon ( ) to edit the condition. 

To insert a table inside a repeat section
In the Templates pane, go to Work and click Fields. 
Place the cursor in the repeat section where you want to insert a table and click 
Insert New Fields.
On the Insert Field popup, select an Object (i.e., "Agreement") from the left column.
To search a field related to the selected object in the right column, enter a keyword 
and click the search icon ( ) or press enter.
Select the required fields. To select multiple fields, hold Ctrl (keyboard key) and select 
the fields. 
Select the radio button Insert as a Table.
Click Insert.
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Using Clauses

Clauses are modular blocks of text that are used frequently across multiple templates. You 
can create clauses and clause bundles in Conga CLM (Contracts for Salesforce). For more 
information about creating clauses and clause bundles, see Clause Library for Conga 
Contracts For Salesforce topic in Conga CLM (Contracts for Salesforce) User Guide. After a 
clause or clause bundle is created, you can use Clause Library to insert clauses or clause 
bundles into a template.

The following sections explain how you can use clauses and clause bundles in your 
agreement template:

Using Clause Library for Templates
Making Clauses and Clause Bundles Smart in a Template
Making Clauses and Clause Bundles Conditional in a Template

Using Clause Library for Templates

Clause Library contains clauses and clause bundles that can be reused across multiple 
agreement templates. Clause Library helps you to search for clauses or clause bundles 
that can be inserted into templates as inline text. You cannot use the Clause Library to 
insert clauses unless the template you are working with has already been checked in at 
least once. If you are in the process of creating a new template, check in the template and 
open it again to start using Clause Library. 

Using Clause Library, you can perform the following actions:

Inserting Clauses into a Template

You can also make any or all of the rows and columns in a table conditional. For 
more information about making table columns and row conditional, refer to Making 
Table Columns and Rows Conditional.



This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding Clauses, 
see Clauses.



This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding Using 
Playbook, see Using Clause Library for Template.
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Inserting Clause Bundles into a Template

Inserting Clauses into a Template

To insert a clause from Clause Library into a template

In the Templates pane, go to Work and click Clause Library. It displays the list of all 
clauses. 
Use the Search clauses box to search for a clause by keyword. Click the Search icon  ( 

) to display a list of clauses. 
Click the filter icon  to expose drop-down menus that can help you to refine your 
search according to Clause Type and Category.  
To clear the filter criteria and view the entire list of clauses:

Click Clear Filters.
Click Apply Filters.

Place the cursor in the section of the template where you want to insert a clause. 
Click a clause from the list to view the clause text and active version. Select the 

clause from the Clause Library tab, click icon  next to the clause name and click 
Insert (Clause Name) to insert the clause into your template as inline text.
If the clause has more than one clause configuration, you see a View Configurations 

option when clicking the more options icon ( ).
Click View Configurations. You can view the Sub Clauses and Alternate Clauses 
in the Related Items list. Click the down arrow ( ) for a Sub Clause or 
Alternate Clause to expand and view the text of the clause. 
Select the required clause configuration from the Configurations drop-down list.
In your template document, place the cursor at the point of insertion and click 
Insert.  
The selected clause configuration is inserted into your template. 

You will see a success message on successfully inserting a clause. The clause content is 
marked by a content control boundary in your template. When you insert a clause 
configuration, only the main clause text is added to the template. When you generate an 
agreement document using the template, the sub-clauses related to clause configuration 
are inserted into the document. The sub clauses related to sub clauses are not inserted into 
the document. Only the first level hierarchy is supported when inserting clause 
configurations. 

The clauses added to the templates and the sub clauses related to clauses are marked as 
smart by default.  For more information, see Making Clauses and Clause Bundles Smart in 
a Template. 
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To delete a clause

Select the clause text in the template and press Delete on your keyboard. The selected 
clause text is deleted from the template.

Behavior and Recommendation

When you modify a clause in Conga CLM (Contracts for Salesforce) org after inserting 
the clause in a template, the modified clause is not updated in the template. The 
latest clause is added to the agreement document when you generate the document. 
For more information about generating an agreement document, refer to Conga CLM 
(Contracts for Salesforce) User Guide.
When you create a new Clause Type and Category in Conga CLM (Contracts for 
Salesforce) org, you must log out and log in again to X-Author for Contracts to view 
the latest value in Clause Type and Category search filters. 

Inserting Clause Bundles into a Template

To insert a bundle from Clause Library into a template

In the Templates pane, go to Work and click Clause Library.
Click Bundles. It displays the list of all clause bundles.
Use the Search bundles box to search for a bundle by keyword. Click the Search icon ( 

) to display a list of bundles. 
From the list of bundles, click the more options icon ( ) next to the bundle name that 
you want to insert in the template.
In your template document, place the cursor at the point of insertion and click Insert.

You will see a success message on successfully inserting a clause bundle. When you insert a 
bundle, a place holder for clause bundle is added in your template. The clause 
bundle place holder is marked by a content control boundary in your template. When you 
generate an agreement document using the template, the clause bundle place holder is 
replaced by clauses related to bundle and sub clauses related to the clause configurations 
in the document. 

The bundles added to the templates and the clauses and sub clauses related to the bundle 
are marked as smart by default.  For more information, see Making Clauses and Clause 
Bundles Smart in a Template. 

To delete a clause bundle

You cannot search and insert an alternate clause from the Clause Library.
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Select the clause bundle text in the template and press Delete on your keyboard. The 
selected clause bundle text is deleted from the template.

Behavior and Recommendation

When you modify a clause bundle in Conga CLM (Contracts for Salesforce) org after 
inserting the clause bundle in a template, the modified clause bundle is not updated 
in the template. The latest clause bundle is added to the agreement document when 
you generate the document. For more information about generating an agreement 
document, refer to Conga CLM (Contracts for Salesforce) User Guide.

Making Clauses and Clause Bundles Smart in a Template

Clauses and clause bundles that you insert into your template are marked as smart by 
default. The clauses within a clause bundle and sub clauses related to clause 
configuration are also marked as smart by default. When you use a template that has a 
smartness attribute enabled for its clauses, the generated agreement document will have 
smart clauses that can be edited.

To make a clause and bundle smart in a template
Open the template and log in to Conga CLM (Contracts for Salesforce). 
In the Templates pane, go to Work > Clauses.
The Clauses pane lists all the clauses present in your template. Select a clause from 

the list and click the gear icon next to the clause name .
In the Properties pane:

For a clause, click the toggle for Smart Clause attribute to enable it and click 
Save.
For a bundle, click the toggle for Smart Bundle attribute to enable it and click 
Save.

Your template clause and clause bundle now have smartness property. To remove the 
smartness property of a clause or clause bundle, you can slide the Smart Clause or Smart 
Bundle attribute toggle to off position (greyed out).

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding making 
clauses smart in a template, see Making Clauses Smart in a Template.
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Making Clauses and Clause Bundles Conditional in a 
Template

You can use condition-based clauses and clause bundles in your template to make more 
customized and flexible agreement templates. The condition for the condition-based 
clauses and clause bundles can be simple or complex expressions that you can make using 
the expression builder. The conditions are evaluated at the time of agreement generation 
and the clause text is included in the generated document only if the associated condition 
resolves to True.

To add a condition to a clause and bundle
Open the template and log in to Conga CLM (Contracts for Salesforce). 
In the Templates pane, go to Work > Clauses.
The Clauses pane lists all the clauses present in your template. Select a clause from 

the list and click the gear icon  next to the clause name.

Select a clause or clause bundle from the list and click the gear icon ( ) next to the 
clause name or clause bundle name.
In the Properties pane, click Add Condition to open the template expression builder.
In the Clause Condition window, you can create a conditional expression and also 
create a complex expression using logical operators between multiple rows of 
conditions. To create an expression you must enter values for the following three 
fields: 

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding making 
clauses conditional in a template, see Making Clauses Condition-based in a 
Template.



A condition created for a clause configuration is applicable for all the sub clauses 
related to the clause configuration. Similarly, a condition created for a clause 
bundle is applicable for all the clauses and sub clauses related to the clause 
bundle. 
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Field Description

Field Select the field which you want to set as the criteria for the 
condition. The Field drop-down shows the Contract Agreement 
object and its fields from your Salesforce org. You must select a 
field name. The fields are listed and grouped according to their 
hierarchy.

Operator Select the logical operator from the drop-down. This forms the 
relationship between the Field and its Value.

Value Enter the value of the field name selected in the Field.

Click Add row to create more conditions. You can add up to 9 rows of condition 
expressions.
Click Custom Logic to add a logical relation between multiple rows of condition 
expressions. The supported filter logic operators are AND and OR. You can use 
parentheses for setting the precedence. For example, if you have 5 rows you can 
create a filter logic like, (((1 AND 3) OR (2 AND 4)) AND 5).  In the absence of a filter 
logic, the default relationship between the rows is the boolean operator AND.
Click Test to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Click Add.
Click Save to save the condition. Your clause is made conditional and you will see a 
success message. A lightning icon ( ) is displayed next to the particular clause. Click 
the lightning icon ( ) to view the conditions added to the particular Clause.

The properties page now shows the condition that you created.

To view and edit a condition
Go to the Work tab and click Clauses in Templates pane.
Select a clause or clause bundle from the clauses list.

Click the gear icon ( ) next to the clause or clause bundle. This opens 
the Properties page and you can see the condition expression set for that clause or 
clause bundle.
To edit the condition, click the pencil icon ( ) next to Condition. 
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To delete a condition
Go to the Work tab and click Clauses in Templates pane.
Select a clause or clause bundle from the clauses list.

Click the gear icon ( ) next to the clause or clause bundle. This opens 
the Properties page and you can see the condition expression set for that clause or 
clause bundle.
Click the delete icon ( ). You will see a confirmation message. Click Remove.

The condition is deleted for the clause or clause bundle. 

Setting Segment in Templates

Set Segment feature allows you to set conditions and style for the highlighted text in your 
agreement template. The condition for the segment's visibility can be set from the 
expression builder. The segment can consist of the highlighted text, a clause, a group of text 
across clauses, or text with fields. Use this feature to create a template that can show or 
hide different segments of text in the generated agreement based on the conditions set by 
you. The expression builder is fully integrated with the objects and fields in your Salesforce 
org.

To make a Segment Conditional in a template
In the Templates pane, go to Work tab, click the more options icon ( ) and select Set 
Segment.
Highlight a block of text in your template and click New Segment. This opens the 
Segment Condition window which has the expression builder.
In the Segment Condition window, you can create a conditional expression and also 
create a complex expression using logical operators between multiple rows of 
conditions. To create an expression you must enter the values of the following three 
fields: 

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding setting 
segments in a template, see Setting Segments in Templates.
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Field Description

Field Select the field which you want to set as the criteria for the 
condition. The Field drop-down shows the Contract Agreement 
object and its fields from your Salesforce org. You must select a 
field name. The fields are listed and grouped according to their 
hierarchy.

Operator You must select the logical operator from the drop-down. This 
forms the relationship between the Field and its Value.

Value Enter the value of the field name selected in the Field.

Click Add row to create additional expressions for the same column. You can create 
up to a maximum of 9 filters for a single column.
Enter Custom Logic to add a logical relation between multiple rows. The supported 
filter logic operators are AND and OR. You can use parentheses for setting the 
precedence. For example, if you have 5 rows you can create a filter logic like, (((1 AND 
3) OR (2 AND 4)) AND 5).  In the absence of a filter logic, the default relationship 
between the rows is the boolean operator AND.
Click Test to check whether your filter logic expression is correct. If your logic is 
incorrect, you will see a message in red.
Click Save to save your table filters and return to your document. 

You will see the success message and your segment will be added as Segment Conditional 
to the segments list in the Set Segment pane. A condition icon ( ) is displayed next to the 
newly added segment. Click the condition icon ( ) to view the conditions added to the 
particular segment.

Selecting the segment name from the list highlights that segment in the template 
document. 

To view or edit a segment condition
Select the Segment Conditional from the segments list in the Segments pane.

Click the Settings ( ) icon next to the segment name. This opens the Segment 
Settings page. where the Segment Type is set to Conditional for that segment.
To edit the conditional, click the pencil ( ) icon next to Condition.  
At the time of agreement generation, if your conditional's value evaluates to true, the 
associated segment is shown in the agreement document.
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To delete a conditional Segment in a template
Go to the Work tab > Segments tab in Templates.
Select the segment from the segment list. The selected segment is highlighted in the 
template.

Click the Settings icon    next to the segment name to open the Segment Settings 
page.
Click Delete Segment. You will see a confirmation message. Click Delete again.

Your segment is successfully deleted and the content control boundary of your segment is 
removed.

To set a style for a segment in a template
In the Templates pane, go to the Work tab, click the more options icon 
 and select Segment.
Highlight a block of text in your template and click Set Style. This opens the Select 
Styles window that lists custom styles.
Select a custom style or select the Show template styles checkbox and select a style.
Click Save.

The segment is added as Segment Regular to the segments list in the Set 
Segment pane. Selecting the segment name from the list highlights that segment in the 
template document. 

To view or edit a segment style
Select Segment Regular from the segments list in the Segments pane and click the 

Settings icon  next to the segment name. 
 

This opens the Segment Regular page with the segment style set for that segment. 
To edit the style, click the pencil icon  next to Style. 
To add a segment condition, click Add Condition. This opens the Segment 
Condition window which has the expression builder. For more information, see To 
make a Segment Conditional in a template. After adding a condition to the segment, 
a lighting icon ( ) is added. 
Segment Regular style segment changes to Segment Conditional after you add a 
condition. When you generate a document using a template with style segments, you 
can view different styles applied in the generated document.
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To delete a style for a segment in a template
Go to the Work tab and click the Segment tab in Templates.
Select the segment from the segment list. The selected segment is highlighted in the 
template.
Click the Settings icon ( ) next to Segment Regular.
Click Delete Segment. You will see a confirmation message. Click Delete again.

Your segment is successfully deleted and the content control boundary of your segment is 
removed.

Using Template Locale

Template localization is a feature that allows Template Administrators to define the 
locale of their templates. Locales can be system defaults or user-defined locales. You can 
define locale settings at the agreement template and field level. Following are some of the 
important points about how localization works:

At the template level:
You can specify the Locale and choose the Currency Format, Date Format, and 
configure Number and Currency Precision for the whole template when you 
create a template. 
You can also change the locale of a template at check-in. 

At the template field level:
You can use the Fields tab to define locale 
for Number, Currency, Date, and Precision fields. 
You can also use the Fields tab to define Currency Format, Date Format, 
Currency Precision, and Number Precision for fields.

Field-level locale formatting takes precedence over template-level locale formatting.
For a field, if locale formatting is not defined at field-level, the template formatting is 
applied.
If an agreement template has no locale defined, the default locale—English (US) is 
applied.

To learn how to change field level locale, refer to Changing Field Level Locale.

This topic contains instructions for Conga CLM (Contracts for Salesforce) users. If 
you are a Conga CLM user and you are looking for information regarding defining 
template locale, see Defining Template Locale.
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Supported Locales
English (US), English (UK), English (Canada), English (Ireland), Italian, German, Chinese, 
Japanese, Korean, Thai, Norwegian, Swedish, Russian, Portuguese, Polish, Greek (Greece), 
and Spanish are the standard locales that are available in Conga CLM (Contracts for 
Salesforce). You can configure custom locales in Conga CLM (Contracts for Salesforce). 

Unsupported Locales
Alsatian (Switzerland), Romansh (Switzerland), French (Switzerland), Walser (Switzerland), 
English (Republic of the Philippines), Filipino (Philippines) locales are not supported. German 
Mark and Swiss Franc currencies are not supported.

Locale Settings for Templates
You can define locale settings while:

Creating Templates
Checking in a Template

Changing Field Level Locale
When you create a new template, you are required to specify a Locale for your template. 

Because there may be some cases that require you to override formats at the field level, X- 
Author for Contracts provides template administrators with the ability to define Number 
and Currency Precision, Currency Format, and Date Format. 

Prerequisites

Enable Formatting must be checked when creating or checking in a template to 
enable field-level locale configuration.

If a locale is deleted in Conga CLM (Contracts for Salesforce) that is being used in a 
template at the template level and you check out and check in the template, the 
deleted locale is replaced with the first value of the Locale dropdown. If a locale is 
deleted in Conga CLM (Contracts for Salesforce) that is being used in a template at 
the field level and you navigate to the Fields tab and view the field details, the 
Locale field is set to blank. If all the locales are deleted in Conga CLM (Contracts 
for Salesforce) and you click Create, a warning message is displayed and you need 
to add required locales. 
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To change the field-level locale, precision, and format for date and 
currency fields

In the X-Author Templates pane, go to the Work tab > Fields.

Click the Settings icon ( ) next to the field name.
In the Settings page, based on the template field selected, you can view and change 
the following field properties:

For date fields, you can change Locale and Date Format from their respective 
dropdown. 
The Date Formats displayed are based on the Locale selected. 
For the currency fields, you can change the Currency Format, Currency 
Precision, and Locale from their respective dropdown. 
Based on the locale selected, the default currency precision value provided in 
Conga CLM (Contracts for Salesforce) is displayed. You can change the 
Currency Precision value as per your requirement.
For the number fields, you can change the Locale and Number Precision from 
their respective dropdown. 
Based on the locale selected, the default number precision value provided 
in Conga CLM (Contracts for Salesforce) is displayed. You can change the 
Number Precision value as per your requirement. 

Click Save.

FAQs
Can I cross-reference clauses in X-Author for Contracts?

Cross-referencing is an MS Word feature. Currently, X-Author for Contracts does not 
support cross-referencing. 
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X-Author for Contracts Features by 
Release
Review the latest X-Author for Contracts Features by Release document.

Features by Release

Features by Release
This document contains an overview of features introduced in each major release of X- 
Author for Contracts. For more information, see X-Author for Contracts Features by 
Release.  

https://documentation.conga.com/features-by-release/x-author-for-contracts-feature-by-release-165937850.html
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